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 1
I n t r o d u c t i o n
The Structural Mechanics Module 3.4 is an optional package that extends the 
COMSOL Multiphysics® modeling environment with customized user interfaces 
and functionality optimized for structural analysis. Like all modules in the 
COMSOL family, it provides a library of prewritten ready-to-run models that make 
it quicker and easier to analyze discipline-specific problems.

This particular module solves problems in the fields of structural and solid 
mechanics, adding special elements such as beams, plates, and shells. It provides 
static, eigenfrequency, damped eigenfrequency, time-dependent, quasi-static 
transient, parametric, linear buckling, fatigue, and frequency response analysis 
capabilities. You can use both linear and nonlinear material models such as 
elasto-plastic models and include large deformation effects as well as contact and 
friction in an analysis. Material models can be isotropic, orthotropic, or fully 
anisotropic. Define loads, constraints, and material models in a global coordinate 
system or in local, user-defined coordinate systems. Piezoelectric materials can be 
analyzed with the constitutive relations on either stress-charge or strain-charge 
form.

All application modes in this module are fully multiphysics enabled, making it 
possible to couple them to any other physics application mode in COMSOL 
Multiphysics or the other modules. Coupling structural analysis with thermal 
 1
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analysis is one example of multiphysics easily implemented with the Structural 
Mechanics Module, which provides predefined multiphysics couplings for 
thermal-structural analysis and other types of multiphysics. Piezoelectric materials, 
coupling the electric field and strain in both directions are fully supported inside the 
module through special application modes solving for both the electric potential and 
displacement. Structural mechanics couplings are common in simulations done with 
COMSOL Multiphysics and occur in interaction with fluid flow (FSI), chemical 
reactions, acoustics, electric fields, magnetic fields, and optical wave propagation.

The underlying equations for structural mechanics are automatically available in all of 
the application modes—a feature unique to COMSOL Multiphysics. This also makes 
nonstandard modeling easily accessible. For example, you can change the constitutive 
equations to model nonlinear materials. The Structural Mechanics Module also 
features extensible material and beam cross-section libraries.

Further, you can include accurate finite element models as blocks in a dynamic 
simulation performed with Simulink. This combination reduces the need for 
approximations and ad hoc models in dynamic simulations. COMSOL Multiphysics’ 
tight integration with the COMSOL Script and MATLAB environments makes the 
Structural Mechanics Module very versatile. For instance, you can use a function to 
describe loads and constraints.

The documentation set for The Structural Mechanics Module consists of three books. 
The one in your hands, the Structural Mechanics Module User’s Guide, introduces 
the basic functionalities in the module, reviews new features in the version 3.4 release, 
reviews basic modeling techniques through tutorial and benchmark example models, 
and includes reference material of interest to those working in structural mechanics. 
The second book in the set, the Structural Mechanics Module Model Library, 
contains a large number of ready-to-run models that illustrate a broad range of 
applications. Each model comes with theoretical background as well as step-by-step 
instructions that illustrate how to set it up. Further, we supply these models as Model 
MPH-files so that you can open them in COMSOL Multiphysics for immediate access. 
This way you can follow along with the printed discussion as well as use them as a 
jumping-off point for your own modeling needs. A third book, the Structural 
Mechanics Module Reference Guide, contains reference material about command- 
line functions and programming. All documentation is available in HTML and PDF 
format from the COMSOL Help Desk.
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Typographical Conventions

All COMSOL manuals use a set of consistent typographical conventions that should 
make it easy for you to follow the discussion, realize what you can expect to see on the 
screen, and know which data you must enter into various data-entry fields. In 
particular, you should be aware of these conventions:

• A boldface font of the shown size and style indicates that the given word(s) appear 
exactly that way on the COMSOL graphical user interface (for toolbar buttons in 
the corresponding tooltip). For instance, we often refer to the Model Navigator, 
which is the window that appears when you start a new modeling session in 
COMSOL; the corresponding window on the screen has the title Model Navigator. 
As another example, the instructions might say to click the Multiphysics button, and 
the boldface font indicates that you can expect to see a button with that exact label 
on the COMSOL user interface.

• The names of other items on the graphical user interface that do not have direct 
labels contain a leading uppercase letter. For instance, we often refer to the Draw 
toolbar; this vertical bar containing many icons appears on the left side of the user 
interface during geometry modeling. However, nowhere on the screen will you see 
the term “Draw” referring to this toolbar (if it were on the screen, we would print 
it in this manual as the Draw menu).

• The symbol > indicates a menu item or an item in a folder in the Model Navigator. 
For example, Physics>Equation System>Subdomain Settings is equivalent to: On the 
Physics menu, point to Equation System and then click Subdomain Settings. 
COMSOL Multiphysics>Heat Transfer>Conduction means: Open the COMSOL 

Multiphysics folder, open the Heat Transfer folder, and select Conduction.

• A Code (monospace) font indicates keyboard entries in the user interface. You might 
see an instruction such as “Type 1.25 in the Current density edit field.” The 
monospace font also indicates COMSOL Script codes.

• An italic font indicates the introduction of important terminology. Expect to find 
an explanation in the same paragraph or in the Glossary. The names of books in the 
COMSOL documentation set also appear using an italic font.
 |  3
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 2
O v e r v i e w
This manual describes the Structural Mechanics Module version 3.4. It is intended 
to give you an introduction to the modeling stages within the Structural Mechanics 
Module and to provide a detailed example of how to work with the models in this 
set, as well as serve as a reference for more advanced modeling.

• Chapter 3, “Quick Start,”, gives you the knowledge necessary to start using 
COMSOL Multiphysics with the Structural Mechanics Module.

• In Chapter 4, “Structural Mechanics Modeling,” you can find modeling advice 
for various structural mechanics problems.

• Chapter 5, “Application Mode Guide,”; Chapter 7, “Continuum Application 
Modes,”; Chapter 8, “Mindlin Plates,”; Chapter 9, “Beams,”; Chapter 10, 
“Trusses,”; and Chapter 11, “Shells,”, provide guidelines to help you select and 
use the application modes in this module.

• Chapter 14, “Fatigue Analysis,”; show you have to perform fatigue analysis 
together with COMSOL Script or MATLAB.

• The “Application Mode Programming Reference” in Chapter 3 describes the 
powerful integration with COMSOL Script and MATLAB and gives details 
about the implementation of the application modes.
 5
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A separate book, the Structural Mechanics Module Model Library, describes in great 
detail each entry in the collection of software models you received with this product.

What Can the Structural Mechanics Module Do?

The Structural Mechanics Module contains a set of modeling interfaces, called 
application modes, adapted to a broad category of structural-mechanics analysis. The 
module serves as an excellent tool for the professional engineer, researcher, and 
teacher. In education the benefit of the short learning curve is especially useful because 
educators need not spend excessive time learning the software and can instead focus 
on the modeling process.

As you develop models using the Structural Mechanics Module, you can view them in 
terms of the underlying partial differential equations or the principle of virtual work. 
The software thus offers a unique way to understand the laws of physics and the 
equations that describe them. For instance, you can add additional physics like 
viscoelasticity to the constitutive equations. It is also possible to export a simulation 
into the COMSOL Script or MATLAB environments, or save it as a Model M-file 
script. This makes it possible to incorporate COMSOL Multiphysics models with 
products in the MATLAB family such as Simulink and the Control System Toolbox.

What Problems Can It Solve?

The Structural Mechanics Module is a collection of application modes for COMSOL 
Multiphysics that handles static, eigenfrequency and damped eigenfrequency, 
transient, frequency response, quasi-static, linear buckling, and parametric analyses for 
applications in structural mechanics, solid mechanics, and piezoelectricity.

S T A T I C  A N A L Y S I S

In a static analysis the load and constraints are fixed in time.

E I G E N F R E Q U E N C Y  A N A L Y S I S

An eigenfrequency analysis finds the undamped eigenfrequencies and mode shapes of 
a model. Sometimes referred to as the free vibration of a structure.

D A M P E D  E I G E N F R E Q U E N C Y  A N A L Y S I S

A damped eigenfrequency analysis finds the damped eigenfrequencies and mode 
shapes of a model. The quality and decay factors of the structure are also calculated.
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T R A N S I E N T  A N A L Y S I S

A transient analysis finds the transient response for a time-dependent model, taking 
into account mass, mass moment of inertia, and damping. 

F R E Q U E N C Y  R E S P O N S E  A N A L Y S I S

A frequency-response analysis finds the steady-state response from harmonic loads.

Q U A S I - S T A T I C  A N A L Y S I S

A quasi-static analysis neglects mass effects, assuming the time scale in the 
structural-mechanics problem is much smaller than other dynamics. An example is a 
transient thermal problem where the time scale in the thermal problem is often much 
longer than the one in the structural dynamics.

P A R A M E T R I C  A N A L Y S I S

A parametric analysis finds the solution dependence due to the variation of a specific 
parameter, which could be, for instance, a material property or the position of a load.

L A R G E  D E F O R M A T I O N S

You can include large deformations with the restriction of small strains in all fully 
dimensional application modes. This effect is also sometimes referred to as a nonlinear 
geometric effect. Using large deformations, the normal strain is replaced with the 
Green strain, and the stress is replaced with the second Piola-Kirchhoff stress. 
COMSOL Multiphysics solves the problem using a total Lagrangian formulation. 
Large deformation is only available in the continuum application modes.

L I N E A R  B U C K L I N G  A N A L Y S I S

A linear buckling analysis includes the stiffening effects from stresses coming from 
nonlinear strain terms. The two stiffnesses coming from stresses and material define an 
eigenvalue problem where the eigenvalue is a load factor that, when multiplied with 
the actual load, gives the critical load in a linear context. 

Linear buckling analysis uses the eigenvalue solver.

Another way to calculate the critical load is to include large deformation effects and 
increase the load until the solver fails because the load has reached its critical value.

Linear buckling analysis is only available in the continuum application modes.
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E L A S T O - P L A S T I C  A N A L Y S I S

An elasto-plastic analysis involves a nonlinear material model with or without 
hardening. Two different hardening models are available:

• Isotropic 

• Kinematic 

Elasto-plastic analysis is available in the continuum application modes.

F A T I G U E  A N A L Y S I S

A fatigue analysis is done in order to find the fatigue damage or fatigue life of a 
component. Fatigue analysis is divided into high-cycle and low-cycle fatigue 
depending of the number of load cycles. The Structural Mechanics Module as 
delivered can handle the following cases for both high-cycle and low-cycle fatigue:

• Proportional loading constant amplitude

• Nonproportional loading constant amplitude

• Proportional loading nonconstant amplitude 

Note: The fatigue analysis in the Structural Mechanics Module is script based and 
requires COMSOL Script or MATLAB.

A P P L I C A T I O N S

Examples of applications include thin plates loaded in a plane (plane stress), thick 
structures with no strain in the out-of-plane direction (plane strain), axisymmetric 
structures, frame structures in 2D and 3D, thin-walled 3D structures (shells), and 
general 3D structures modeled using solid elements.

Available application modes are:

• Plane stress

• Plane strain

• Axial symmetry, stress-strain

• 2D beams, Euler theory

• 2D truss

• Thick plates, Mindlin theory

• 3D beams, Euler theory
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• 3D truss

• Solid, stress-strain

• Shells

• Piezoelectric application modes

- Piezo solid

- Piezo plane stress

- Piezo plane strain

- Piezo axial symmetry

New Features in Structural Mechanics Module 3.4

• Improved piezoelectric application modes. See “Piezoelectric Application Modes” 
on page 319 for more information.

• Follower loads. See “Follower Loads” on page 73 for more information.

• Fatigue analysis capabilities. See “Fatigue Analysis” on page 125 for more 
information.
 |  9
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 3
Q u i c k  S t a r t
The objective of this chapter is to familiarize you with modeling procedures in the 
Structural Mechanics Module using the graphical user interface. Because this 
module is fully integrated with COMSOL Multiphysics, the modeling process is 
similar to the one used in that environment. This chapter takes a detailed 
walk-through of one model to present the various aspects of the simulation process; 
it steps through all the stages of modeling, from geometry creation to 
postprocessing.
 11
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Ba s i c  Mode l i n g  P r o c e du r e s

The way COMSOL Multiphysics orders its toolbar buttons and menus mirrors the 
basic procedural flow during a modeling session. You work your way from left to right 
in the process of modeling, defining, solving, and postprocessing a problem using the 
COMSOL Multiphysics graphical user interface (GUI). Thus, in this manual and the 
accompanying Structural Mechanics Model Library manual we maintain a certain 
style convention when describing the following introductory models as well as those 
in the COMSOL Multiphysics Model Library. The format includes headlines that 
corresponding to each major step in the modeling process; these headlines also roughly 
correspond to the various GUI modes and menus.

Model Navigator

The Model Navigator appears when you start COMSOL Multiphysics or when you 
restart from scratch within COMSOL Multiphysics by selecting New from the File 
menu or clicking on the New button on the Main toolbar. On the New page in the 
Model Navigator you specify the application mode, names of dependent variables, and 
the nature of the problem—the analysis type: stationary (static), eigenfrequency or 
damped eigenfrequency, time dependent (transient), quasi-static, parametric, or 
frequency response. By clicking on the Multiphysics button you can set up a 
combination of application modes from the Structural Mechanics Module, other 
modules, or COMSOL Multiphysics. It is also possible to open the Model Navigator 
from the Multiphysics menu at any time to add or remove an application mode.

Options and Settings

This section reviews basic settings, for example, those for the axes and grid spacing. All 
settings are accessible from the Options menu and some are also accessible by 
double-clicking the status bar. You might need to use the Constants dialog box to enter 
model parameters (see “Constants” on page 139 in the COMSOL Multiphysics User’s 
Guide for a more detailed description). You can also maintain libraries of user-defined 
materials, which you access through the Materials/Coefficients Library dialog box. 

It is possible to define materials, loads, and constraints in a user-defined coordinate 
system. Create such a coordinate system in the Coordinate System Settings dialog box, 
which is accessible from the Options menu.
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Geometry Modeling

In this step you set up the model’s geometry. This stage requires knowledge of how to 
use the Draw menu and the Draw toolbar (see “Geometry Modeling and CAD Tools” 
on page 23 in the COMSOL Multiphysics User’s Guide for details). You can also 
import 3D CAD drawings using the optional CAD Import Module.

Physics Settings

In this section you define a model’s physics. Open all appropriate dialog boxes from 
the Physics menu or by double-clicking on the domain in the respective domain 
selection mode. Further, control the active selection mode from the Physics menu or 
by clicking on the appropriate domain type button on the Main toolbar.

Material properties are normally defined on subdomains. In the Structural Mechanics 
Module, however, some application modes are not defined at the subdomain level. 
This is the case, for example, in

• The Shell application mode, where you define material properties on boundaries 
(3D) / faces

• The In-plane Euler Beam application mode, where you define material properties 
on boundaries (2D) / edges.

A P P L I C A T I O N  M O D E  P R O P E R T I E S

Application mode properties are global properties controlling the analysis starting with 
which analysis to perform. Make all corresponding settings in the Application Mode 

Properties dialog box, which you open by choosing Physics>Properties.

A P P L I C A T I O N  S C A L A R  V A R I A B L E S

Application scalar variables are global variables defining an analysis. The Structural 
Mechanics Module application modes have only one variable, freq, the excitation 
frequency in a frequency response analysis. To open the Application Scalar Variables 
dialog box, choose Scalar Variables from the Physics menu.

PO I N T  S E T T I N G S

You define loads and constraints on points in Point mode. Point settings are used in 
all Structural Mechanics Module application modes, whereas point masses are defined 
in the Beam application modes. A table is used to describe the settings in the Point 

Settings dialog box in a compact format.
B A S I C  M O D E L I N G  P R O C E D U R E S  |  13
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E D G E  S E T T I N G S

Edge settings are used only in the 3D application modes for shells, solids, and beams. 
In the 3D Euler Beam application mode you define physical properties as well as loads 
and constraints, whereas the other application modes define only loads and constraints. 
A table is used to describe the settings in the Edge Settings dialog box in a compact 
format.

B O U N D A R Y  S E T T I N G S

In Boundary Selection mode, you specify loads and constraints on the edges (in 2D) 
or faces (in 3D). For in-plane Euler beams and shells the physical properties are also 
defined. A table is used to describe the settings in the Boundary Settings dialog box in 
a compact format. 

S U B D O M A I N  S E T T I N G S

In Subdomain Selection mode you specify material properties, loads, and damping for 
application modes existing on the top domain in 2D and 3D. A table is used to describe 
the settings in the Subdomain Settings dialog box in a compact format. You can also 
implement constraints, specify initial stresses and strains, and control the element to 
use from this dialog box. For all continuum application modes you can select the order 
of the Lagrange element. In addition, for time-dependent and nonlinear problems you 
set initial conditions for subdomains in this mode.

Mesh Generation

At this stage the software meshes the problem geometry. Sometimes you simply click 
one of the meshing buttons on the Main toolbar; in other cases it is necessary to set 
some parameters using the Mesh menu and the dialog boxes for the meshers, or use the 
interactive meshing and the Mesh toolbar (see “Meshing” on page 285 in the 
COMSOL Multiphysics User’s Guide for a detailed description about meshing).

Computing the Solution

To compute the solution, click the Solve button on the Main toolbar. You can specific 
settings for each solver in the Solver Parameters dialog box (see “Solving the Model” 
on page 359 in the COMSOL Multiphysics User’s Guide for details).
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Postprocessing and Visualization

COMSOL Multiphysics’ powerful visualization tools are accessible in the program’s 
Postprocessing mode, but to use them you must be familiar with the Postprocessing 
menu (see “Postprocessing and Visualization” on page 419 in the COMSOL 
Multiphysics User’s Guide for details). For additional postprocessing you can export 
the solution to the COMSOL Script or MATLAB workspace.
B A S I C  M O D E L I N G  P R O C E D U R E S  |  15
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A Me chan i c a l  C omponen t

The following detailed example consists of a plane stress analysis of a mechanical 
component. The component is cut from a 4-mm steel plate, and the thickness is small 
compared to its extent in the xy-plane. This aspect along with the fact that the applied 
loads lie in the xy-plane mean that you can assume that the out-of-plane stress is 
negligible. The Plane Stress application mode works under this assumption.

This example also introduces the seven basic analysis types available in the Structural 
Mechanics Module: 

• Static analysis

• Eigenfrequency analysis

• Damped eigenfrequency analysis

• Time-dependent analysis

• Frequency response analysis

• Parametric analysis

• Quasi-static transient analysis

In the static, time-dependent, frequency response, parametric, and quasi-static 
analyses, the model contains a load to the lower-right end of the component. In all 
analyses the component is clamped on the left-hand side. 

0.22 m

0.
05

 m
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Static Analysis

A static analysis has no explicit or implicit time dependencies. This situation 
corresponds to the steady state of a transient analysis with constant boundary 
conditions and material properties.

The purpose of this analysis is to:

• Find the maximum stress level and compare it with the material’s yield strength

• Find the static deflection at the point where the load is applied and compare it with 
the time-dependent analysis.

The Model Library note immediately below appears in the discussion of every model. 
The path indicates the location of the model file on the Model Library page in the Model 

Navigator.

Model Library path: Structural_Mechanics_Module/Tutorial_Models/
component_static

M O D E L  D E F I N I T I O N

The model starts with a mechanical component whose shape and overall dimensions 
are shown in the following figure. It is possible to create the geometry in a CAD 
package and import it into COMSOL Multiphysics as a DXF file.

Some key parameters for the model:

0.22 m

0.
01

5 
m

0.
05

 m
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Material
• Structural steel as taken from the material library

• Thickness of 4 mm

Load
A 900 N force in the x direction on the inside of the right end

Constraints
The left edge is fixed.

R E S U L T S

After the analysis you find that the von Mises effective stress has a maximum value of 
2.8·108 N/m2 = 280 MPa, which, compared with the material’s yield strength of 
350 MPa, results in a utilization factor of 80%.

The analysis also gives the static displacements at the bottom end of the edge where 
the load is applied:

Now take a step-by-step look at how to achieve these results using the Structural 
Mechanics Module.

M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
1 In the Model Navigator go to the New page, then select 2D from the Space dimension 

list.

RESULT x DIRECTION y DIRECTION

Displacement 6.89e-4 m 1.14e-3 m
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2 On that same page go to the list of application modes and select  
Structural Mechanics Module>Plane Stress>Static analysis.

3 Click OK to close the Model Navigator.

Geometry Modeling
Instead of drawing the geometry directly in the user interface, you can import a DXF 
file.

1 From the File menu select Import>CAD Data From File.

2 The Import CAD Data from File dialog box appears. Open the DXF file 
component_geometry.dxf, which is located in 
/models/Structural_Mechanics_Module/Tutorial_Models in the COMSOL 
installation directory.
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3 Click Import to close the dialog box, then click the Zoom Extents button on the Main 
toolbar to view the entire geometry.

4 Select all the lines in the drawing by clicking the left mouse button and dragging a 
rubber-band box that encloses all the edges (or use the shortcut key Ctrl+A).

5 Construct a solid from the edges imported from the DXF file. To coerce the edges 
to a solid, click the Coerce to Solid button in the Draw toolbar.

6 Split the solid by clicking the Split Object button in the Draw toolbar to create 
independent objects for the holes.
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7 Click the Difference button on the Draw toolbar to cut out the hole in the geometry.

Physics Settings

Application Mode Properties   

Set the analysis type to static (the analysis type is already static in this model, so this 
step is not necessary).

1 From the Physics menu select Properties to open the Application Mode Properties 
dialog box.

2 The Analysis type list defines which analysis to perform and some other properties 
for the analysis. Because you selected a static analysis from the Model Navigator, the 
analysis type is already defined as being Static.
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Boundary Settings   In boundary mode you specify loads and constraints. By default all 
edges are free, which means that there are no loads or constraints. Loads can be defined 
as force per area (using the thickness) or as force per length. The default is force per 
length, which this example uses.

The total static force on Edge 12 on the lower right end is 900 N. This results in a 
distributed force along the edge, which is 15 millimeter long, of 60 kN/meter. The 
left edge is fixed in both directions.

1 Open the Boundary Settings dialog box by going to the Physics menu and selecting 
Boundary Settings.

2 Select Boundary 1. Click the Constraint tab, then select Fixed from the Constraint 

condition list.

3 Select Boundary 12. Click the Load tab and enter 60e3 in the Fx edit field.

You have set the boundary conditions according to the following table:

You frequently encounter tables such as this one both in the remainder of this 
chapter and throughout the Model Library. The row marked “Page” indicates on 
which page in the dialog box you find the setting.

4 Click OK to close the Boundary Settings dialog box. 

Subdomain Settings   In subdomain mode you specify material properties and element 
order. The material properties are selected from the material library or entered 

BOUNDARY 1 BOUNDARY 12

Page Constraint Load

Constraint condition Fixed Fx 60e3
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explicitly by typing the corresponding value or expression. This example uses the 
material library. Before you can use a material from the library, you must add it to the 
geometry. Do so from the Options menu or directly from the Subdomain Settings dialog 
box.

1 Select Subdomain Settings from the Physics menu.

2 Select Subdomain 1.

3 Click the Load button on the Material page to open the Materials/Coefficients Library 
dialog box.

4 Select Structural steel from the Basic Material Properties folder in the Materials list 
and click Apply.

You have now added the structural steel material to the geometry, an entry that you 
can see in the Model part of the Materials list.

5 Click OK to close the Material/Coefficients Library dialog box. Structural steel is now 
selected in the Library material list in the Subdomain Settings dialog box.
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6 Type 4e-3 in the thickness edit field. 

In tabular form, the material settings are:

The Element page shows the shape functions currently in use in the selected 
subdomain. The shape functions define polynomials used in interpolating the 
dependent variables. Typically, you do not need to change this setting.

SUBDOMAIN 1

Page Material

Library material Structural steel

thickness 4e-3
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The default element type is quadratic Lagrange elements. They use 2nd-order 
polynomials, which is often a good trade-off between memory usage and accuracy. You 
can use linear Lagrange elements to reduce memory consumption when accurate stress 
or strain results are not required. 

Mesh Generation
The Free Mesh Parameters dialog box, found on the Mesh menu, gives access to a 
number of parameters that control the mesh’s density and gradation. Use the default 
mesh parameters.

1 Select Free Mesh Parameters from the Mesh menu to look at the Free Mesh Parameters 
dialog box.

2 Click OK to use the default mesh settings.
A  M E C H A N I C A L  C O M P O N E N T  |  25



26 |  C H A P T E R
3 Initialize the mesh by clicking the Initialize Mesh button on the Main toolbar.

Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in 
the Solver Parameters dialog box. This option is enabled as the default, so there is no 
need to change the solver settings because stationary is the solver associated with the 
static analysis type.

To compute the solution, either click the Solve button (=) on the Main toolbar or select 
Solve Problem from the Solve menu.

Postprocessing and Visualization
In Postprocessing mode you can, for example, add additional plot types and set 
parameters for plots. The postprocessing utilities can visualize any expression 
containing, for example, the solution variables, their derivatives, and the space 
coordinates. Many frequently used expressions are predefined as postprocessing 
variables, and they are directly available from lists in the Plot Parameters dialog box.

As soon as the solution is ready, a default plot appears. In the Plane Stress application 
mode the default visualizes the von Mises effective stress. Plot the von Mises stress 
together with the deformed shape of the component:

1 Select Plot Parameters from the Postprocessing menu.
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2 On the General page select the Deformed shape and Surface check boxes.

3 Click OK to close the Plot Parameters dialog box.
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4 Click the Zoom Extents button on the Main toolbar. 

The deformation is exaggerated using automatic scaling. You can control the scaling 
of the deformation from the Plot Parameters dialog box on the Deform page.

Eigenfrequency Analysis

An eigenfrequency analysis finds the eigenfrequencies and modes of deformation of a 
component. The eigenfrequencies f in the structural mechanics field are related to the 
eigenvalues λ returned by the solvers through

In COMSOL Multiphysics you can choose between working with eigenfrequencies 
and working with eigenvalues according to your preferences. Eigenfrequencies are the 
default option for all application modes in the Structural Mechanics Module.

The purpose of the following eigenfrequency analysis is to find the six lowest 
eigenfrequencies and corresponding mode shapes.

f −Im λ( )
2π

----------------=
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Model Library path:  

Structural_Mechanics_Module/Tutorial_Models/component_eigen

M O D E L  D E F I N I T I O N

The geometry, material, loads, and constraints are the same as for the static analysis; 
see the description on page 17 for details.

R E S U L T S

The first six eigenfrequencies are:

M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
The eigenfrequency analysis is described as if it were done after the static analysis 
described on page 17, so the Plane Stress application mode is already selected.

Geometry Modeling
This was already done in the static analysis.

Physics Settings
This model uses the same material, loads, and constraints as the static analysis.

Application Mode Parameters   

Change the analysis type to eigenfrequency analysis:

1 From the Physics menu, choose Properties to open the Application Mode Properties 
dialog box.

The Analysis type list defines which analysis to perform and which equation to solve. 

2 Select Eigenfrequency from the Analysis type list; then click OK.

EIGENFREQUENCY NUMBER FREQUENCY

f1 300.67 Hz

f2 1346.42 Hz

f3 3456.12 Hz

f4 4405.38 Hz

f5 8410.73 Hz

f6 11 kHz
A  M E C H A N I C A L  C O M P O N E N T  |  29



30 |  C H A P T E R
Mesh Generation
This model uses the same mesh, so there is no difference from the static analysis.

Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in 
the Solver Parameters dialog box. This option is enabled as the default, so there is no 
need to change the solver settings. The eigenfrequency solver is the solver associated 
with the eigenfrequency analysis type.

Examine the eigenfrequencies solver parameters

1 From the Solve menu, choose Solver Parameters to open the Solver Parameters dialog 
box.

The Eigenfrequency solver is already selected through the Auto select solver option. 
The number of eigenfrequencies to compute is controlled from the General page. 
Use the default settings to solve for the six lowest eigenfrequencies.

2 Click OK to close the Solver Parameters dialog box.

3 To compute the solution, either click the Solve button (=) on the Main toolbar or 
select Solve Problem from the Solve menu.

Postprocessing and Visualization
You can select which eigenfrequency to work with from a list on the General page in 
the Plot Parameters dialog box. The default plot shows the eigenmode corresponding 
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to the lowest eigenfrequency. The eigenmodes are scaled (normalized) so the size of 
deformations should be compared only within an eigenmode and not among modes.

1 Choose Plot Parameters from the Postprocessing menu.

2 Select the Deformed shape check box on the General page.

3 Select the second eigenfrequency from the Eigenfrequency list.

4 Click the Surface tab and select Total displacement from the Predefined quantities list.
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5 Click OK to close the Plot Parameters dialog box to look at the mode shape of the 
second eiegenfrequency.

Time-Dependent Analysis

A time-dependent analysis solves for the transient solution of the displacements and 
velocities as functions of time. The material properties, forces, and boundary 
conditions can vary in time.

The purpose of this analysis is to find the transient response from a harmonic load with 
the same amplitude as the static load during the first two periods. The excitation 
frequency is 500 Hz, which is between the first and second eigenfrequency found in 
the eigenfrequency analysis.

Model Library path: Structural_Mechanics_Module/Tutorial_Models/
component_transient
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M O D E L  D E F I N I T I O N

The geometry, material, and constraints are the same as for the static analysis (see the 
static description on page 17 for details).

Load
This model uses a harmonic load with an excitation frequency of 500 Hz on the same 
edge and with the same amplitude as the static problem. The expression for the load 
can be written

where t denotes the time.

Damping
Damping is important in a transient analysis but can be difficult to model. For transient 
analysis, the Structural Mechanics Module supports Rayleigh damping and loss factor 
damping. It is also possible to use no damping.

This model uses Rayleigh damping, where you specify damping parameters that are 
proportional to the mass (αdM) and stiffness (βdK) in the following way:

where C is the damping matrix, M is the mass matrix, and K is the stiffness matrix. The 
damping is specified locally; you can specify different damping parameters in different 
parts of the model.

You leave the damping parameters at their default values from the previous analyses 
because they are used only for transient and frequency response analyses.

To find good values for the Rayleigh damping, you can use the relations between the 
critical damping ratio and the Rayleigh damping parameters. It is often easier to 
interpret the critical damping ratios, which are given by

where ξi is the critical damping ratio at a specific angular frequency ωi. Knowing two 
pairs of corresponding ξi and ωi results in a system of equations

Fx 900 2π 500 t⋅ ⋅( )sin⋅=

C αdMM βdKK+=

ξi

αdM

ωi
----------- βdK ωi⋅+⎝ ⎠
⎛ ⎞

2
--------------------------------------------=
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with the damping parameters as the unknown variables.

The structure has a constant damping ratio of 0.1. Select two frequencies near the 
excitation frequency, 200 Hz and 600 Hz, to calculate the damping parameters. You 
can do this in COMSOL Script or MATLAB with the following commands:

b=[0.1;0.1];
A=[1/(2*200*2*pi) 2*pi*200/2; 1/(2*600*2*pi) 2*pi*600/2];
% A*damp=b
damp=A\b;
alphadM=damp(1)
betadK=damp(2)

The result is αdM = 1.88e2, βdK = 3.98e-5.

For more information see the section “Damping” on page 121.

1
2 ω1⋅( )

-------------------
ω1
2

------

1
2 ω2⋅( )

-------------------
ω2
2

------

αdM

βdK

ξ1

ξ2

=
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R E S U L T S

The following plot shows the x- and y-displacements at the bottom end of the edge 
where the load is applied as a function of time:

M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
The time-dependent analysis is described as if it were done after the static analysis 
described on page 17, so the Plane Stress application mode is already selected.

Geometry Modeling
This was already done in the static analysis (see the description on page 17 for details).

Physics Settings

Application Mode Parameters   

Change the analysis type to time-dependent analysis:

1 Select Properties from the Physics menu to open the Application Mode Properties 
dialog box.

The Analysis type list defines which analysis to perform and which equation to solve. 
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2 Select Time dependent from the Analysis type list.

3 Click OK.

Boundary Settings   

The force at the right end is harmonic with the same amplitude as the force in the static 
case and with a frequency of 500 Hz,

Use the unit syntax in COMSOL Multiphysics to specify the force in kN/m and the 
frequency in Hz. The variable t is used by COMSOL Multiphysics to denote the time 
in second. You specify the time steps in the Solver Parameters dialog box, which will be 
explained later in this model.

The left edge is still fixed in both directions.

1 Open the Boundary Settings dialog box by selecting Boundary Settings from the 
Physics menu.

2 Set boundary conditions according to the following table and then click OK:

Subdomain Settings   

Fx 60 103 2π500t( )sin⋅=

BOUNDARY 1 BOUNDARY 12

Page Constraint Load

Constraint condition Fixed Fx 60[kN]*sin(2*pi*500[Hz]*t)

Fy 0
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The material properties are the same as in the static and eigenfrequency analyses. 

1 Select Subdomain Settings from the Physics menu.

2 Click the Damping tab and enter the damping properties according to the following 
table; when done, click OK.

SETTINGS SUBDOMAIN 1

Page Damping

 αdM 1.89e2

 βdK 3.98e-5
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To specify the initial values, click the Init tab.

In this case the initial deformation and velocity are zero, which are the default values. 

Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in 
the Solver Parameters dialog box. The option is enabled as the default, so there is no 
need to change the solver settings. The time-dependent solver is the one associated 
with the time-dependent analysis type. Solving for two periods with an excitation 
frequency of 500 Hz means solving for 4 ms.

Specify the time-dependent solver parameters:

1 Choose Solver Parameters from the Solve menu.

2 Type 0:1e-4:4e-3 in the Times edit field. This means that the solution is saved 
every 0.1 ms during the total solution time of 4 ms.
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3 Type 1e-9 in the Absolute tolerance edit field. This is important for an accurate 
analysis (the absolute tolerance must be smaller than the displacements).

4 Click OK.

5 Compute the solution by clicking the Solve button (=) on the Main toolbar or by 
selecting Solve Problem from the Solve menu.
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Postprocessing and Visualization
You have access to the solution at all the computed time steps by going to the Plot 

Parameters dialog box, then the General page, and selecting them from the Output time 

list. The default plot shows the last time step.

For a more quantitative view of the time evolution of the displacement, plot a graph 
of the displacements in the x and y directions at the lower-left corner as a function of 
time.

1 Select Domain Plot Parameters from the Postprocessing menu.

2 Go to the General page and select all the time steps from the Solutions to use list.

3 Click the Point tab (this selects a point plot automatically).

4 Click at the lower-left corner or select Point 27 from the Point selection list.

5 Select x displacement from the Predefined quantities list.

6 Click Apply to plot the x-displacement.

7 Click the General tab and then select the Keep current plot check box.

8 Click the Point tab and then select y displacement from the Predefined quantities list.
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9 Click Apply to plot the y-displacement.

10 Click OK to close the dialog box.

Frequency Response Analysis

I N T R O D U C T I O N

A frequency response analysis solves for the steady-state response from harmonic 
excitation loads. The loads can have amplitudes and phase shifts that depend on the 
excitation frequency, f:

where F(f) is the amplitude and FPh(f) is the phase shift of the load.

The purpose of this analysis is to find the transient response from a harmonic load with 
an excitation frequency in the range 200–600 Hz, which is near the first 
eigenfrequency found in the eigenfrequency analysis.

Ffreq F f( ) 2πf t FPh f( ) π
180
----------⋅+⋅⎝ ⎠

⎛ ⎞cos⋅=
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Model Library path: Structural_Mechanics_Module/Tutorial_Models/
component_frequency

M O D E L  D E F I N I T I O N

The geometry, material, and constraints are the same as for the static analysis (see the 
static description on page 17 for details).

Loads
This model uses a harmonic load with an excitation frequency between 200 and 600 
Hz on the same edge and with the same amplitude as the static problem.

Damping
Damping is modeled using Rayleigh damping in the same way as for transient analysis 
(see page 29 for details): αdM = 189, βdK = 3.98·10−5

R E S U L T S

The x- and y-displacements at the bottom end of the edge where the load is applied as 
a function of excitation frequency appear in the following figure:

There is a peak near the first eigenfrequency where the steady-state response is as much 
as eight times higher than the static displacement. The amplitude for 500 Hz is below 
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the transient response, which is natural because the damping reduces the transient 
effects.

M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
The frequency response analysis is described as if it were done after the static analysis 
described on page 17, so the Plane Stress application mode is already selected.

Geometry Modeling
This was already done in the static analysis (see the static description on page 17 for 
details).

Physics Settings

Application Mode Parameters   

Change the analysis type to frequency response analysis.

1 Choose Properties from the Physics menu to open the Application Mode Properties 
dialog box.

2 Select Frequency response from the Analysis type list.

The Analysis type list defines which analysis to perform and which equation to solve.

3 Click OK.

Boundary Settings   

Use the same amplitude as for the time-dependent analysis without any phase shift, 
which is the default setting. The left edge is fixed in both directions. In the transient 
analysis you entered the harmonic excitation load explicitly. The frequency response 
analysis uses a harmonic assumption and therefore you only need to specify the 
amplitude of the load, F.

1 Open the Boundary Settings dialog box by selecting Boundary Settings from the 
Physics menu.

2 Set boundary conditions according to the following table; click OK when done.

BOUNDARY 1 BOUNDARY 12

Page Constraint Load

Constraint condition Fixed Fx 60e3
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Subdomain Settings   

The material properties and damping parameters are the same as in the 
time-dependent analysis on page 22.

Computing the Solution
Usually when performing a frequency response analysis you want to sweep over a 
frequency range. This can be done using the parametric solver. The analysis type 
controls which solver to use through the Auto select solver option in the Solver 

Parameters dialog box. This option is enabled as the default, and there is no need to 
change the solver settings. The parametric solver is the one associated with the 
frequency response analysis type. Solving for two periods with an excitation frequency 
of 500 Hz means solving for 0.004 s.

Specify the parametric solver parameters.

1 Select Solver Parameters from the Solve menu to open the Solver Parameters dialog 
box.

2 Go to the General page and enter freq_smps in the Parameter name edit field.
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3 Enter 200:10:600 in the Parameter values edit field to specify an excitation 
frequency from 200 Hz to 600 Hz in steps of 10 Hz.

4 Click OK to close the Solver Parameters dialog box.

If you only want to use the parametric solver to sweep another parameter than the 
excitation frequency, specify the same Analysis type and enter the other parameter in 
the Parameter name edit field. You specify the excitation frequency in the Application 

Scalar Variables dialog box.

5 Select Scalar Variables from the Physics menu to open the Application Scalar Variables 
dialog box.
A  M E C H A N I C A L  C O M P O N E N T  |  45



46 |  C H A P T E R
You specified a sweep using freq as the Name of the parameter in the Solver Parameters 
dialog box, which replaces the value of the Excitation frequency specified in the 
Application Scalar Variables dialog box.

6 Click OK to close the Application Scalar Variables dialog box.

7 To compute the solution, either click the Solve button (=) on the Main toolbar or 
select Solve Problem from the Solve menu.

Postprocessing and Visualization
To view the solution at all the different excitation frequencies, open the Plot 

Parameters dialog box, go to the General page and select among those frequencies. The 
default plot shows the von Mises stress for the last excitation frequency in the list.

1 Select Plot Parameters from the Postprocessing menu.

2 Check Deformed shape plot.

3 On the Surface page, in the Surface Data tab, select von Mises stress from the 
Predefined quantities list.

The result of a frequency response analysis is a complex time-dependent 
displacement field, which can be interpreted as an amplitude, uamp, and a phase 
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angle, uphase. The actual displacement at any point in time is the real part of the 
solution

The software can visualize the amplitudes and phases as well as the solution at a 
specific angle (time). The Solution at angle parameter, which you can find on the 
General page, makes this easy. When plotting, COMSOL Multiphysics multiplies the 
solution by , where is the angle in radians that corresponds to the angle 
specified in degrees in the Solution at angle edit field. The plot shows the real part 
of the evaluated expression

The angle  is available as the variable phase (radians) and can be used in plot 
expressions.

4 Click OK to close the dialog box.

For a more quantitative view of the frequency evolution of the displacement, plot the 
x- and y-displacement amplitude at the lower-left corner as a function of the frequency.

1 Select Domain Plot Parameters from the Postprocessing menu.

u uamp 2πf t uphase+⋅( )cos=

eiφ φ

u uamp φ uphase+( )cos=

φ
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2 Go to the General page and select all the excitation frequencies in the Solutions to 

use list.

3 Click the Point tab (this selects a point plot automatically).

4 Click at the lower-left corner or select Point 27 from the Point selection list.

5 Select Disp. amplitude x-dir. from the Predefined quantities list.

6 Click Apply to plot the x-displacement amplitude.

7 Click the General tab and then select the Keep current plot check box.

8 Click the Point tab and then select Disp. amplitude y-dir. from the Predefined 

quantities list.

9 Click Apply to plot the y-displacement amplitude.

10 Click OK.

Parametric Analysis

A parametric analysis solves for the static response as a function of a parameter. You 
freely define the parameter name and what it affects; it can be a material property, a 
load parameter, or something else.
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The purpose of this example is to find the static response as a function of the direction 
of the force. The force is applied at the same edge as in the static analysis.

Model Library path: Structural_Mechanics_Module/Tutorial_Models/
component_parametric

M O D E L  D E F I N I T I O N

The geometry, material, and constraints are the same as for the static analysis (see the 
description on page 17 for details).

Load
This model uses a static load on the same edge and with the same magnitude as in the 
static model. The force is free to act in any direction.
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R E S U L T S

The x-displacement at the bottom end of the edge where the load is applied as a 
function of the direction of the force (α) is shown in the following plot:

M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
The parametric analysis is described as if it were done after the static analysis on page 
17, so the Plane Stress application mode is already selected.

Geometry Modeling
This was already done in the static analysis (see the description on page 17 for details).

Physics Settings

Application Mode Parameters   

Change the analysis type to parametric analysis.

1 Select Properties from the Physics menu to open the Application Mode Properties 
dialog box.

The Analysis type list defines which analysis to perform and which equation to solve. 

2 Select Parametric from the Analysis type list; then click OK.

Boundary Settings   
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This model uses the same magnitude as for the static analysis, but the direction α is 
added as the parameter to vary. The force is divided into its x- and y-components as a 
function of the force direction, α:

1 Open the Boundary Settings dialog box by selecting Boundary Settings from the 
Physics menu.

2 Set boundary conditions according to the following table:

Because the cosine and sine functions take radians as input, a transformation from 
degrees to radians is done to be able to vary α from 0 to 360°.

Subdomain Settings   

The material properties are the same as in the static analysis on page 22.

Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in 
the Solver Parameters dialog box. This option is enabled as the default so there is no 

BOUNDARY 1 BOUNDARY 12

Page Constraint Load

Constraint condition Fixed Fx 60e3*cos(alpha*pi/180)

Fy 60e3*sin(alpha*pi/180)

Fx 60 103 α( )

Fy

cos⋅

60 103 α( )sin⋅

=

=
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need to change the solver settings. The parametric solver is the one associated with the 
parametric analysis type. 

Specify the force direction α as the parameter to vary between 0 and 360°.

1 Choose Solver Parameters from the Solve menu to open the Solver Parameters dialog 
box.

2 In Parameter, enter alpha in the Parameter name edit field.

3 Enter 0:10:360 in the Parameter values edit field to specify the direction of the 
force between 0° to 360° in steps of 10°.

4 Click OK to close the Solver Parameters dialog box.

5 To compute the solution either click the Solve button (=) on the Main toolbar or 
choose Solve Problem from the Solve menu.

Postprocessing and Visualization
To view the solution for all different directions of the force, open the Plot Parameters 

dialog box, go to the General page, then select from the Parameter value list. The 
default plot shows the von Mises stress for the last direction angle alpha in the list.

For a more quantitative view of the angle evolution of the displacement, plot the 
x-displacement at the lower-left corner as a function of the force direction.

1 Select Domain Plot Parameters from the Postprocessing menu.
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2 Select all load direction angles in the Solutions to use list on the General page.

3 Click the Point tab (this selects a point plot automatically).

4 Click at the lower-left corner or select Point 27 in the Point selection list.

5 Select x-displacement from the Predefined quantities list.

6 Click Apply to plot the x-displacement.

7 Click OK.

Quasi-Static Transient Analysis

A quasi-static transient analysis solves for the transient response where the dynamics of 
the structure are static compared to some other much longer time scale. In this 
example, a transient temperature problem is coupled to the structure, and the 
temperature problem has a much longer time scale than the dynamics of the structure.

The goal of this analysis is to find out for how long time the component can be exposed 
to a temperature of 500 °C before the x-displacement of the loaded edge increases by 
30% compared to the static displacement without thermal expansion.
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Model Library path: Structural_Mechanics_Module/Tutorial_Models/
component_quasi_static

M O D E L  D E F I N I T I O N

The geometry, material, and constraints are the same as for the static analysis (see the 
description on page 17 for details).

The boundary conditions for the temperature problem are:

• The left edge has fixed temperature of 20 °C

• The loaded edge has fixed temperature of 500 °C

• All other edges and both sides of the plate are cooled convectively with:

- External temperature, Tinf = 20 °C

- Heat transfer coefficient, h = 5 W/(m2·°C)

The initial conditions is:

• T = 0 °C

R E S U L T S

In the following figure you can see a plot of the x-displacement versus time at the 
bottom end of the edge where the load is applied.

0.22

0.
01

5

0.
05

Text = 20, h = 5

T = 20

T = 500
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Figure 3-1: The x-displacement at Point 27 as a function of time

From the results you can conclude that it takes 500 s for the displacement to increase 
by 30%.

M O D E L I N G  U S I N G  T H E  G R A P H I C A L  U S E R  I N T E R F A C E

Model Navigator
This time the modeling procedure is described as if starting from scratch.

1 Go to the New page in the Model Navigator, then select 2D from the Space dimension 

list.
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2 Select Structural Mechanics Module>Thermal-Structural Interaction> 
Plane Stress with Thermal Expansion>Quasi-static analysis.

This is a predefined multiphysics coupling that adds both a Plane Stress and a heat 
transfer application mode (Heat Transfer by Conduction or General Heat Transfer 
if the license includes the Heat Transfer Module). The predefined multiphysics 
coupling also sets up the thermal expansion on the Load page in the Subdomain 

Settings dialog box for the Plane Stress application mode.

3 Click OK to close the Model Navigator.

Geometry Modeling
This was described in the static analysis (see the description on page 17 for details).

Physics Settings

Application Mode Properties General Heat Transfer   

Skip to the next section if you are using the Heat Transfer by Conduction application 
mode.

1 Select Properties from the Physics menu to open the Application Mode Properties 
dialog box.

2 From the Out-of-plane heat transfer list box select Enabled, then click OK.

Boundary Settings Plane Stress   
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This model uses the same boundary conditions for the Plane Stress application mode 
as for the static analysis (see page 22 for details).

1 Select Plane Stress from the Multiphysics menu.

2 Apply boundary settings according to “Boundary Settings” on page 22.

Boundary Settings Heat Transfer   

1 Select Heat Transfer by Conduction from the Multiphysics menu, or General Heat 

Transfer if you are using the Heat Transfer Module.

2 Set boundary conditions for the heat transfer application mode according to the 
following table. Click OK when done.

An easy way to apply the settings is if you first select all boundaries, then apply the 
Heat flux boundary condition according to the last two columns of the table. Finish 
by changing the settings for boundary 1 and 12 according to the table.

Subdomain Settings Plane Stress   

BOUNDARY 1 BOUNDARY 12 BOUNDARIES 2–11, 13–30

Boundary 
condition

Temperature Temperature Heat flux

T0 20[degC] T0 500[degC] Tinf 20[degC]

h 5[W/(m^2*K)]
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The material properties for the Plane Stress application mode are the same as in the 
static analysis on page 22.

Specify the reference temperature in the Plane Stress application mode. The 
temperature coupling is already defined because you used the predefined multiphysics 
coupling node in the Model Navigator.

1 Select Plane Stress from the Multiphysics menu.

2 Set the reference temperature for the Plane Stress application mode according to the 
following table:

You can see that the variable T, which is the temperature from the heat transfer 
application mode, is entered by default in the Temp edit field.

Subdomain Settings Heat Transfer by Conduction   

Skip to the next section if you are using the General Heat Transfer application mode 
from the Heat Transfer Module.

Specify the material properties for the heat transfer application mode. The cooling of 
the surfaces is the same as for the boundaries, but you must transform it into cooling 
per volume, taking into account the thickness of the plate and that it has two sides. 

SUBDOMAIN 1

Page Load

Tempref 20[degC]
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Instead of 5, htrans is 2500 coming from division by the thickness and multiplication 
by 2.

1 Select Heat Transfer by Conduction from the Multiphysics menu.

2 Set the subdomain settings for the heat transfer application mode according to the 
following table. Click OK when finished.

Subdomain Settings General Heat Transfer   

Skip to the next section if you are using the Heat Transfer by Conduction application 
mode.

1 Select General Heat Transfer from the Multiphysics menu.

2 Set the subdomain settings according to the following table, then click OK.

Computing the Solution
The analysis type controls which solver to use through the Auto select solver option in 
the Solver Parameters dialog box. The option is enabled as the default so there is no 
need to change the solver settings. The time-dependent solver is the one associated 
with the quasi-static transient analysis type. 

Specify the time-dependent solver parameters:

SUBDOMAIN 1

Page Physics

Library material Structural steel

Text 20[degC]

htrans 2500[W/(m^3*K)]

SUBDOMAIN 1

Page Conduction

Library material Structural steel

Page Out-of-Plane

hu 5[W/(m^2*K)]

hd 5[W/(m^2*K)]

Text,u 20[degC]

Text,d 20[degC]

dz 4[mm]
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1 Select Solver Parameters from the Solve menu to open the Solver Parameters dialog 
box.

2 Enter 0:50:1000 in the Times edit field. This means that the software saves the 
solution every 50 s during the total solution time of 1000 s. This does not influence 
the time-stepping length, only the times when the solution is saved.

3 Click OK.

4 To compute the solution either click the Solve button (=) on the Main toolbar or 
select Solve Problem from the Solve menu.

Postprocessing and Visualization
Look at the final temperature distribution together with the deformed geometry.

1 Select Plot Parameters from the Postprocessing menu.

2 Select the Deformed shape check box in the Plot type area.

3 Go to the Surface page and select Heat Transfer by Conduction (ht)>Temperature (or 
General Heat Transfer (htgh)>Temperature) from the Predefined quantities list.

4 Click OK to close the Plot Parameters dialog box.

For a quantitative view of the time evolution of the displacement, plot the 
x-displacement at the lower-left corner as a function of time.

1 Select Domain Plot Parameters from the Postprocessing menu.
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2 Go to the General page and select all the time steps in the Solutions to use list.

3 Click the Point tab (this selects a point plot automatically).

4 Click at the lower-left corner or select Point 27 from the Point selection list.

5 Select x-displacement from the Predefined quantities list.

6 Click Apply to plot the x-displacement.

7 Click OK to close the Domain Plot Parameters dialog box.
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 4
S t r u c t u r a l  M e c h a n i c s  M o d e l i n g
The objective of this chapter is to give you an insight on how to approach the 
modeling of various structural mechanics problems. The contents cover subjects 
like loads and constraints, units, reaction forces, and material models.
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L o ad s

An important aspect of structural analysis is the formulation of the forces applied to 
the modeled structure. You have the freedom of using custom expressions, predefined 
or user-defined coordinate systems, and even variables from other application modes.

You can apply loads on the Load page of either one of the following dialog boxes: 
Subdomain Settings, Boundary Settings, Edge Settings, or Point Settings. You access these 
from the Physics menu or the Model Tree. This User’s Guide includes a detailed 
description of the above functionality for each application mode in the Structural 
Mechanics Module. Use the Table 4-1 below to locate the relevant page.

Units, Orientation, and Visualization

U S I N G  U N I T S

You can enter loads in any unit, independently of the base unit system in the model, 
because COMSOL Multiphysics automatically converts any unit to the base unit 
system. To use the feature for automatic unit conversion, enter the unit in square 
brackets, for example, 100[lbf/in^2]. You can read more about unit systems in 
“Using Units” on page 183 of the COMSOL Multiphysics User’s Guide.

P R E D E F I N E D  A N D  C U S T O M  C O O R D I N A T E  S Y S T E M S

In the Structural Mechanics Module, two predefined coordinate systems are always 
available when you specify loads. These are the global coordinate system and the local 
tangent and normal coordinate system to the boundary.

Custom coordinate systems are also available and are useful, for example, to specify a 
load in any direction without breaking it up into components. To set up a coordinate 

TABLE 4-1:  LOAD SETTINGS FOR APPLICATION MODES IN THE STRUCTURAL MECHANICS MODULE

APPLICATION MODE LOAD SETTINGS

Continuum Application Modes page 205

Mindlin Plates page 247

Shells page 312

Beams page 270

Trusses page 293

Piezoelectric application modes page 344
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system open the Coordinate Systems dialog box from the Options menu. For a detailed 
explanation of coordinate systems, see Chapter 6, “Coordinate Systems,” on page 144.

V I S U A L I Z I N G  L O A D S

A convenient check for load orientation is to activate the display of load symbols on 
the geometry. You can do this on the Visualization page of the Preferences dialog box, 
which you access from the Options menu. Load symbols are listed on page 154. You 
can also read about visualization settings on page 119 of the COMSOL Multiphysics 
User’s Guide.

Another way to visualize loads is to create plots of the global force or surface tractions 
during postprocessing.

Load Cases

Similar to the familiar concept of load cases, but more powerful, is the parametric 
solver available in all the application modes. You can select the parametric solver from 
the Solver Parameters dialog box which you access from the Solve menu. Here you can 
either select Parametric from the Analysis list or just select Parametric from the Solver 
list, which works together with all of the analysis types. On the General page, you then 
name your parameter and define a list of values. The parameter defined here is available 
in any expression. You can easily control the magnitude, distribution, and even 
location of loads.

A good example on how to set up expressions for controlling position and distribution 
of loads, with the help of the parametric solver, is the model in the Structural 
Mechanics Module Model Library.

Singular Loads

In reality, loads always act on a finite area. However, in a model you can define a load 
on a point or an edge, which leads to singularities. The reason for this is that points 
and lines have no area, so the stress becomes infinite. Because of the stress singularity, 
there are high stress values in the area surrounding the applied load. The size of this 
area and the magnitude of the stresses depend on both the mesh and the material 
properties. The stress distribution at locations far from these singularities is unaffected 
according a to a well-known principle in solid mechanics, the St. Venant’s principle. It 
states that for an elastic body, statically equivalent systems of forces produce the same 
stresses in the body, except in the immediate region where the loads are applied.
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The Figure 4-1 on page 66 shows a plate with a hole in plane stress loaded with a 
distributed load and a point load of the same magnitude. The mesh consists of 
triangular elements with quadratic shape functions. The high stress around the point 
load is dissipated within the length of a few elements for both mesh cases. The stresses 
in the middle of the plate and around the hole are in agreement for the distributed load 
and the point load. The problem is that due to the high stress around the singular load 
it is easy to overlook the high stress region around the hole. When you apply the point 
load, you have to manually set the range for the stress plot to get the same visual 
feedback of the high stress region around the hole in the two cases. This is because the 
default plot settings automatically set the range based on the extreme values of the 
expression that is plotted.

Figure 4-1: A plate with a hole subject to a distributed load (left) and a point load (right).

Despite these findings it is good modeling practice to avoid singular loads because it is 
difficult to estimate the size of the singular region. In the Structural Mechanics 
Module it is possible to define loads on all boundary types. However, avoid singular 
loads altogether with nonlinear and elasto-plastic material models.

normal mesh size

finer mesh size
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Moments in the Continuum Application Modes

The continuum application modes do not have rotational degrees of freedom, which 
makes the specification of moments somewhat cumbersome. To specify moments, you 
can apply a stress distribution which corresponds to the moment.

E X A M P L E :  TO R S I O N A L  M O M E N T  O N  A  C Y L I N D E R

The following steps show how to apply a torsional moment at one end of a cylindrical 
axle in the following figure.

1 In the Model Navigator select 3D from the Space dimension list.

2 In the list of application modes select Structural Mechanics Module> 
Solid, Stress-Strain>Static analysis; then click OK.

Continue by creating a cylinder:

3 In the Draw toolbar click the Cylinder button.

Apply torsional moment at this position
L O A D S  |  67



68 |  C H A P T E R
4 In the dialog box that opens, enter 0.5 as the Radius, 5 as the Height, and define the 
axis of the cylinder along the x-axis by entering 1 in the x edit field and 0 in the y 
and z edit fields in the Axis direction vector area. Click OK.

Next define the radial location as a scalar expression, which you can later use in the 
load expression.

5 Choose Options>Expressions>Scalar Expressions. Enter r in the Name column and 
sqrt(y^2+z^2) in the Expression column. Click OK.

Create a work plane that you can use to define a cylindrical coordinate system.

6 Select Draw>Work-Plane Settings.
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7 On the Face Parallel page in the Work-Plane Settings dialog box select Face 3 from 
the Face selection list. Click OK.

8 A new geometry appears with the work plane that you just created. Switch back to 
the geometry containing the cylinder by clicking the Geom1 page in the Drawing 
area.

Continue by defining a cylindrical coordinate system with the help of the work plane 
you just created.

9 Select Options>Coordinate Systems. Click New in the Coordinate System Settings 
dialog box.

10 Click OK in the New Coordinate System dialog box.

11 Back in the Coordinate System Settings dialog box make sure that Define using work 

plane is selected as well as Geom2 in the Work plane list.
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12 Click the Cylindrical coordinate system button. Enter 0.5 for both the x- and 
y-coordinates of the origin, because these are the coordinates of the center of the 
circular face in the coordinate system of the work plane. Click OK.

Now you can define a shear stress distribution in the tangential direction, which is 
zero at the center and reaches its maximum at the surface of the axle.

13 Select Physics>Boundary Settings to open the Boundary Settings dialog box.

14 Select Boundary 1 from the Boundary selection list.

15 On the Load page select Coordinate system 1 (the one you just created) from the 
Coordinate system list.
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16 Enter tau_0*r in the Fyl edit field. Click OK.

Because the integral of the stress distribution over the boundary must equal the 
moment to satisfy equilibrium, you can easily specify a value for the moment based 
on the stress distribution.

17 Define the boundary integral for the moment. Select Options>Integration Coupling 

Variables>Boundary Variables.

18 In the dialog box that opens select Boundary 1, which is the one where you have 
defined the load.

19 Enter M in the Name column and Taz_smsld*y+Tay_smsld*z in the Expression 
column. Click OK.

20 In this last step you specify a value for the moment through defining an equilibrium 
equation. Choose Physics>Global Equations to open the Global Equations dialog box.
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21 Enter tau_0 in the Name column and M-100 in the Equation column. The value 100 
is the magnitude of the applied moment. This entry defined the equation M − 100 
= 0, that is, M = 100.

22 Constrain the other end face of the cylinder by fixing it before solving the model.

After solving the model you can visualize the moment on the cylinder by an arrow 
plot of the global force on the boundaries.

23 Click the Plot Parameters button on the Main toolbar.

24 On the General page clear the Slice check box and select the Arrow check box.

25 Click the Arrow tab to switch to the Arrow page.

26 From the Plot arrows on list box select Boundaries.

27 From the Predefined quantities list box select Global force.

28 From the Arrow type list box select 3D arrow.

29 From the Arrow length list box select Normalized.

30 Click OK.
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Follower Loads

Follower loads are defined with respect to the geometry and, as the geometry deforms 
locally, the orientation of the load changes. The use of follower loads is meaningful 
only if you have large deformations in your model and have activated the Large 
Deformation option in the Application Mode Properties dialog box. To define a load as 
a follower load you can select Follower load in the Load type list box on the Load page 
of the Boundary Settings dialog box.

Acceleration Loads

Acceleration loads can be found, for example, in the structural mechanics analysis of 
an airplane seat. Acceleration or deceleration of the aircraft produces a force that an 
accurate simulation must include. Because you can use expressions when specifying 
loads, it is easy to model acceleration loads. In the case of the airplane seat, you define 
the acceleration, acc_x, in the Constants dialog box. Then for the appropriate 
subdomains simply enter rho_smsld*acc_x in the Body load x dir. edit field on the 
Load page of the Subdomain settings dialog box. The density rho_smsld is already 
defined for the material and refers to the corresponding edit field. In a similar manner 
it is also possible to specify gravity loads.

For modeling rotating parts under static conditions, you can use centrifugal 
acceleration loads. The body load in the radial direction is

,  (4-1)

where ρ is the density of the material, ω is the angular frequency, and r is the radius.

E X A M P L E :  A  R O T A T I N G  D I S K

This example describes how to specify a body load according to Equation 4-1, using a 
cylindrical coordinate system. The model is that of a disk welded on a shaft, which 
rotates with a constant angular velocity of 90 rad/s.

Kr ρω2r=
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Figure 4-2: The model geometry.

1 In the Model Navigator, select 3D from the Space dimension list.

2 Select Structural Mechanics Module> Solid, Stress-Strain, then click OK.

3 Create the geometry by first drawing two cylinders, then taking the difference 
between them.

4 Click the Cylinder button on the Draw toolbar.

5 Enter 0.1 in the Radius edit field, and 0.01 in the Height edit field. Click OK.

6 Create one more cylinder with a radius of 0.02 and a height of 0.01.

7 Select both objects by typing Ctrl+A on the keyboard.

8 Click the Difference button on the Draw toolbar to create the final geometry.

9 Select Constants from the Options menu.
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10 Enter omega in the Name column and 90[rad/s] in the Expression column.When 
finished click OK.

11 Select Options>Expressions>Scalar Expressions.

12 Enter r in the Name column, and sqrt(x^2+y^2) in the Expression column. Click 
OK.

Next set up the cylindrical coordinate system by first defining a work plane.

13 Select Draw>Work-Plane Settings. 

14 Select the x-y radio button on the Quick page and click OK.

15 The new workplane is now the active geometry. Switch back to your initial 
geometry, by clicking the Geom1 tab at the top of the drawing area.

16 Select Options>Coordinate Systems to open the Coordinate System Settings dialog 
box.

17 Click New, then click OK to accept the default name.

18 On the Workplane page, click the Define using workplane button. From the Workplane 
list, select Geom2.
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19 Select the Cylindrical coordinate system and click OK. 

You can now define the radial body load, by using the defined coordinate system.

20 Open the Subdomain Settings dialog box from the Physics menu.

21 Select the only subdomain and then go to the Load page.

22 From the Coordinate system list, select the coordinate system you have just defined.

23 Enter rho_smsld*omega^2*r in the Fxl edit field, and then click on OK.

Before solving the model you need to constrain the disk.

24 From the Physics menu, select Boundary Settings.

25 From the list of boundaries, select boundary 5, 6, 8, and 9.

26 Select Prescribed displacement from the Constraint condition list, and then select 
Tangent and normal coord. sys. (t1,t2,n), from the Coordinate system list.

27 Select the Rn check box, and then click OK.

28 From the Physics menu select Point settings.

29 Select point 3, then select the Rz check box.

30 Click OK.

31 Open the Free Mesh Parameters dialog box from the Mesh menu.

32 From the list of predefined mesh sizes, select Finer, and then click OK.
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33 Click the Solve button on the Main toolbar to compute the solution.

Figure 4-3: The von Mises stress distribution.

34 Click the Plot Parameters toolbar button.

35 In the Plot type area, clear the Slice check box and select the Subdomain check box.

36 Click OK to create the plot shown in Figure 4-3.

Temperature Loads—Thermal Expansion

When performing thermal expansion analysis, you specify temperature loads by 
entering a temperature and a reference temperature on the Load page of the Subdomain 

Settings dialog box. You can enter a constant temperature as well as an analytic 
expression that can depend on the coordinates or dependent variables. More details are 
available in the descriptions for each application mode (see Table 4-1 on page 64).

When you use a separate application mode to model heat transfer in the material, the 
entry for the temperature is the dependent variable for the temperature from that 
application mode, typically T. Read more about how to couple heat transfer analysis 
with structural mechanics analysis on page 114.
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The Structural Mechanics Module also includes a predefined multiphysics coupling to 
a heat transfer application mode. See “Thermal-Structure Interaction” on page 354 for 
more information.

Total Loads

You can specify a load either as a distributed load per unit length, area, or volume, or 
as a total force to be uniformly distributed on a boundary.

When you apply a distributed load on a boundary, the Structural Mechanics Module 
provides a way to check that the total force is correct without having to solve the 
model. After you have entered the load, choose Solve>Get Initial Value. Then choose 
Postprocessing>Boundary Integration. In the dialog box that appears, you can select a 
boundary and from the Predefined quantities list select a face load in 3D or an edge load 
in 2D. Click Apply to display the value of the integral, which is the value of the total 
force in the selected direction, in the message log.

Similarly you can check the total body load by subdomain integration of the 
appropriate component of a body load.
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Con s t r a i n t s

Defining the proper constraints for structural mechanics models is just as important as 
defining the loads. Together they make up the boundary conditions of a model. The 
Structural Mechanics Module provides many useful features to define various types of 
constraints. Besides all the predefined options, you can use any expressions to define 
constraints of your choice.

From the Physics menu, you can access the dialog boxes where you can define 
constraints. Depending on your model these can be one or more of the Subdomain 

Settings, Boundary Settings, Edge Settings or Point Settings dialog boxes. Each 
application mode description includes a complete list of available options for constraint 
settings, use the following table to find the appropriate pages.

Orientation and Visualization

You can specify constraints in both global and local coordinate systems. Beside these, 
you can use any coordinate system that you have previously defined in the Coordinate 

System Settings dialog box, which you access from the Options menu. Coordinate 
systems are further explained on page 144.

When you turn on the visualization of load and constraint symbols from the Preferences 
dialog box, COMSOL Multiphysics displays all applied constraints with symbols on 
the geometry. See page 156 for a list of the symbols for constraints.

APPLICATION MODE CONSTRAINT SETTINGS

Continuum Application 
Modes

page 201

Mindlin Plates page 244

Shells page 307

Beams page 265

Trusses page 289

Piezoelectric application 
modes

page 342
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Symmetry Constraints

In many cases you can use symmetry of the geometry and loads to your advantage in 
modeling. Symmetries can often greatly reduce the size of a model and hence reduce 
the memory requirements. When a structure exhibits axial symmetry, you can use the 
axisymmetric application modes. A solid that you can generate by rotating a planar 
shape about an axis is said to have axial symmetry.

For other types of symmetry, you can use many of the predefined symmetry constraints 
available in the user interface of the Structural Mechanics Module. This means that you 
do not have to enter any expressions—instead just select the type of constraint you 
want to apply from a list.

If the geometry exhibits two symmetry planes, as shown in the figure below, you can 
model a quarter of the geometry by selecting Symmetry plane from the Constraint 

condition list on the Constraint page in the Boundary Settings dialog box for the two 
selected surfaces.

As mentioned earlier not only the symmetry of the geometry but also that of the load 
is important in selecting the correct constraints for your model. Figure 4-4 on page 81 
illustrates symmetric and antisymmetric loading of a symmetric geometry. When 
modeling half of the geometry, the correct constraint for the face at the middle of the 

Symmetry planes
Apply Symmetry plane
boundary condition
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object would be Antisymmetry plane in the case of antisymmetric loading and Symmetry 

plane in the case of symmetric loading of the object.

Figure 4-4: Symmetry plane (left) and antisymmetry plane (right).

You can often take advantage of symmetry by using the superposition principle and 
thus reduce the size of models. The superposition principle states that for linear elastic 
materials you can solve separately for different load cases and superpose or add the 
solutions afterwards. For symmetric objects, it is possible to separate any load into a 
symmetric load and antisymmetric load. Thus, you can solve two models on half of the 
geometry and later superpose or add the solutions. Read about how to apply this 
technique to analyze a wheel rim of a car in the description of the model “Automobile 
Wheel Rim” on page 108 of the Structural Mechanics Model Library.

Kinematic Constraints

Kinematic constraints are equations that control the motion of solids, faces, edges, or 
points. Select Prescribed displacement from the Constraint Condition list to enter 
expressions for constraints. You can define the equations using both predefined 
coordinate systems and custom coordinate systems. Special constraints, for instance to 
keep an edge of body straight or to make a boundary rotate, require such constraint 
equations.

E X A M P L E :  S T R A I G H T  E D G E  C O N S T R A I N T  B Y  E Q U A T I O N S

The following short example shows how to implement constraint equations to keep an 
edge of a solid body straight during deformation. The three linear constraints 

Symmetry plane Antisymmetry plane
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(Equation 10-18) are derived starting on page 281 and are used to keep truss elements 
straight in the 3D truss application modes.

1 In the Model Navigator select 3D from the Space dimension list.

2 In the list of application modes select Structural Mechanics Module>Solid, 

Stress-Strain>Eigenfrequency analysis; then click OK.

Continue by creating a bar with a rectangular cross section.

3 On the Draw toolbar click the Block button. In the dialog box that appears enter 5 
in the X edit field under the Length label. Click OK.

Continue by defining point extrusion variables, which you can use in the constraint 
equation.

4 Select Options>Extrusion Coupling Variables>Point Variables, which opens the Point 

Extrusion Variables dialog box.

Keep this edge straight

Fixed boundary
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5 From the Point selection list select Point 2. Enter the expressions belonging to this 
point from the following table in the Name and Expression columns. Make sure to 
select General transformation for each variable.

6 Select Point 6 and enter the variables and expressions listed for this point. Select 
General transformation for each of these variables as well.

Next you define the destination for the variables. This is the edge to which you apply 
the constraint equation.

7 On the Destination page select x1 in the Variable list, then select Edge in the Level list. 
Now select the check box in front of Edge 5 in the Edge selection list.

POINT 2 POINT 6

NAME EXPRESSION NAME EXPRESSION

x1 x x2 x

y1 y y2 y

z1 z z2 z

u1 u u2 u

v1 v v2 v

w1 w w2 w
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8 Repeat the previous step for each of the variables in the Variable list. Close the dialog 
box by clicking OK.

In the next steps you specify expressions which simplify the definition of the 
constraint equations.
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9 Select Options>Expressions>Edge Expression. In the Edge Expressions dialog box 
select Edge 5 and enter the following expressions in the Name and Expression 
columns. Click OK.

In the last step you set the constraints for the edge. In the graphical user interface 
you can use the general notation which allows you to specify a system of equation 
containing any linear combination of displacement components.

NAME EXPRESSION

a21 x2-x1

b21 y2-y1

c21 z2-z1

xn (x*a21+y*b21+z*c21)/sqrt(a21^2+b21^2+c21^2)

xn1 (x1*a21+y1*b21+z1*c21)/sqrt(a21^2+b21^2+c21^2)

xn2 (x2*a21+y2*b21+z2*c21)/sqrt(a21^2+b21^2+c21^2)

xn21 xn2-xn1

xn2n xn2-xn

xnn1 xn-xn1

R1 -c21*(u1*xn2n+u2*xnn1)/xn21+a21*(w1*xn2n+w2*xnn1)/xn21

R2 -c21*(v1*xn2n+v2*xnn1)/xn21+b21*(w1*xn2n+w2*xnn1)/xn21

R3 -a21*(v1*xn2n+v2*xnn1)/xn21+b21*(u1*xn2n+u2*xnn1)/xn21
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10 Open the Edge Settings dialog box by selecting Physics>Edge Settings. Select Edge 5 
and select the General Notation check box.

11 Click the Edit button next to the H label and enter the following matrix:

The H matrix multiplied by the displacement vector makes up the left hand side of 
the equation system, while the R vector which you enter next is the right hand side.

12 Click OK.

13 Click the Edit button next to the R label and enter the following vector:

c21– 0 a21
0 c21– b21

b21 a21– 0

R1
R2
R3
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14 Click OK.

15 Click OK to close the Edge Settings dialog box.

16 In the Boundary Settings dialog box apply the Fixed constraint to Boundary 1, then 
click OK.

17 Click the Solve button on the Main toolbar to solve the problem.

Next create a deformed shape plot of the bar. For better visualization of the straight 
edge plot the last eigenfrequency, which is 467.6 Hz.

18 Click the Plot Parameters button on the Main toolbar.

19 On the General page clear the Slice check box and select the Boundary and Deformed 

shape check boxes.

20 From the Solution to use list select the last eigenfrequency, which is 467.626 Hz.

21 Click OK.

E X A M P L E :  S T R A I G H T  E D G E  C O N S T R A I N T  B Y  T R U S S  E L E M E N T S

An alternate method to that shown in the example on page 75 is to enforce the 
straight-edge constraint of a solid by adding a 3D Truss application mode to a model 
and activate it only on the edge to be constrained. Keep in mind that by adding truss 
elements to the model you add both additional mass and stiffness to the problem, 
which can influence the results.

1 Repeat Steps 1 to 3 of the example on page 81.

2 In the Boundary Settings dialog box apply the Fixed constraint to Boundary 1, then 
click OK.

Continue by adding a truss application mode to the model.
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3 Select Multiphysics>Model Navigator.

4 In the list of application modes select 
Structural Mechanics Module>3D Truss>Eigenfrequency analysis. Click Add, then click 
OK.

5 Select Physics>Edge Settings to open the Edge Settings dialog box for the truss 
application mode.

6 Select Edges 1–4 and 6–12, then clear the Active in this domain check box.

Next change the element type for the Truss application mode so that it is compatible 
with the default element type used in the Solid, Stress-Strain application mode.
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7 Select Edge 5. On the Element page select Lagrange - Quadratic from the Predefined 

elements list.

Decrease the density and Young’s modulus of the truss, so that it does not influence 
the results.

8 On the Material page, enter 1 in the E edit field and 0 in the ρ edit field. Click OK.

9 Click the Solve button on the Main toolbar to solve the problem.

10 Repeat Steps 18–21 from the previous example to verify that the solution is similar.
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Rotational Joints

Joints between elements in the In-Plane Truss and 3D Truss application modes are 
automatically rotational joints because the truss elements have no rotational degrees of 
freedom. In an application mode for beams, however, the rotational degrees of 
freedom are by default coupled between elements. To create a rotational joint between 
two beam elements, add one additional In-Plane Euler Beam or 3D Euler Beam 
application mode to your geometry. Make sure that it is only active for the boundary 
that includes the point where the joint will be positioned and that no other application 
mode is active here. Couple the translational degrees of freedom and leave the 
rotational degrees of freedom uncoupled at the joint. This procedure is described for 
a simple 2D case in the following example.

E X A M P L E :  R O T A T I O N A L  J O I N T  B E T W E E N  2 D  B E A M  E L E M E N T S

In this example you set up a rotational joint by using two In-Plane Euler Beam 
application modes. You also use boundary expressions to gain access to dependent 
variables of both application modes during postprocessing.

1 In the Model Navigator select 2D from the Space dimension list.

2 In the list of application modes select Structural Mechanics Module>In-Plane Euler 

Beam>Eigenfrequency analysis; then click OK.

Fixed point Pinned point

Rotational joint
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3 Hold down the Shift key and click the Line button on the Draw toolbar. Enter the 
following values for the line B1:

4 Click OK.

5 To draw the next line segment, hold down the Shift key and click the Line button 
on the Draw toolbar. Enter the following values for the line B2:

6 Click OK.

7 Select Physics>Boundary Settings. In the Boundary selection list select Boundary 2 
and clear the Active in this domain check box, then click OK.

EDIT FIELD B1

x -1 0

y 0 0

EDIT FIELD B2

x 0 1

y 0 0
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8 Select Physics>Point Settings. Select Point 1 from the Point selection list and on the 
Constraint page select Fixed from the Constraint condition list.

9 Click OK.

Continue by adding one more beam application mode to the model.

10 Select Multiphysics>Model Navigator.

11 In the list of application modes select 
Structural Mechanics Module>In-Plane Euler Beam>Eigenfrequency analysis. Click Add, 
then click OK.

Now you can edit the physics settings of the second application mode and couple 
the two together.

12 If the Model Tree is not visible click the Model Tree button on the Main toolbar to 
make it visible.

13 In the Model Tree click the Detail button or the Inspect button.

14 Expand the In-Plane Euler Beam (smeulip2) branch and double click Boundary Settings 
to open the Boundary Settings dialog box for this application mode.

15 In the Boundary selection list select Boundary 1 and clear the Active in this domain 
check box, then click OK.

16 Under the In-Plane Euler Beam (smeulip2) branch double-click Point Settings to open 
the Point Settings dialog box for this application mode.
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17 In the Point selection list select Point 3 and on the Constraint page select Pinned from 
the Constraint condition list.

18 Now select Point 2 and select Prescribed displacement from the Constraint condition 
list.

19 Select the Rx check box and enter u in the edit field next to it.

20 Select the Ry check box and enter v in the edit field next to it. Click OK.

Now you can create boundary expressions that take the value of the displacement 
variables from both of the application modes and make them available on the entire 
geometry for postprocessing.

21 Select Options>Expressions>Boundary Expressions.
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22 In Boundary Expressions dialog box select Boundary 1 and enter the following:

23 Select Boundary 2 and fill in the Expression column according to the table below:

24 Click OK.

25 Click the Solve button on the Main toolbar to solve the problem.

To see the deformation of the entire geometry you can use the boundary 
expressions you have defined.

26 Click the Plot Parameters button on the Main toolbar.

27 On the General page select the Boundary and Deformed shape check boxes.

NAME EXPRESSION

my_u u

my_v v

NAME EXPRESSION

my_u u2

my_v v2
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28 On the Deform page, click the Boundary Data tab. Enter my_u in the x component edit 
field and my_v in the y component edit field.

29 On the Boundary page enter sqrt(my_u^2+my_v^2) in the Expression edit field. 
Click OK to plot the results.
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Re a c t i o n Fo r c e s

There are two possibilities for calculating the reaction forces on constrained 
boundaries in the Structural Mechanics Module. To get accurate results you can 
activate weak constraints which adds extra variables, corresponding to the reaction 
forces, to the solution components. You can also obtain approximate values without 
adding additional DOFs to the model by evaluating the surface traction on constrained 
boundaries.

Continuum Application Modes

C A L C U L A T I N G  B Y  U S I N G  WE A K  C O N S T R A I N T S

To get the maximum accuracy for reaction forces, activate weak constraints for the 
application mode by selecting On in the Weak Constraints list box in the Application 

Mode Properties dialog box. Make sure that Ideal is selected for the Constraint type.

With weak constraints activated, COMSOL Multiphysics adds the reaction forces to 
the solution components. The variables in 3D are denoted lm1, lm2, and lm3 (for 
Lagrange multipliers). Only the first two are present in 2D application modes. The 
following table shows the interpretation of these variables on the boundaries.

VARIABLE CORRESPONDS TO REACTION FORCE IN THE DIRECTION OF THE FOLLOWING 
AXES

GLOBAL COORDINATE SYSTEMS LOCAL GEOMETRICAL 
COORDINATE SYSTEMS

USER-DEFINED 
COORDINATE 
SYSTEMS

3D 2D 2D AXI- 
SYMMETRIC

3D 2D

lm1  x  x  r  t1  t  x1
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It is only possible to evaluate reaction forces on constrained boundaries in the 
constraint directions. Coordinate systems available in the Structural Mechanics 
Module are explained on page 144.

In order to calculate the reaction force on a boundary, you can carry out a boundary 
integration of one of the variables lm1, lm2, or lm3 in the Boundary Integration dialog 
box. COMSOL Multiphysics displays the value of the integral in the message log.

In a similar fashion use the Subdomain Integration, Edge Integration, or Point Evaluation 
dialog boxes to evaluate the reaction forces for constraints applied on these boundary 
types.

Because the reaction force variables are added to the solution components, the number 
of DOFs for the model increases slightly, depending on the mesh size for the 
boundaries in question.

With weak constraints activated, you are able to individually turn off weak constraints 
for boundaries on the Weak Constr. page of the Boundary Settings dialog box. However, 
boundaries that are adjacent to each other must have the same settings. The reason for 
this is that adjacent boundaries share a common node. Read more about the use of 
weak constraints on page 300 of the COMSOL Multiphysics Modeling Guide.

lm2  y  y  z  t2  n  x2

lm3  z - -  n -  x3

VARIABLE CORRESPONDS TO REACTION FORCE IN THE DIRECTION OF THE FOLLOWING 
AXES

GLOBAL COORDINATE SYSTEMS LOCAL GEOMETRICAL 
COORDINATE SYSTEMS

USER-DEFINED 
COORDINATE 
SYSTEMS

3D 2D 2D AXI- 
SYMMETRIC

3D 2D
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C A L C U L A T I N G  B Y  U S I N G  S U R F A C E  TR A C T I O N

By an alternative method, you can obtain an approximation to the reaction forces on 
constrained boundaries using boundary integration of the relevant components of the 
surface traction vector.

In 2D application modes, you need to multiply the surface traction by the cross section 
thickness before integrating to calculate the total reaction force. This method is less 
accurate than solving for the reaction forces by the use of weak constraints.

Other Application Modes

Evaluate the reaction forces or moments similarly as for the continuum application 
modes (see page 96). Use the following tables to identify the variables and 
corresponding forces or moments.
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TR U S S  A P P L I C A T I O N  M O D E S

B E A M  A P P L I C A T I O N  M O D E S

VARIABLE CORRESPONDS TO REACTION FORCE IN THE DIRECTION OF THE 
FOLLOWING AXES

GLOBAL COORDINATE SYSTEM LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE 
SYSTEM

3D 2D 2D

lm1  x  x  t  x1

lm2  y  y  n  x2

lm3  z - -  x3

VARIABLE CORRESPONDS TO REACTION FORCE IN THE DIRECTION OF THE FOLLOWING AXES

GLOBAL COORDINATE 
SYSTEM

BEAM LOCAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE SYSTEM

3D 2D 3D 2D 3D 2D

lm1 x x xlocal t x1 x1

lm2 y y ylocal n x2 x2

lm3 z - zlocal - x3 -

VARIABLE CORRESPONDS TO REACTION MOMENT AROUND THE FOLLOWING AXES

GLOBAL COORDINATE 
SYSTEM

BEAM LOCAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE SYSTEM

3D 2D 3D 2D 3D 2D

lm3 - z - z - x3

lm4 x - xlocal - x1 -

lm5 y - ylocal - x2 -

lm6 z - zlocal - x3 -
R E A C T I O N  F O R C E S  |  99



100 |  C H A P T E R
S H E L L  A P P L I C A T I O N  M O D E

M I N D L I N  P L A T E  A P P L I C A T I O N  M O D E

VARIABLE CORRESPONDS TO REACTION FORCE IN THE DIRECTION OF THE 
FOLLOWING AXES

GLOBAL 
COORDINATE 
SYSTEM

SHELL LOCAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE 
SYSTEM

lm1 x xlocal t1 x1

lm2 y ylocal t2 x2

lm3 z zlocal n x3

VARIABLE CORRESPONDS TO REACTION MOMENT AROUND THE FOLLOWING 
AXES

GLOBAL 
COORDINATE 
SYSTEM

SHELL LOCAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE 
SYSTEM

lm4 x xlocal t1 x1

lm5 y ylocal t2 x2

lm6 z zlocal n x3

VARIABLE CORRESPONDS TO REACTION FORCE IN THE 
DIRECTION OF THE FOLLOWING AXES

GLOBAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE 
SYSTEM

lm1 z z z

VARIABLE CORRESPONDS TO REACTION MOMENT AROUND 
THE FOLLOWING AXES

GLOBAL 
COORDINATE 
SYSTEM

LOCAL 
GEOMETRICAL 
COORDINATE 
SYSTEM

USER-DEFINED 
COORDINATE 
SYSTEM

lm2 x t x1

lm3 y n x2
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Ma t e r i a l  Mode l s

A wide variety of material models is available in the Structural Mechanics Module. In 
addition, you can extend these models by modifying or defining your own material 
models. The chapters of this book dealing with the different application modes contain 
theory background and information about entering material settings in the graphical 
user interface, as well as application mode specific information. While all the material 
models are available in the continuum application modes, the other application modes 
use only linear elastic stress-strain relationship. Use the table below to locate the 
appropriate pages.

In the present section you find tips and tricks related to the use of material models in 
the Structural Mechanics Module.

Linear Elastic Materials

While for the isotropic case two parameters are enough to describe the material 
behavior, the number of parameters increases to (at most) 21 for the anisotropic case 
in 3D. When setting up a model make sure that the parameters you use are defined in 
agreement with the definitions used in the Structural Mechanics Module. The 
stress-strain relationship for linear elastic materials is discussed on page 167. If 
necessary, transform the material data before entering it in the user interface. For 
example, for orthotropic materials calculate the Poisson’s ratio νxy by

.

APPLICATION MODE THEORY BACKGROUND MATERIAL SETTINGS

Continuum Application Modes page 166 page 193

Mindlin Plates page 229 page 240

Shells page 301 page 306

Beams page 254 page 261

Trusses page 280 page 287

Piezoelectric application modes page 319 page 328

νxy νyx
Ex

Ey
------=
M A T E R I A L  M O D E L S  |  101



102 |  C H A P T E R
Hyperelastic Materials

Two of the most widely used phenomenological models for hyperelastic materials: the 
Neo-Hookean and Mooney-Rivlin material models, are predefined in the Structural 
Mechanics Module. In addition, using predefined and custom stress and strain 
measures you can specify other material models. Read more about this on page 109.

Extracting the parameters for the material models from experimental stress strain 
curves involves curve fitting with the appropriate equations for the nominal 
(Piola-Kirchhoff) stress. These can be derived from the general stress strain 
relationship for hyperelastic materials, Equation 7-3, for a known strain state.

For a thin sheet of incompressible hyperelastic material under uniaxial tension the 
stretch along the axis of the loading is λ1 = λ = 1 + ε, where ε is the strain. Due to 
symmetry and incompressibility the stretch ratios in the transverse directions are 
λ2 = λ3 = λ−1/2. The stress state corresponding to this state of deformation is reduced 
to P1 = P, P2 = P3 = 0, where

.  (4-2)

Assume a strain energy function, Whyp, according to the Mooney-Rivlin material 
model, Equation 7-5, for which Equation 4-2 becomes

.  (4-3)

Use Equation 4-3 to curve fit the parameters C10 and C01 from a uniaxial stress-strain 
curve, as demonstrated by the following example script.

E X A M P L E :  S C R I P T  F O R  C U R V E  F I T T I N G  O F  P A R A M E T E R S  O F  T H E  

M O O N E Y - R I V L I N  M A T E R I A L  M O D E L

In the beginning of the script, stress and strain data are stored in the vectors 
engStressExp and engStrain, respectively. Then, the stretch, lam1, is calculated from 
the strain, followed by solving the equation for C10 and C01. Both the experimental 
and fitted data are plotted at the end.

% Example
% Use least-squares analysis to curve fit C01 and C10 for a
% Mooney-Rivlin material from experimental stress strain data.
engStrain = [0, .075, .103, .15, .174, .2004, .25, .305, .351, .37];
engStressExp = [0, 4.9e5, 8.67e5, 1.36e6, 1.55e6, 1.71e6, 1.95e6, 
2.10e6, 2.17e6, 2.21e6];

P 2 λ λ 2–
–( )

∂Whyp
∂I1

---------------- 1
λ
---

∂Whyp
∂I2

----------------+⎝ ⎠
⎛ ⎞=

P 2 λ λ 2–
–( )C10 2 1 λ 3–

–( )C01+=
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% Calculate stretch and set up equation system
lam1 = 1 + engStrain;
lam1=lam1';
CoeffMatrix = zeros(length(engStrain),2); 
CoeffMatrix(:,1)  = 2./lam1.*(lam1.^2-1./lam1);
CoeffMatrix(:,2)  = 2./(lam1.^2).*(lam1.^2-1./lam1);

% Solve for C10 and C01
C10C01=CoeffMatrix\engStressExp';

% Calculate stress from this data
engStressMRML = CoeffMatrix*C10C01;
%Plot
plot(engStrain, engStressExp,'*', engStrain, engStressMRML, '-');
legend('Experimental data','Curve fit');

Elasto-Plastic Materials

The Elasto-Plastic Material Settings dialog box is prepared for directly entering three 
types of hardening models: perfectly plastic hardening, isotropic hardening, and 
kinematic hardening. You also have the choice to use von Mises or user-defined yield 
functions. The implementation of elasto-plastic material models in the Structural 
Mechanical Module works best for strains within the small strain range and permits 
large deformations.
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To specify a hardening function for an elasto-plastic material model with isotropic 
hardening, enter it as an expression or use a function specified by a function table. In 
both cases the hardening function is a function of the effective plastic strain, εpe, and 
has to describe the behavior starting at the yield stress of the material. For the 
derivation of the hardening function, note that the experimental stress curve is a 
function of the total strain, which is the sum of the plastic strain and the elastic strain. 
Thus, the total effective strain can be written as

 (4-4)

where σe is the effective stress and E is the Young’s modulus for the material. Based 
on the experimental stress function, σexp, the hardening function can now be defined 
as

 (4-5)

where σys is the yield stress for the material.

E X A M P L E :  U S E  O F  S T R E S S - S T R A I N  C U R V E  A S  H A R D E N I N G  F U N C T I O N

The following steps show how to specify a hardening function based on a stress-strain 
curve from a uniaxial tension test. The model shows the loading under tension of a thin 
plate with a hole in the center. Due to symmetry analyze only a quarter of the plate.

1 In the Model Navigator select 2D from the Space dimension list.

εeff εpe
σe
E
-----+=

σyhard σexp εeff( ) σys σexp εpe
σe
E
-----+⎝ ⎠

⎛ ⎞ σys–=–=

Distributed load

Symmetry
boundary
condition
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2 In the list of application modes select Structural Mechanics Module>Plane 

Stress>Static analysis elasto-plastic material; then click OK.

Create the geometry for the model. First, draw a rectangle, then a circle, and finally 
take the difference of these two objects to get the geometry for the plate.

3 Hold down the Shift key and click the Rectangle/Square button on the Draw toolbar. 
Enter 0.22 in the Width edit field and enter 0.45 in the Height edit field. Click OK.

4 Hold down the Shift key and click the Ellipse/Circle (Centered) button on the Draw 
toolbar. In the Radius edit field enter 0.11. Click OK.

5 With both objects selected click the Difference button on the Draw toolbar.

Continue by defining the experimental stress strain data as an interpolation function 
based on a table.

6 Select Options>Functions. Click New in the dialog box that opens. Enter 
stress_strain_curve in the Function name edit field and select the Interpolation 
radio button. Make sure that Table is selected in the Use data from list box and click 
OK.

7 In the Functions dialog box select Cubic spline from the Interpolation method and 
enter the data shown in the figure below in the x and f(x) columns.
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8 Click the Plot button to see a plot of both the entered data points and the 
interpolated curve.

9 Click OK to close the Functions dialog box.

Next define the constants for the material parameters and the expression for the 
hardening function, based on the second part of Equation 4-5.

10 Select Options>Constants to open the Constants dialog box and enter the following 
constants; click OK when finished.

11 Select Options>Expressions>Scalar Expressions and enter the expression from the 
following table. Click OK when finished.

The variables epe_smps and mises_smps are the effective plastic strain and the 
effective stress according to von Mises, respectively. The suffix changes depending 

NAME EXPRESSION DESCRIPTION

E 71.2e9 Young’s modulus

nu 0.31 Poisson’s ratio

sigma_yield 260e6 Yield strength

Area 0.45*0.002 Area of cross section

NAME EXPRESSION DESCRIPTION

sigma_hard stress_strain_curve(epe_
smps+mises_smps/
E)-sigma_yield

Stress increase from the 
yield stress level due to 
hardening
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on the application mode, in this case _smps denotes the Plane Stress application 
mode.

12 Select Physics>Subdomain Settings. In the Subdomain selection list select Subdomain 
1 and enter E in the E edit field and nu in the ν edit field.

13 Click the Elasto-Plastic Material Data button to open the Elasto-Plastic Material 

Settings dialog box. Enter sigma_yield in the σys edit field. Click the Hardening 

function data option button and enter sigma_hard in the σyhard(εp) edit field.

Now enter the material parameters and boundary conditions for the model.

14 Click OK and then click OK again in the Subdomain Settings dialog box.

15 Select Physics>Boundary Settings. In the Boundary selection list select Boundaries 1 
and 3. On the Constraint page select Symmetry plane from the Constraint condition 
list box.
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16 Select Boundary 2 and on the Load page enter Load/Area in the Fy edit field. Click 
the Edge load is defined as fore/area using the thickness button; then click OK.

The last step is to define the load parameter and solve the problem.

17 Click the Solver Parameters button on the Main toolbar. Enter Load in the Parameter 

name edit field and enter 10e3:10e3:45e3 49e3 54e3 55e3:10e3:145e3 
147e3:10e3:167e3 in the Parameter list edit field. Click OK.

18 Click the Solve button on the Main toolbar to solve the problem.

To visualize the solution you can plot the plastic strain.

19 Click the Plot Parameters toolbar button.

20 In the dialog box that opens switch to the Surface page.

21 From the Predefined quantities list, select Plane Stress (smps)>effective plastic strain.

22 Click OK.

Mixed Formulation

As described on page 170, the negative mean stress becomes an additional dependent 
variable when you select the Use mixed U-P formulation check box on the Material page 
of the Subdomain Settings dialog box. Select this setting when the Poisson’s ratio of a 
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material is close to 0.5, which means that the material is nearly incompressible. The 
mixed formulation is useful not only for elastic materials but also for elasto-plastic and 
hyperelastic materials.

Note that not all iterative solvers work together with mixed formulation because the 
stiffness matrix becomes indefinite. You can find recommendations on solver settings 
for the mixed formulation on page 126. It is also important to remember that because 
the shape function for the pressure must be one order less than the shape functions for 
the displacements, it is not possible to use linear elements for the displacement 
variables on the subdomains where mixed formulation is turned on.

User-Defined Materials

For most cases when a material model is not readily available in the graphical user 
interface, you can implement it by modifying or adding necessary equations and 
expressions.

For example, you can define a new hyperelastic material model by following these short 
steps of entering constants and variables and editing the strain energy function:

• Define the material parameters that you want to use in the strain energy function. 
Do this in the Constants dialog box that you open from the Options menu.

• Specify additional strain invariants to use in the strain energy expression, if 
applicable. Read about application mode variables in the Structural Mechanics 
Module Reference Guide. To include custom strain invariants in the strain energy 
function enter these as expressions. For example, choose Options>Expressions>Scalar 

Expressions to enter expressions that becomes available on the current geometry.

• Edit the definition of the strain energy function. Choose 
Physics>Equation Systems>Subdomain Settings and in the dialog box that opens click 
the Variables tab. Locate and edit the expression for the variable named Ws_smsld, 
which is the strain energy function. The index appended to the name Ws may be 
different depending on the application mode’s name.

Example models in the Structural Mechanics Module Model Library provide further 
insight into how to use other types of constitutive equations in your models. Read 
about how to model the viscoelastic behavior of polymer material on page 443 and 
about modeling thermally induced creep in metals on page 479. These models provide 
good examples on setting up custom constitutive equations.
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Ma t e r i a l  L i b r a r i e s

A useful feature in COMSOL Multiphysics is the Materials/Coefficients library. In 
addition to the Basic Material Properties library the Structural Mechanics Module 
extends this library with two extra material libraries:

• MEMS Material Properties, an extended solid material library for MEMS 
applications. See “MEMS Material Properties Library” on page 111.

• Piezoelectric Material Properties, a material library with 23 common piezoelectric 
materials. See the section “Piezoelectric Material Properties Library” below.

The Basic Material Properties library is included with COMSOL Multiphysics and 
contains properties for a limited number of basic solid materials, given as constants, 
and temperature-dependent properties for air and water, given as functions.

For more information about using the Materials/Coefficients Library dialog box, see 
“Using the Materials/Coefficients Library” on page 223 in the COMSOL 
Multiphysics User’s Guide.

Piezoelectric Material Properties Library

The Piezoelectric Material Properties library ships with the Acoustics Module, MEMS 
Module, and Structural Mechanics Module. It contains the following piezoelectric 
materials:

MATERIAL

Barium Sodium Niobate

Barium Titanate

Barium Titanate (poled)

Lithium Niobate

Lithium Tantalate

Lead Zirconate Titanate (PZT-2)

Lead Zirconate Titanate (PZT-4)

Lead Zirconate Titanate (PZT-4D)

Lead Zirconate Titanate (PZT-5A)

Lead Zirconate Titanate (PZT-5H)

Lead Zirconate Titanate (PZT-5J)
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All materials define the following material properties needed for piezoelectric 
modeling:

MEMS Material Properties Library

The MEMS Material Properties library ships with the Acoustics Module, MEMS 
Module, and Structural Mechanics Module. It contains 33 materials commonly used 
in MEMS applications. The materials are divided into the following groups: Metals, 
Semiconductors, Insulators, and Polymers.

The basic structure of this library comes from the book Microsensors, MEMS, and 
Smart Devices (Ref. 3). The material properties come from two primary sources: the 
CRC Handbook of Chemistry and Physics (Ref. 1) and MacMillan’s Chemical and 
Physical Data (Ref. 2). Some of the mechanical properties in the library are instead 

Lead Zirconate Titanate (PZT-7A)

Lead Zirconate Titanate (PZT-8)

Quartz

Rochelle Salt

Bismuth Germanate

Cadmium Sulfide

Gallium Arsenide

Tellurium Dioxide

Zinc Oxide

Zinc Sulfide

Ammonium Dihydrogen Phosphate

Aluminum Nitride

MATERIAL PROPERTY DESCRIPTION

cE Elasticity matrix

e Coupling matrix, stress-charge

εrS Relative permittivity, stress-charge

sE Compliance matrix

d Coupling matrix, strain-charge

εrT Relative permittivity, strain-charge

ρ Density

MATERIAL
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more MEMS-specific values from The MEMS Handbook (Ref. 4), and most of the 
semiconductor properties are values from Ref. 5. Ref. 6 provides a valuable resource 
for cross-checking the insulation material properties.

The table below lists the materials and their corresponding groups:

MATERIAL GROUP

Aluminium (Al) Metals

Silver (Ag) Metals

Gold (Au) Metals

Chrome (Cr) Metals

Indium (In) Metals

Titanium (Ti) Metals

Iron (Fe) Metals

Nickel (Ni) Metals

Lead (Pb) Metals

Palladium (Pd) Metals

Platine (Pt) Metals

Antimon (Sb) Metals

Tungsten (W) Metals

C [100] Semiconductors

GaAs Semiconductors

Ge Semiconductors

InSb Semiconductors

Si(c) Semiconductors

Poly-Si Semiconductors

Silicon (single-crystal) Semiconductors

Al2O3 Insulators

SiC (6H) Insulators

Si3N4 Insulators

SiO2 Insulators

ZnO Insulators

Borosilicate Insulators

Nylon Polymers

PMMA Polymers
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Polymide Polymers

Polyethylene Polymers

PTFE Polymers

PVC Polymers

MATERIAL GROUP
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Mu l t i p h y s i c s  Mode l i n g

In this section you find modeling tips about how to create multiphysics models with 
the Structural Mechanics Module. A good place to start reading about how to create 
all types of multiphysics models is “Multiphysics Modeling” on page 63 of the 
COMSOL Multiphysics Modeling Guide, where you can see how to add or remove 
different physics in a model, how to set the properties for the different physics and how 
to manage the solution components.

Thermal-Structure Interaction

The Structural Mechanics Module provides a predefined one-way coupling for 
thermal-structure interaction, which combines a continuum application mode from 
the Structural Mechanics Module with a heat transfer application mode from the Heat 
Transfer Module or COMSOL Multiphysics. See “Thermal-Structure Interaction” on 
page 354.

You can also manually set up such a coupling using the temperature described by a heat 
transfer application mode to define the strain temperature. On the Load page in the 
Subdomain Settings dialog box in the structural mechanics application mode, select the 
Include thermal expansion check box, and enter the dependent variable for temperature 
from the heat transfer application mode, typically T, in the Temp edit field for the strain 
temperature. 

Note: A special approach is required if the structural analysis is performed in the 
frequency domain. This includes the following analysis types: Frequency response, 
Eigenfrequency, and Damped eigenfrequency. The coupled displacement-temperature 
field presents thermoelastic oscillations of small amplitude, which are initialized to 
zero. You need to set the strain reference temperature Tempref to zero, and use a 
special form of the heat balance equation. For more details, see the model “Heat 
Generation in a Vibrating Structure” on page 703 of the Structural Mechanics 
Module Model Library.

By default, COMSOL Multiphysics solves for the temperature and displacements 
simultaneously. For large problems, you can take advantage of the one-way coupling 
and solve the problem sequentially (unless there are thermal properties that depend on 
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the displacements): first solve for temperature and then perform the stress-strain 
analysis using the computed temperature field from the heat transfer equation. While 
the matrices from a coupled thermal-structure model are unsymmetric, the individual 
structural and heat transfer problems can result in symmetric matrices. The SPOOLES 
solver takes advantage of matrix symmetry and further reduces memory requirements. 
See “Solving for a Subset of the Dependent Variables” on page 329 of the COMSOL 
Multiphysics Modeling Guide on how to select which variables to solve for.

See Chapter 15, “Thermal-Structure Interaction,” in the Structural Mechanics 
Module Model Library for models that exemplify thermal-structure interaction.

Fluid-Structure Interaction

Fluid-structure interaction models usually include a two-way coupling between the 
solid and fluid domains. The fluid exerts a force on the solid domain, while the 
deformation of the solid affects the geometry of the fluid domain. The Fluid-Structure 
Interaction (FSI) predefined multiphysics coupling enables this interaction by 
combining fluid flow with structural mechanics and using a Moving Mesh (ALE) 
application mode. You can find a description of this multiphysics coupling on page 356 
of this book. See Chapter 10, “Fluid-Structure Interaction,” in the Structural 
Mechanics Module Model Library for models that exemplify thermal-structure 
interaction.

A first thing to consider is whether your FSI problem really needs two-way coupling 
between the physics. If you do not expect the deformation of the solid domain to 
influence the flow problem, the ALE application mode is not necessary. This way you 
can greatly simplify your model. A good example where this method is applied is the 
model “Fluid-Structure Interaction in a Network of Blood Vessels” on page 210 of the 
Structural Mechanics Module Model Library.

When using the Moving Mesh (ALE) application mode it can happen that, as the mesh 
is deforming, you get inverted elements, which result in convergence problems. There 
are several ways to avoid this:

• Try to start with a different mesh. It is often preferable to start from a reasonably 
uniform mesh.

• Try the remeshing algorithm. This allows you to create a new mesh before the one 
you are working with becomes too distorted.
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• Try a different smoothing algorithm. Winslow smoothing is slightly slower, more 
memory consuming, and is usually, but not always, better than Laplace smoothing.

• Another technique you can try is to draw help lines along which you can control the 
mesh deformation.

You find a more detailed description of the above techniques in the COMSOL Support 
Knowledge Base; see Ref. 1.

If you are using the transient solver with a coupled model and you experience 
convergence problems for the initial time step it is most likely due to the instantaneous 
application of a boundary condition, like the velocity. To help the problem to converge 
at the initial time step you can use a smoothed step transition function, like flc1hs (a 
smoothed Heaviside function), when defining the boundary condition. This way both 
the velocity and its derivative are zero for t = 0. You can read about using smoothed 
step functions in the COMSOL Support Knowledge Base; see Ref. 2.

Acoustic-Structure Interaction

By coupling application modes from the Structural Mechanics Module to an acoustics 
application mode from either the Acoustics Module or COMSOL Multiphysics you 
can solve acoustic-structure interaction. Coupling to an acoustics application mode 
from COMSOL Multiphysics enables you to analyze the sound field in an interior 
space. By using an acoustics application mode from the Acoustics Module you can have 
additional tools like a transient solver and means to simulate absorbing or radiation 
boundary conditions. You can find models, including step by step instructions, on 
acoustic-structure interaction in Chapter 2, “Acoustic-Structure Interaction,” of the 
Structural Mechanics Module Model Library.

In the multiphysics coupling, on the boundaries between the solid and fluid, the 
acoustic analysis provides a load (the sound pressure) to the structural analysis, and the 
structural analysis provides accelerations to the acoustic analysis. For example, the 
structural mechanics application mode in a 3D model is the Solid, Stress-Strain (smsld) 
application mode. On the Load page of the Boundary Settings dialog box for this 
application mode specify -p*nx_smsld, -p*ny_smsld, and -p*nz_smsld in the edit 
fields labeled Fx, Fy, and Fz, respectively. The variables nx_smsld, ny_smsld, and 
nz_smsld are the Cartesian components of the normal vector directed outward from 
the subdomain where the Solid, Stress-Strain (smsld) application mode is active. In the 
Boundary Settings dialog box for the acoustics application mode select the Conditions 
page and set the boundary condition to Normal acceleration for those same boundaries. 
Specify the acceleration, an, as 
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nx_smsld*u_tt_smsld+ny_smsld*v_tt_smsld+nz_smsld*w_tt_smsld. The 
variables u_tt_smsld, v_tt_smsld, and w_tt_smsld are the acceleration 
components from the Solid, Stress-Strain (smsld) application mode. These and other 
application mode variables are available on the Variables page of the dialog box that 
opens if you go to Physics>Equation System>Boundary Settings.

Coupled acoustic-structure models have symmetric matrices, which means you can 
take advantage of the SPOOLES solver to reduce memory requirements.

When coupling acoustics time-harmonic and structural mechanics frequency response 
application modes make sure that the excitation frequencies for these are set to the 
same value. You can find these variables in the Application Scalar Variables dialog box, 
which opens if you select Physics>Scalar Variables. One more thing to look out for is 
the mesh size where the acoustics application modes are active. A good rule of thumb 
is that the mesh should have about 10–12 elements per wavelength.

References
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Con t a c t  Mode l i n g

In the Structural Mechanics Module you can create models involving contact, with or 
without friction, between parts. Contact is implemented based on the augmented 
Lagrangian method, which is described on page 186. When modeling contact 
between structural parts you need to set up contact pairs, which define where the parts 
may come into contact. A contact pair consists of two sets of boundaries, which are the 
master domains and the slave domains. The 2D and 3D structural continuum 
application modes use the pairs to set up equations that prevent the slave boundaries 
to penetrate the master boundaries. The present section provides some advice 
regarding important aspects of creating contact models. You can find tips regarding 
solver settings for contact models in the section “Solver Settings for Contact 
Modeling” on page 129.

On page 217 you can read about how to specify contact pairs and define the physics 
for these in the graphical user interface.

When creating contact models it can often be to advantage to set up a prototype in 2D 
before attempting a 3D model. Similarly it is often good to start using linear elements 
to ease convergence toward a solution. When you have got this working, you can 
switch to quadratic elements if you want to.

You can find contact models complete with step by step instructions in Chapter 7, 
“Contact and Friction Models,” of the Structural Mechanics Module Model Library.

Constraints

Make sure that the bodies are sufficiently constrained, also in the initial position. If the 
bodies are not in contact in the initial configuration, and there are no constraints on 
the bodies, you have an underconstrained state. This causes the solver to fail. One way 
to fix this problem is to set initial values for the displacement variables so that you have 
a small penetration in the initial configuration. Another way is to use a 
displacement-controlled model rather than a force-controlled one.

Contact Pairs

For efficiency, only include those boundaries that may actually come in contact in the 
slave. For the master, it is often a bit more efficient to make it so large that every slave 
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point “has” a corresponding master point. Note that the corresponding master point 
is obtained by following the normal to the slave until it reaches the master.

To decide which boundaries should be assigned as master and slave in a contact pair 
consider the following guidelines:

• Make sure that the master boundary stiffness in the normal direction is higher than 
the slave boundary stiffness. This is especially important if the difference in stiffness 
is quite large, for example, over ten times larger. Keep also in mind that for 
elasto-plastic or hyperelastic materials there can be a significant change in stiffness 
during the solution process, and choose the master and slave boundaries 
accordingly. For such materials you might have to also adjust the penalty factor as 
the solution progresses.

• When the contacting parts have approximately the same stiffness, you can instead 
consider the geometry of the boundaries. The master should be concave and the 
slave convex rather than the opposite.

Once you have chosen the master and slave boundaries you should mesh the slave finer 
than the master. Do not make the slave mesh just barely finer than the master because 
this often causes unphysical oscillations in the contact pressure. Make the slave at least 
two times finer than the master.

Boundary Settings for Contact Pairs

PE N A L T Y  F A C T O R S

Note that in the augmented Lagrangian method, the value of the penalty factor does 
not affect the accuracy of the final solution, like it does in the penalty method. When 
running into convergence problems, check the penalty parameters. If the iteration 
process fails in some of the first augmented iterations, lower your penalty parameters. 
If the model seems to converge but very slowly, consider increasing the maximum 
value of your penalty parameters. 

Increasing the penalty factor can lead to an ill-conditioned Jacobian matrix and 
convergence problems in the Newton iterations. You can often see this by noting that 
the damping factor becomes less than 1 for many Newton iterations. If this occurs, 
decrease the penalty factors.

The default values for the penalty factors, using Young’s modulus, only work for linear 
isotropic materials, for which the Young’s modulus is defined. For other types of 
materials you need to substitute E with a suitable value or define it as a constant or 
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expression variable. For elasto-plastic materials you may find that the default value 
works fine until there is a significant decrease in stiffness due to plastic deformation. 
This can give rise to convergence problems for the nonlinear solver, since the penalty 
factor becomes too large. To aid convergence you can specify an expression for the 
stiffness that depends for example on the solver parameter.

I N I T I A L  V A L U E

In force-controlled contact problems where no other stiffness prohibits the 
deformation except the contact, the initial contact pressure is crucial for convergence. 
If it is too low the parts might pass through each other in the first iteration. If it is too 
high they never come into contact.

Multiphysics Contact

Multiphysics contact problems are often very ill-conditioned, which leads to 
convergence problems for the nonlinear solver. For example, take heat transfer 
through the contact area, where initially only one point is in contact. The solution for 
the temperature is extremely sensitive to the size of the contact area (that is, the 
problem to determine the temperature is ill-conditioned). Therefore it is important to 
resolve the size of the contact area accurately, that is, to use a very fine mesh in the 
contact area. If the contact area is larger, you do not need as fine mesh because then 
the temperature solution is not that sensitive to the size of the contact area. If possible, 
start with an initial configuration where the contact area is not very small.
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Damp i n g

Damping is important in time-dependent and frequency response analysis. This section 
describes how to model it in the Structural Mechanics Module using different damping 
models.

Rayleigh Damping

A common model for viscous damping is Rayleigh damping, which assumes that the 
damping is proportional to a linear combination of the stiffness and mass. To illustrate 
this, consider a system with a single degree of freedom. The following equation of 
motion describes the dynamics of such a system with viscous damping:

.

In the Rayleigh damping model, the damping parameter c is expressed in terms of the 
mass m and the stiffness k as

where αdM and βdK are the mass and stiffness damping parameters, respectively.

A complication with the Rayleigh damping model is obtaining good values for the 
damping parameters. A more physical damping measure is the damping ratio, the ratio 
between actual and critical damping, often expressed as a damping factor in percentage 
of the critical damping. You can find commonly used values of damping factors in the 
literature.

It is possible to transform damping factors to Rayleigh damping parameters. The 
damping factor, ξ, for a specified pairs of Rayleigh parameters, αdM and βdK, at a 
frequency, f, is

.

Using this relationship at two frequencies, f1 and f2, with different damping factors, ξ1 
and ξ2, results in an equation system that can be solved for αdM and βdK:

md2u
dt

---------- cdu
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------- ku+ + f t( )=
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.

Using the same damping factors, ξ1 = ξ2, does not result in a constant damping factor 
inside the interval f1 < f < f2. It can be shown that the damping factor is lower inside 
the interval, as the following figure shows.

Note: All application modes in the Structural Mechanics Modules use nonzero 
default values for αdM and βdK. You must adapt these default values to suit your 
specific modeling situation.

Loss Factor Damping

Loss factor damping (sometimes referred to as material or structural damping) applies 
to viscoelastic materials modeled in the frequency domain. The complex modulus 
G*(ω) is the frequency-domain representation of the stress relaxation function of 
viscoelastic material. It is defined as

where G' is the storage modulus, G'' is the loss modulus, and their ratio η = G''/G' is 
the loss factor. The term G' defines the amount of stored energy for the applied strain, 
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whereas G'' defines the amount of energy dissipated as heat; G', G'', and η can all be 
frequency dependent.

In COMSOL Multiphysics, the loss information appears as a multiplier of the total 
strain in the stress-strain relationship:

.

For hyperelastic material, the loss information appears as a multiplier in the first 
Piola-Kirchhoff stress, P:

Loss factor damping is available for frequency response analysis in all application 
modes, but it is not defined for elasto-plastic materials.

Equivalent Viscous Damping

Although equivalent viscous damping is independent of frequency, it is only possible 
to use it in a frequency response analysis. Equivalent viscous damping also uses a loss 
factor η as the damping parameter, but its implementation is different from the actual 
loss factor damping. 

The piezoelectric application modes have built-in support for this type of damping. For 
the other application modes, you can model it using the stiffness damping parameter 
βdK. Specify βdK to the loss factor, η, divided by the excitation frequency.

You must also set the mass damping factor, αdM, to zero.

Explicit Damping

Another way to model damping is to specify it explicitly as a viscous force. In a transient 
analysis you do so by specifying a force that depends on the velocities with opposite 
signs:

where v is the velocity

σ D 1 jη+( )ε εth– ε0–( ) σ0+=

P 1 jη+( )
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and ut is the velocity component in the x direction, typically named ut.

You can specify viscous damping locally using such a force on any domain level.

In a frequency response analysis you can specify viscous damping in a similar way, but 
the name of the velocity variable changes and includes the application mode name, for 
example, u_t_smsld for the Solid, Stress-Strain application mode.

No Damping

To create an undamped model, you can also select to use No damping from the Damping 

model list.

v
ut

vt

wt

=
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F a t i g u e  Ana l y s i s

The fatigue analysis capabilities in the Structural Mechanics Module extends the 
COMSOL Script environment—an open and extensible language for technical 
computing of any kind—with a suite of tools for performing fatigue analysis.

The fatigue analysis tools works together with both MATLAB and COMSOL Script. 

The fatigue analysis capabilities in the Structural Mechanics Module consists of a 
number of script functions that compute fatigue damage or fatigue life from input 
consisting of loading data and material fatigue data. A typical function takes all stress 
tensor components in the form of a matrix as input and delivers the fatigue damage or 
fatigue life as result.

A typical fatigue analysis consists of the following steps:

1 Perform a finite element analysis of your structure, using COMSOL Multiphysics 
and the Structural Mechanics Module.

2 Calculate the stress field on a matrix format, available in COMSOL Script or 
MATLAB.

3 Calculate the fatigue damage from the stress field, and the fatigue material data 
using a fatigue-analysis script function.

4 Plot the result.

Fatigue analysis is divided into high-cycle and low-cycle fatigue depending of the 
number of load cycles. The Structural Mechanics Module as delivered can handle the 
following cases for both high-cycle and low-cycle fatigue:

• Proportional loading, constant amplitude

• Nonproportional loading, constant amplitude

• Proportional loading, nonconstant amplitude

You find a detailed description of how to perform fatigue analysis together with a 
comprehensive background to the subject and a theoretical descriptions of the 
different methods in the chapter “Fatigue Analysis” on page 361. Model examples are 
available in the section “Fatigue Models” on page 345 in the Structural Mechanics 
Module Model Library.
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S o l v e r  S e t t i n g s

A large number of possible solver settings are available in COMSOL Multiphysics. To 
make it easier for you to select a solver and its associated solver parameters, the various 
application modes use different default settings depending on the analysis type. In 
some situations you must change the default settings. This section helps you select a 
solver and its solver settings to solve structural mechanics and multiphysics problems. 
Further details about all solver settings appear in the chapter “Solving the Model” on 
page 359 in the COMSOL Multiphysics User’s Guide.

Symmetric Matrices

The Matrix symmetry list appears on the General page in the Solver Parameters dialog 
box. Here you specify if the assembled matrices (stiffness matrix, mass matrix) resulting 
from your equations are symmetric or not.

Normally the matrices from a single-physics structural mechanics problem are 
symmetric, but there are exceptions:

• Multiphysics models solving for several physics simultaneously, for example, heat 
transfer and structural mechanics. Solving for several structural mechanics 
application modes, such as shells combined with beams, does not create 
unsymmetric matrices.

• Elasto-plastic analysis.

One of the benefits of using the symmetric solvers is that they use less memory and are 
faster. The default option is Automatic, which means the solver automatically detects if 
the system is symmetric or not. Some solvers do not support symmetric matrices and 
always solve the full system regardless of symmetry. The default solver in 2D, 
UMFPACK, does not support symmetry—but it is faster than SPOOLES, the default 
solver in 3D. SPOOLES uses less memory, but memory is usually not a major issue in 
2D.

Note: Selecting the Symmetric option for a model with unsymmetric matrices 
produces incorrect results.
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Complex matrices can be unsymmetric, symmetric, or Hermitian. Hermitian matrices 
do not appear in structural mechanics problems.

Note: Selecting the Hermitian option for a model with complex-valued symmetric 
matrices produces incorrect results.

Selecting Iterative Solvers

The Linear system solver list appears on the General page in the Solver Parameters dialog 
box. The default solver in the Structural Mechanics Module is Direct (SPOOLES) in 3D 
and Direct (UMFPACK) in 2D. For large problems (several hundred thousands or 
millions of degrees of freedom) it is beneficial to use iterative solvers when possible to 
save time and memory. The drawback is that they are more sensitive and might not 
converge if the mesh quality is low.

The iterative solvers have more options than the direct solvers. The following table 
makes suggestions on which iterative solver and preconditioner to use for different 
analyses for large problems.

Specifying a positive shift greater than the lowest eigenfrequency results in indefinite 
matrices. The conjugate gradients iterative solver does not work for indefinite matrices. 
Get more details about solver settings in Chapter 6, “Selecting a Solver,” in the 
COMSOL Multiphysics User’s Guide.

ANALYSIS LINEAR SYSTEM SOLVER PRECONDITIONER

Static analysis, single physics Conjugate gradients Geometric multigrid

Quasi-static transient analysis, single 
physics

Conjugate gradients Geometric multigrid

Parametric analysis, single physics Conjugate gradients Geometric multigrid

Eigenfrequency analysis, single physics Conjugate gradients Geometric multigrid

Static analysis, multiphysics GMRES Geometric multigrid

Eigenfrequency analysis, multiphysics GMRES Geometric multigrid

Frequency response analysis GMRES Geometric multigrid

Elasto-plastic analysis GMRES Geometric multigrid

Time-dependent analysis Conjugate gradients Geometric multigrid
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Note: Check the mesh quality when using the geometric multigrid (GMG) 
preconditioner. It does not work well when using the option to scale the geometry 
before meshing (on the Advanced tab in the Free Mesh Parameters dialog box). When 
using extruded meshes, you might need to create the mesh cases manually.

The conjugate gradients solver does not work together with a mixed formulation 
because it results in an indefinite stiffness matrix. For this type of problems the 
following solver combinations work:

When using the Vanka smoother for a mixed-formulation problem, specify the 
pressure as the Vanka variable. Get more information about using the Vanka smoother 
in the section “The Vanka Algorithm” on page 530 in the COMSOL Multiphysics 
Reference Guide.

Specifying the Absolute Tolerance

The absolute-tolerance parameters used for time-dependent problems are very 
problem specific. As a rule of thumb, set the absolute tolerance to be at least one order 
of magnitude smaller than the typical displacement.

The default value is 0.001 for all solution components. When solving mixed problems 
with both displacements and pressure, this default results in very small tolerance 
conditions for the pressure. One way to help the solver is to specify individual tolerance 
values for all solution components. This speeds up the solution and usually does not 
affect the accuracy. For example, when solving a model using the 3D Solid, 
Stress-Strain application mode for a mixed problem with a typical displacement 
amplitude of 10−5 and an internal pressure amplitude of 105, specify u 1e-7 v 1e-7 
w 1e-7 p 1e3 in the Absolute tolerance edit field (that is, use space-separated pairs of 
variable names and the absolute tolerance for that variable).

LINEAR SYSTEM SOLVER PRECONDITIONER SMOOTHER

GMRES GMG Vanka

GMG - Vanka

GMRES Incomplete LU -
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Solver Settings for Contact Modeling 

You solve contact problems using the augmented Lagrangian method. The augmented 
solution components are specified on the Stationary page in the Solver Parameters 
dialog box. The augmented solution components are the contact pressure and the 
friction traction components. By default the solver finds these components 
automatically.

If the model includes friction, some solution components from the previous solution 
step are needed. You specify these variables on the Parametric page in the Solver 

Parameters dialog box. The components are the master coordinates, the contact 
variable, and, if dynamic friction is modeled, the time. By default the program finds 
these components automatically.

M A N U A L  S C A L I N G

You need to use manual scaling if the parts are not in contact initially (initial value of 
contact pressure is zero) or if the model includes friction. Select Manual from the Type 

of scaling list on the Advanced page in the Solver Parameters dialog box. In the Manual 

scaling edit field, enter the name of all the solution components together with their 
approximate order of magnitude. For example, solving a plane stress problem with one 
contact pair including friction, where the displacements in both directions are around 
10−3, the contact pressure is around 1000, and the friction traction components are 
around 100. Then enter u 1e-3 v 1e-3 Tn_cp1_smps 1000 Ttx_cp1_smps 100 
Tty_cp1_smps 100 (using space-separated pairs of variable names and scaling factors) 
in the Manual scaling edit field.

To get the list of degrees of freedom in the model, go to the Solver Manager dialog box 
and look at the Solve For page. For each degree of freedom, use a positive value that is 
of the order of the typical value of that variable. You need not specify scaling factors 
for the friction history variables containing _old, for instance 
contact_cp1_old_smps, xm_old_cp1_smps, ym_old_cp1_smps.

You can read more about how to prevent ill-conditioned matrices by scaling of 
variables and equations on page 497 of the COMSOL Multiphysics Reference Guide.

TO L E R A N C E S

You find tolerance settings for both the augmented Lagrangian solver and the 
nonlinear solver on the Stationary page of the Solver Parameters dialog box.

Specify the tolerance for the augmented Lagrangian solver (augtol) in the Tolerance 
edit field under the Augmented Lagrangian solver group label. It controls the accuracy 
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of the so-called augmentation components Tn, Ttx, Tty (that is, the contact pressure 
and the friction tractions). The accuracy in these components is the product of the 
manual scaling value with augtol. For example, if the manual scale for Tn is set to 108, 
the default augtol = 10−3 gives an error 108*10−3  = 105 or about 0.1% in Tn.

The tolerance for the nonlinear solver (ntol) controls the accuracy of the displacement 
variables (and other variables in a multiphysics model). You can change its value in the 
Relative Tolerance edit field in the Nonlinear settings area.

Do not use a too coarse ntol, especially if the body is stiff, because this causes too large 
errors in the determination of the contact tractions, which leads to nonconvergence in 
the augmented Lagrangian iterations. You can estimate ntol by looking at the scaling 
of the dependent variables and the penalty factors:

where Tmin denotes the minimum of the contact traction scales, pmax the maximum 
penalty factor, and umax the maximum of the displacement scale factors. For example, 
for a material with Young’s modulus of 1011, a minimum mesh size of 10−2, and with 
the manual scaling set to

u 1e-4 v 1e-3 Tn_cp1_smps 1e8 Ttx_cp1_smps 1e6 Tty_cp1_smps 1e6

using the default values for the penalty factors, the nonlinear tolerance is

A U G M E N T E D  L A G R A N G I A N  S O L V E R

You select the augmented Lagrangian solver from the Solver list on the Stationary page 
of the Solver Parameters dialog box. This solver controls the updating of the contact 
tractions in each augmented Lagrange iteration. Because these degrees of freedom are 
rather few there is no performance issue here. The default lumped solver is used for 2D 
problems because this gives less undershoots in the contact tractions at the ends of the 
segments in contact. The lumped solver is an approximation that replaces the 
boundary mass matrix with a lumped diagonal matrix.

In 3D, the UMFPACK solver is used as default because lumping does not work for 
quadratic elements.

ntol Tmin augtol⋅
pmax umax⋅

-------------------------------------<

ntol 106 10 3–⋅
1013 10 3–⋅
----------------------------< 10 7–

=
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A p p l i c a t i o n  M o d e  G u i d e
The application modes in the Structural Mechanics Module form a complete set 
of simulation tools for various modeling situations in structural and solids 
mechanics. Select an application mode that describes your structure by analyzing 
the loading conditions and any possible engineering assumptions.
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CONTIN
MODES

Solid, S √ √

Plane S √ √

Plane S √ √

Axial Sy
Stress-S

√ √
Ove r v i ew

The following table lists the application modes available in the Structural Mechanics 
Module. For a detailed description of any of them, refer to the corresponding section 
on the page listed in the table.

The column for the dependent variables shows the field variables that formulate the 
PDEs or weak form equations. Depending on the engineering assumptions, these 
variables might be a subset of the displacements u, v, and w in the global coordinate 
system, or the rotations , , and  about the global axes. In the piezoelectric 
application modes the electric potential V is included. For axisymmetric simulations, 
COMSOL Multiphysics uses a variable transformation to avoid a singularity at the 
symmetry axis.

For each application mode, the table indicates the availability of various analysis 
capabilities.

Finally the table lists the domains where you can specify application mode data such as 
material properties, loads, and constraints. Note that edges exist only in 3D 
geometries.
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UUM APPLICATION 159

tress-Strain smsld 160 u, v, w √ √ √ √ √ √ √ √ √ √ √ √

tress smps 161 u, v √ √ √ √ √ √ √ √ √ √ √

train smpn 162 u, v √ √ √ √ √ √ √ √ √ √ √

mmetry 
train

smaxi 163 uor, v √ √ √ √ √ √ √ √ √ √ √
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MINDLIN √ √
BEAMS

In-plane √

3D Eule

TRUSSES

2D Tru √

3D Tru

SHELL √

PIEZO A

Piezo S √ √

Piezo P √ √

Piezo P √ √

Piezo A √ √
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IN
To change the type of simulation for a given set of parameters, simply modify the 
analysis type, which is an application mode property. The analysis type sets up the 
coefficients in the underlying equations. The available analysis types depend on the 
application mode. Static, eigenfrequency, time dependent, and frequency response are 
common for all application modes.

When starting to work on a model, select the application mode from the Model 

Navigator. You can add application modes to an existing model to create a multiphysics 
model. One example is adding Euler beams to a thin plate modeled in the Plane Stress 
application mode to account for various stiffening structures in the plate.

 PLATE smdrm 227 w, , √ √ √ √ √ √ √ √

253

 Euler Beam smeulip 277 u,v, √ √ √ √ √ √ √ √

r Beam smeul3d 278 u, v, w, 
, ,

√ √ √ √ √ √ √ √ √

279

ss smtr2d 299 u, v √ √ √ √ √ √ √ √ √ √

ss smtr3d 300 u,v, w √ √ √ √ √ √ √ √ √ √ √

smsh 304 u, v, w, 
, ,

√ √ √ √ √ √ √ √ √

PPLICATION MODES 319

olid smpz3d 348 u, v, w, V √ √ √ √ √ √ √

lane Stress smpps 348 u, v, V √ √ √ √ √ √

lane Strain smppn 349 u, v, V √ √ √ √ √ √

xial Symmetry smpaxi 349 uor, w, V √ √ √ √ √ √
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When using the Axial Symmetry application mode it is important to note that the 
horizontal axis represents the r direction and the vertical axis the z direction. The 
entire geometry must lie in the half plane r > 0.

Next note that the excitation frequency freq used in frequency response analysis is 
given as an application scalar variable in the GUI. 

Depending on the application mode, you can specify parameters defining a problem 
on points, edges (3D), boundaries, and subdomains. It is possible to specify loads and 
constraints on all available domain types, but you can specify material properties only 
for the subdomain, except for shells and in-plane Euler beams, where they are defined 
on the boundary, and 3D Euler beams, where they are defined on the edge level.

All domain-setting dialog boxes—Point Setting, Edge Settings, Boundary Settings, and 
Subdomain Settings—have a common layout. In each of these dialog boxes, you specify 
a problem using the tabbed pages Constraints, Loads, Material, Cross Section, Init, and 
Element. The Material, Init, and Element pages are available only on the subdomain 
level, except for shells and in-plane Euler beam, where they exists on the boundary, and 
3D Euler beam, where they exists on edge level. In contrast, the Load and Constraint 
pages exist on all available domains, making it possible to define constraints and loads 
on all levels. You set the loads and constraints independently of each other, so it is 
possible to apply loads on constrained domains. Such loads do not affect the 
computation’s final result. 

The Cross Section page is available only for the beam application modes. On the 
Postprocessing page you can indicate at which depth you want to postprocess results 
for plate and shell elements.
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Selecting the Correct Application Mode

The Structural Mechanics Module supplies the following application modes:

PLICATION MODE PICTURE USE TO MODEL

lid, Stress-Strain 3D solids, not thin or slender.

ell Thin 3D structures.

 Euler Beam Slender 3D structures. Typical examples are 
frameworks and latticeworks.

 Truss Slender 3D structures with components capable
to withstand axial forces only. Typical example is
latticeworks.

ne Stress In-plane loaded thin plates.
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Pla

Ax

Mi

2D

2D

Pie

AP
ne Strain In-plane loaded structures whose extent out of 
the plane is large compared to the in-plane 
dimensions, or when the z-displacement is in 
some way restricted. A typical example is a long 
tunnel.

ial Symmetry Stress-Strain Axisymmetric structures exposed to symmetric 
loads and constraints.

ndlin Plate Out-of-plane loaded thin plates.

 Euler Beam Slender 2D structures. Typical examples are 
plane frameworks and latticeworks

 Truss Slender 2D structures with components capable 
to withstand axial forces only. Typical example is 
plane latticeworks.

zo Solid 3D solids, of piezoelectric material

PLICATION MODE PICTURE USE TO MODEL
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The following chapters present a detailed description of the above-mentioned 
application modes together with an introductory example for each one. For a 
description of the command-line use of the application modes, see the corresponding 
entries in the section “Application Mode Programming Reference” on page 100.

Analysis Capabilities

The Structural Mechanics Module performs static, eigenfrequency, damped 
eigenfrequency, transient, frequency response, parametric, and quasi-static analyses. 
The analysis types require different solvers and equations. In the Application Mode 

Properties dialog box you select an analysis type, each of which has a predefined solver. 
You can disable the choice of a predefined solver by clearing the Auto select solver check 
box in the Solver Parameters dialog box. The following table lists the different analysis 
types with their predefined solver:

zo Plane Stress In-plane loaded thin plates of piezoelectric 
material

zo Plane Strain In-plane loaded structures of piezoelectric 
material whose extent out of the plane is large 
compared to the in-plane dimensions, or when 
the z-displacement is in some way restricted.

zo Axial Symmetry Axisymmetric structures of piezoelectric 
material exposed to symmetric loads and 
constraints.

PLICATION MODE PICTURE USE TO MODEL

ANALYSIS TYPE SOLVER

Static Stationary

Static elasto-plastic material Parametric

Eigenfrequency Eigenvalue

Damped eigenfrequency Eigenvalue
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To manually change to a different solver, make a new selection in the Solver Parameters 
dialog box. Read through the following solver descriptions to help find good 
candidates for your application.

S T A T I C  A N A L Y S I S

A static analysis solves for stationary displacements, rotations, and temperature 
(depending on the type of application mode). All loads and constraints are constant. 
The equations include no mass or mass moment of inertia.

E I G E N F R E Q U E N C Y  A N A L Y S I S

An eigenfrequency analysis solves for the undamped eigenfrequencies and the shape of 
the eigenmodes. When performing an eigenfrequency analysis, you can specify 
whether to look at the mathematically more fundamental eigenvalue, λ, or the 
eigenfrequency, f, which is more commonly used in a structural mechanics context.

You control the way to specify eigenvalues from the Application Mode Properties dialog 
box from the Physics menu.

D A M P E D  E I G E N F R E Q U E N C Y  A N A L Y S I S

A damped eigenfrequency analysis solves for the damped eigenfrequencies and the 
shape of the eigenmodes. When performing a damped eigenfrequency analysis, you 
can specify whether to look at the mathematically more fundamental eigenvalue, λ, or 
the eigenfrequency, f, which is more commonly used in a structural mechanics context.

You control the way to specify eigenvalues from the Application Mode Properties dialog 
box (choose Properties from the Physics menu).

In addition to the eigenfrequency you can also look at the quality factor, Q, and decay 
factor, δ, of your model.

Transient Time dependent

Frequency response Parametric 

Quasi-static Time dependent

Linear buckling Eigenvalue

ANALYSIS TYPE SOLVER

f Im λ( )
2π

----------------–=

f Im λ( )
2π

----------------–=
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TR A N S I E N T  A N A L Y S I S

A transient analysis solves a time-dependent (unsteady) problem where loads and 
constraints can vary in time.

For transient analysis, COMSOL Multiphysics models damping with the Rayleigh 
damping model, which assumes that the damping matrix C is a linear combination of 
the stiffness matrix K and the mass matrix M:

You can specify the Rayleigh damping parameters locally.

F R E Q U E N C Y  R E S P O N S E  A N A L Y S I S

A frequency response analysis solves for the steady-state response from harmonic loads. 
For this analysis type, you can model damping using Rayleigh damping (in the same 
way as in a transient analysis) or using loss factor damping, where you specify a loss 
factor.

For a frequency response analysis, the Structural Mechanics Module divides harmonic 
loads into two parts:

• The amplitude, F

• The phase (FPh)

Together they define a harmonic load whose amplitude and phase shift can depend on 
the excitation angular frequency ω or excitation frequency f.

For a frequency response analysis, you can choose either the stationary linear or 
nonlinear solvers, setting the excitation frequency in the Application Scalar Variables 

dialog box. An easier way to perform a frequency sweep is to choose the parametric 
solver with freq as the named parameter. You set the sweeping frequency in the List 
of parameter values edit field, which appears on the Parametric page in the Solver 

Parameters dialog box.

Q Im λ( )
2Re λ( )
-------------------=

δ Re λ( )=

C αdMM βdKK+=

Ffreq F ω( ) ωt FPh ω( ) π
180
----------⋅+⎝ ⎠

⎛ ⎞cos⋅=

ω 2πf=
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The result of a frequency response analysis is a complex time-dependent displacement 
field, which can be interpreted as an amplitude uamp and a phase angle uphase. The 
actual displacement at any point in time is the real part of the solution:

COMSOL Multiphysics allows the visualization of the amplitudes and phases as well 
as the solution at a specific angle (time). The Solution at angle parameter makes this 
task easy. When plotting the solution, the program multiplies it by , where is the 
angle in radians that corresponds to the angle (specified in degrees) in the Solution at 

angle edit field. COMSOL Multiphysics plots the real part of the evaluated expression:

The angle is available as the variable phase (in radians) and is allowed in plotting 
expressions. Both freq and omega are available variables.

Note: In a frequency response analysis, everything is treated as harmonic: prescribed 
displacements, velocities, accelerations, thermal strains, and initial stress and strains; 
not only the forces.

Q U A S I - S T A T I C  A N A L Y S I S

A quasi-static transient analysis neglects mass effects, assuming the time scale in the 
structural mechanics problem is much smaller than other dynamics. An example is a 
transient thermal problem where the time scale in the thermal problem is often much 
longer than that of the structural dynamics.

P A R A M E T R I C  A N A L Y S I S

A parametric analysis finds the solution dependence from the variation of a specific 
parameter. The parameter could be, for instance, a material property or the position of 
a load. The equations are static.

L A R G E  D E F O R M A T I O N S

The Structural Mechanics Module allows you to include large deformations with the 
restriction of small strains in all fully dimensional application modes. This effect is also 
sometimes referred to as a nonlinear geometric effect. Using large deformation, the 
application mode replaces the normal strain with the Green strain and replaces the 

u uamp 2πf t uphase+⋅( )cos=

eiφ φ

u uamp φ uphase+( )cos=

φ
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stress with the second Piola-Kirchhoff stress. It solves the problem using a total 
Lagrangian formulation.

L I N E A R  B U C K L I N G  A N A L Y S I S

A linear buckling analysis includes the stiffening effects from stresses coming from 
nonlinear strain terms. The two stiffnesses coming from stresses and material define an 
eigenvalue problem where the eigenvalue is a load factor that, when multiplied with 
the actual load, gives the critical load in a linear context. The linear buckling analysis 
uses the eigenvalue solver.

Another way to calculate the critical load is to include large deformation effects and 
increase the load until the solver fails because the load has reached its critical value.

Linear buckling analysis is available only in the continuum and Truss application 
modes.

T H E R M A L  C O U P L I N G S

Solids expand with temperature, which causes thermal strains to develop in the 
material. These thermal strains combine with the elastic strains from structural loads 
to form the total strain:

Thermal strain depends on the temperature, T, the stress-free reference temperature, 
Tref, and the thermal-expansion coefficient, α:

Thermal expansion affects displacements, stresses, and strains. Thermal coupling is 
available as an option in all application modes except the piezoelectric application 
modes. You need only specify the thermal expansion coefficient and the two 
temperature fields, T and Tref. These temperatures can be any mathematical expression 
and are typically other variables solved for in another COMSOL Multiphysics 
application mode, for instance, the heat transfer application modes. You can use 
temperature coupling in any type of analysis.

Note: A special approach is required if the structural analysis is performed in the 
frequency domain. This includes the following analysis types: frequency response, 
eigenfrequency, and damped eigenfrequency. The coupled displacement-temperature 
field presents thermoelastic oscillations of small amplitude, which are initialized to 

ε εel εth+=

εth α T Tref–( )=
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zero. You need to set the strain reference temperature Tempref to zero and use a 
special form of the heat balance equation. For more details, see the example “Heat 
Generation in a Vibrating Structure” on page 703 of the Structural Mechanics 
Module Model Library.
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 6
C o o r d i n a t e  S y s t e m s  a n d  S y m b o l s
The Structural Mechanics Module makes available various predefined and 
user-defined coordinate systems, which are described in this chapter. In a separate 
section, you also find information about the symbols used for illustrating loads and 
constraints.
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Coo r d i n a t e  S y s t em s

Using different coordinate systems can be convenient when specifying loads, 
constraints, and anisotropic materials, and when postprocessing the results. The 
Structural Mechanics Module provides a number of different coordinate systems:

• A global Cartesian coordinate system, where the geometry is created in 3D (x, y, z).

• A local geometrical coordinate system on 2D boundaries (t, n) and on 3D faces 
(t1, t2, n).

• Application-mode specific coordinate systems: a shell coordinate system and a 3D 
Euler beam coordinate system.

• User-defined coordinate systems.

To specify the coordinate system, select it from the Coordinate system list on the 
Constraint, Load, and Material pages.

The following figure shows the Load page in the Boundary Settings dialog box for the 
Shell application mode.
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The Global Coordinate System

You can use the global coordinate system in all application modes to specify loads and 
constraints on all domain levels: points, edges, faces, and subdomains. It is the default 
setting for loads and constraints in all application modes on all domain levels except 
boundary constraints for the Mindlin plate application mode. The default names for 
the space coordinates are the following for the different geometries:

It is possible to change the names of the space coordinates when creating a geometry 
from the Model navigator, see “Creating Cartesian and Cylindrical Coordinate 
Systems” on page 27 in COMSOL Multiphysics User’s Guide for details.

Local Geometrical Coordinate Systems

Boundaries in 2D and 3D have geometric variables describing the parametrization of 
the geometry defined on them. These variables contain directions that define a local 
coordinate system that you can use when specifying loads and constraints.

In 2D, the local geometrical coordinate system (t, n) represents the directions 
tangential and normal to the boundary. For interior boundaries and free edges this 
coordinate system is right-oriented. For exterior boundaries the normal is always 
directed out from the domain.

In 3D, the local geometrical coordinate system (t1, t2, n) represents two tangential 
directions and one normal direction. t1 and t2 depend on the parametrization of the 
geometry. For interior boundaries and free faces this coordinate system is 
right-oriented but not always orthogonal. For exterior boundaries the normal is always 
directed out from the domain. Common applications for this coordinate system 
include specifying pressure or normal displacement on a surface.

Note: t1 and t2 depend on how the geometry was created and are usually 
perpendicular to each other.

GEOMETRY DEFAULT NAME OF SPACE COORDINATES

2D  x y z

3D  x y z

Axial symmetry 2D  r zϕ
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Read more about this topic in “Geometric Variables” on page 165 in the COMSOL 
Multiphysics User’s Guide.

The Constraint page in the Boundary Settings dialog box for the Solid, Stress-Strain 
application mode shows how local coordinate systems work.

Application-Mode Specific Coordinate Systems

The 3D Euler Beam and Shell application modes include a local coordinate system.

The 3D Euler Beam application mode defines the orientation of the cross-section 
coordinate system needed to specify the orientation of the beam. Details about the 3D 
Euler beam local coordinate system is available in “Cross Section” on page 263.

The Shell application mode defines a local coordinate system on the face needed to 
define postprocessing variables such as internal moments, normal forces, and shear 
forces. Details about the shell local coordinate system are found in “Postprocessing” 
on page 316 of this manual. 

You can also use these coordinate systems to define loads and constraints.
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The Load page in the Edge settings dialog box for the 3D Euler Beam application mode 
shows how local application-specific coordinate systems is used.

User-Defined Coordinate Systems

User-defined coordinate systems can be applied at all domain levels in all application 
modes. For the continuum application modes, they can define orthotropic and 
anisotropic material properties in a coordinate system other than the global Cartesian 
system.

Create a user-defined coordinate system by choosing Options>Coordinate Systems, 
thereby opening the Coordinate Systems Settings dialog box. Depending on the active 
geometry, the software creates a 2D or 3D coordinate system.
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2 D  G E O M E T R Y

The New button opens the New Coordinate System dialog box.

In the Copy from list you select from which existing coordinate system you want to copy 
the coordinate-system settings.

In the Name edit field you enter the name of the coordinate system, and it is the name 
that appears in all coordinate-system lists.

The software creates a coordinate system in one of three ways, which you control with 
option buttons:

• Rotate x-axis: The local xl-axis direction is specified by an angle (α) between the 
global and local x-axes.

xl

xg

ygyl

α
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• x-axis direction vector: Specify the local xl-axis direction by a direction vector v.

• Cylindrical coordinate system: A local cylindrical coordinate system (xl, yl) with 
origin at (x0, y0) is specified.

3 D  G E O M E T R Y

The New button works in the same way as for the 2D geometry case.

xl

xg

ygyl

v

xg

yg

(x0, y0)

xl

yl
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The software defines the coordinate system in one of two ways, which you control with 
the Define using work plane and Define using global coordinates option buttons.

Define Using Work Plane
Define using work plane is enabled when a least one work plane/2D geometry exists.

Select the work plane on which to base the local coordinate system from the Work plane 
list.

Four options are available, which you control with option buttons:

•  Use work plane coordinate system: The local coordinate system is the same as the 
work plane. You control the definition of the work plane by going to the Draw menu 
and opening the Work-Plane Settings dialog box. Get details about the creation of 
work planes in “Creating and Using 2D Work Planes” on page 59 in the COMSOL 
Multiphysics User’s Guide.

•  Rotate x-axis:The local xl-axis direction is specified by an angle (α) between the 
work planes xwp-axis and the local xl-axis.

xl

xwp

ywpyl

α
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•  x-axis direction vector: The local xl-axis direction is specified by a direction vector v.

•  Cylindrical coordinate system: A local cylindrical coordinate system (xl, yl) with 
origin at (x0, y0) in the work plane coordinates is specified.

xl

xwp

ywpyl

v

xwp

ywp

(x0, y0)

xl

yl
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Define Using Global Coordinates

There are two different options available, which you control with option buttons:

•  Direction method: The local xl-axis direction is specified by a direction vector vaxi. 
The local xlyl-plane is specified using a direction vector vplane which is a vector lying 
in the local xlyl-plane.

•  Rotation angle method: The local coordinate system (xl, yl, zl) is specified using three 

xl

xg

yg yl

vaxi

zg

vplane
zl
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consecutive rotation angles θx, θy', and θz''.

x'xg

yg

zg

y'

θx

θx

z'

x'

y'

θy'

z'
z''

θy'

x''

y''

θz''

zl z''

θz''

x''

rotate around xg then around rotated y'

then around doubly rotated z''

yl

y''

xl
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LOAD SY
S ymbo l s  f o r  L o ad s  and Con s t r a i n t s

To make it easier to specify a model, you can choose to display load and constraint 
symbols on a geometry. This is done automatically, but in some situations it might take 
too long, so the software provides an option to deactivate the automatic update of 
symbols. This option appears on the Visualization page in the Preferences dialog box. 
To read more about that dialog box see the section “Saving Preferences for Labels, 
Rendering, and Highlighting” on page 119 in the COMSOL Multiphysics User’s 
Guide. In the Preferences dialog box you also have the option to select whether to plot 
the symbols from the current domain type or all domain types. A manual update of 
symbols is possible from the Options menu by selecting Update Symbols or by clicking 
the Update Symbols button on the Visualization/Selection toolbar. Scaling the size of 
the symbols is possible in the Visualization/Selection dialog box; see “Scaling of Load 
and Constraint Symbols” on page 119 in the COMSOL Multiphysics User’s Guide.

Load Symbols

You can plot load symbols on points, boundaries, edges, and subdomains. The loads 
are normalized with respect to the maximum value within a domain type.

The following table lists all load symbols together with the application modes where 
they appear.

MBOL DESCRIPTION APPLICATION MODES

Force at a point or in a subdomain. Plane Stress, Piezo Plane Stress,

Plane Strain, Piezo Plane Strain,

Axial Symmetry, Stress-Strain,

Piezo Axial Symmetry,

2D Euler Beam

Boundary force. Plane Stress, Piezo Plane Stress,

Plane Strain, Piezo Plane Strain,

Axial Symmetry, Stress-Strain,

Piezo Axial Symmetry,

2D Euler Beam
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Fl  

LOAD SY
Transversal force in the z direction at point 
or in a subdomain.

Positive (left) and negative (right) z direction 
respectively.

Mindlin Plate

Point bending moment about the z-axis. 2D Euler Beam

Edge bending moment about the z-axis. 2D Euler Beam

Bending moment about the axis indicated by 
the direction of the arrow.

Mindlin Plate

Force in the direction indicated by the 
direction of the arrow.

Solid, Stress-Strain,

Piezo Solid,

Shell,

3D Euler Beam

Moment about the axis indicated by the 
direction of the arrow.

Shell,

3D Euler Beam

Force and/or moment defined in the local 
coordinate system.

3D Euler Beam, local coordinate
system.

MBOL DESCRIPTION APPLICATION MODES
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CONSTR
Constraint Symbols

Constraint symbols are available on points, boundaries, edges, and subdomains. The 
following table lists all constraint symbols together with the application modes where 
they appear.

AINTS SYMBOL DESCRIPTION APPLICATION MODE

Displacement constrained in the direction 
indicated by the roller.

Plane Stress, Piezo Plane Stress,

Plane Strain, Piezo Plane Strain,

Axial Symmetry, Stress-Strain,

Piezo Axial Symmetry,

2D Euler Beam

Displacement constrained in the x and 
y directions. 

2D Euler Beam

All degrees of freedom constrained. Plane Stress, Piezo Plane Stress,

Plane Strain, Piezo Plane Strain,

Axial Symmetry, Stress-Strain,

Piezo Axial Symmetry,

2D Euler Beam

Rotation constrained. 2D Euler Beam

Rotation constrained.

Displacement constrained in the direction 
indicated by the roller.

2D Euler Beam
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CONSTR
Displacement constrained in the 
z direction.

Mindlin Plate

Displacement constrained in the 
z direction.

Rotation constrained but allowed about 
the axis indicated by the line segments.

Mindlin Plate

Rotation constrained about the axis 
indicated by the space between the 
triangles.

Mindlin Plate

Rotations about all axes constrained. Mindlin Plate

Clamped edge, all degrees of freedom 
constrained.

Plane Stress, Piezo Plane Stress,

Plane Strain, Piezo Plane Strain,

Axial Symmetry, Stress-Strain,

Piezo Axial Symmetry,

2D Euler Beam

Displacement constrained in the 
z direction.

Mindlin Plate

AINTS SYMBOL DESCRIPTION APPLICATION MODE
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Cl stem.

CONSTR
Rotation constrained but allowed about 
the axis indicated by the line segments.

Mindlin Plate

Displacement constrained in the 
z direction.

Rotation constrained but allowed about 
the axis indicated by the line segments.

Mindlin Plate

Rotations about all axes constrained. Mindlin Plate

Displacements constrained in the 
directions indicated by the arrows.

3D Euler Beam,

Shell,

Solid, Stress-Strain,

Piezo Solid

Rotations constrained about axis 
directions indicated by the arrows.

3D Euler Beam

Shell

Displacements and/or rotations 
constrained in the local coordinate 
system.

3D Euler Beam, local coordinate sy

AINTS SYMBOL DESCRIPTION APPLICATION MODE
 6 :  C O O R D I N A T E  S Y S T E M S  A N D  S Y M B O L S



 7
C o n t i n u u m  A p p l i c a t i o n  M o d e s
Continuum in this context means that no simplifications are available and that you 
solve for the displacements without involving rotations.

The following application modes in the Structural Mechanics Module are of the 
continuum type:

• Solid, Stress-strain

• Plane Stress

• Plane Strain

• Axial Symmetry, Stress-Strain

Continuum application modes are formulated on planes in 2D and volumes in 3D. 
In the continuum application modes you can use Lagrange elements of arbitrary 
order.
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S o l i d ,  S t r e s s - S t r a i n

The degrees of freedom (dependent variables) in this application mode are the global 
displacements u, v, and w in the global x, y, and z directions, respectively, and the 
pressure p (only used if mixed formulation is selected).

Loads and constraints applied to a 3D solid using the Solid, Stress-Strain application 
mode.
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P l a n e  S t r e s s

Use the Plane Stress application mode in the Structural Mechanics Module to analyze 
thin in-plane loaded plates. It solves for the global displacements (u, v) in the x and y 
directions, the pressure p (only used for mixed formulation), and the displacement 
derivative in the perpendicular direction (only used for hyperelastic material). For a 
state of plane stress, this mode assumes the σz, τyz, and τxz components of the stress 
tensor are zero.

The Plane Stress application mode models plates where the loads are only in the plane; it 
does not include any out-of-plane stress components.

This application mode allows loads in the x and y directions, and it assumes that these 
are constant throughout the material’s thickness, which however can vary with x and 
y. The plane stress condition prevails in a thin flat plate in the xy-plane loaded only in 
its own plane and without any z direction restraint. 
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P l a n e  S t r a i n

The Plane Strain application mode in the Structural Mechanics Module solves for the 
global displacements (u, v) in the x and y directions and the pressure p (only if mixed 
formulation is used). The assumption that defines a state of plane strain is that the εz, 
εyz, and εxz components of the strain tensor are zero. 

A geometry suitable for plane strain analysis.

Loads in the x and y directions are allowed. The loads are assumed to be constant 
throughout the thickness of the material, but the thickness can vary with x and y. The 
plane strain condition prevails in geometries, whose extent is large in the z direction 
compared to in the x and y directions, or when the z displacement is in some way 
restricted. One example is a long tunnel along the z-axis where it is sufficient to study 
a unit-depth slice in the xy-plane.
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Ax i a l  S ymme t r y ,  S t r e s s - S t r a i n

The Axial Symmetry, Stress-Strain application mode uses cylindrical coordinates r, 
(phi), and z. It solves equations for the global displacement (uor, w) in the r and 

z directions and the pressure p (only used for mixed formulation). The dependent 
variable, , is introduced to avoid division by r, which causes problems on 
the axis where r = 0. This application mode assumes that the displacement v in the 

 direction together with the , , , and  components of the stresses and 
strains are zero. Loads are independent of , and this application mode allows loads 
only in the r and z directions.

You can view the domain where the application mode solves the equations as the 
intersection between the original axially symmetric 3D solid and the half plane , 
r ≥ 0. Therefore you draw the geometry only in the half plane r ≥ 0 and recover the 
original 3D solid by rotating the 2D geometry about the z-axis.

Rotating a 2D geometry to recover a 3D solid.

Note: r = 0 is the symmetry axis. In the Axisymmetry, Stress-Strain application mode 
x → r and y → z.

ϕ

uor u r⁄=

ϕ τrϕ τϕz γrϕ γϕz
ϕ

ϕ 0=
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Th eo r y  Ba c k g r ound

Strain-Displacement Relationship

The strain consists of thermal (εth), elastic (εel), and initial (ε0) contributions so that

The strain conditions at a point are completely defined by the deformation 
components—u, v, and w in 3D—and their derivatives. The precise relation between 
strain and deformation depends on the relative magnitude of the displacement.

S M A L L  D I S P L A C E M E N T S

Under the assumption of small displacements, the normal strain components and the 
shear strain components are related to the deformation as follows:

 (7-1)

To express the shear strain, use either the tensor form, εxy, εyz, εxz, or the engineering 
form, γxy, γyz, γxz. 

The symmetric strain tensor ε consists of both normal and shear strain components:

The strain-displacement relationships for the axial symmetry case for small 
displacements are

ε εel εth ε0+ +=

εx x∂
∂u

=

εy y∂
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=
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L A R G E  D I S P L A C E M E N T S

For large-displacement analysis, the deformation is not small and you calculate the 
strains without this restriction. The resulting strains are known as Green or Green-
Lagrange strains, and large displacement is sometimes referred to as geometric 
nonlinearity or nonlinear geometry.

Green strains are defined with reference to an undeformed geometry. Hence, they 
represent a Lagrangian description.

In a small-strain, large rotational analysis, the Green strain corresponds to the 
engineering strain in directions that follow the deformed body. The Green strain is a 
natural choice when formulating a problem in the undeformed state.

The Green strain components, εij, are

 (7-2)

A N A L Y S I S  O F  D E F O R M A T I O N  A N D  T H E  D E F O R M A T I O N  G R A D I E N T

As a start, consider a certain physical particle, initially located at the coordinate X. 
During deformation, this particle follows a path

For simplicity, assume that undeformed and deformed positions are measured in the 
same coordinate system. Using the displacement u, it is then possible to write

When studying how an infinitesimal line element dX is mapped to the corresponding 
deformed line element dx, the deformation gradient  F defined by

is used.

The deformation gradient contains the complete information about the local straining 
and rotation of the material. It is a positive definite matrix, as long as material cannot 
be annihilated. The ratio between current and original volume (or mass density) is

εij
1
2
---

ui∂
xj∂

--------
uj∂
xi∂

--------
uk∂
xi∂

---------
uk∂
xj∂

---------⋅+ +⎝ ⎠
⎛ ⎞=

x x X t,( )=

x X u+=

dx x∂
X∂

-------dX F dX= =

dV
dV0
-----------

ρ0
ρ
------ det F( ) J= = =
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As a consequence, a deformation state where J = 1 is said to be incompressible. From 
the deformation gradient, it is possible to define the right Cauchy-Green tensor as

The most commonly used definition of strain is the engineering strain ε; see 
Equation 7-1.

As can be shown by simple insertion, a finite rigid body rotation will cause nonzero 
values of the engineering strain. This is not in correspondence with the intuitive 
concept of strain, and it is certainly not useful in a constitutive law. There are several 
alternative strain definitions in use that do have the desired properties. The Green 
strain, ε, is defined as

Using the displacements, the Green strain can be also written as shown in Equation 7-
2. 

The deformation gradient and its inverse are available as variables and can be used, for 
instance, to model follower loads; see the Hyperelastic Seal model on page 467 in the 
Structural Mechanics Model Library for an example.

Stress-Strain Relationship

The symmetric stress tensor σ describes stress in a material:

This tensor consists of three normal stresses (σx, σy, σz) and six (or, if symmetry is used, 
three) shear stresses (τxy, τyz, τxz).

For large deformations and hyperelastic material models there are more than one stress 
measure:

• Cauchy stress σ (the components are denoted sx, … in COMSOL Multiphysics) 
defined as force/deformed area in fixed directions not following the body. 
Symmetric tensor.

C FTF=

ε 1
2
--- C I–( ) 1

2
--- FTF I–( )= =

σ
σx τxy τxz

τyx σy τyz

τzx τzy σz

= τxy τyx= τxz τzx= τyz τzy=
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• First Piola-Kirchhoff stress P (the components are denoted Px, … in COMSOL 
Multiphysics). This is an unsymmetric tensor used only for hyperelastic material 
models.

• Second Piola-Kirchhoff stress S (the components are denoted Sx, … in COMSOL 
Multiphysics). This is a symmetric tensor, for small strains same as Cauchy stress 
tensor but in directions following the body.

The stresses relate to each other as 

L I N E A R  E L A S T I C  M A T E R I A L

The stress-strain relationship—or the constitutive equation—for linear conditions 
including initial stress and strain and thermal effects reads:

where D is the 6-by-6 elasticity matrix and the stress and the strain are both given in 
column vector form:

Note: In the following descriptions σ and ε denote either the stress and strain vectors 
or the corresponding tensors depending on the circumstances.

The elasticity matrix D—or the more basic flexibility (or compliance) matrix, the 
inverse of D—is defined differently for isotropic, orthotropic, and anisotropic 
materials. For an isotropic material, the flexibility matrix looks like

S F 1– P=

σ J 1– PFT J 1– FSFT
= =

σ Dεel σ0+ D ε εth– ε0–( ) σ0+= =

σ

σx

σy

σz

τxy

τyz

τxz

= ε

εx

εy

εz

γxy

γyz

γxz

=
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where E is the modulus of elasticity or Young’s modulus, and ν is Poisson’s ratio, 
which defines the contraction in the perpendicular direction. Inverting D−1 results in 
the following elasticity matrix:

For an orthotropic material, the D−1 matrix takes the form

where you supply the values of Ex, Ey, Ez, νxy, νyz, νxz, Gxy, Gyz, and Gxz in designated 
edit fields in the user interface. The software deduces the remaining components—νyx, 
νzx, and νzy—by using the fact that the matrices D and D−1 are symmetric.

D 1– 1
E
----

1 ν– ν– 0 0 0
ν– 1 ν– 0 0 0
ν– ν– 1 0 0 0

0 0 0 2 1 ν+( ) 0 0
0 0 0 0 2 1 ν+( ) 0
0 0 0 0 0 2 1 ν+( )

=

D E
1 ν+( ) 1 2ν–( )

---------------------------------------

1 ν– ν ν 0 0 0
ν 1 ν– ν 0 0 0
ν ν 1 ν– 0 0 0

0 0 0 1 2ν–
2

---------------- 0 0

0 0 0 0 1 2ν–
2

---------------- 0

0 0 0 0 0 1 2ν–
2

----------------

=

D 1–

1
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--------–

νzx
Ez
--------– 0 0 0

νxy
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--------–

1
Ey
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Ez
--------– 0 0 0

νxz
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--------–

νyz

Ey
--------–

1
Ez
------ 0 0 0

0 0 0 1
Gxy
--------- 0 0

0 0 0 0 1
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--------- 0

0 0 0 0 0 1
Gxz
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=
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Note: The definitions of the components νij can vary depending on the application 
field. When specifying the material properties, make sure you use the definitions just 
given. If necessary, transform your material data so that it conforms with the above 
conventions before entering it in the Structural Mechanics Module’s user interface.

Inverting D−1 using only the Ex, Ey, Ez, νxy,νyz, νxz, Gxy, Gyz, and Gxz coefficients 
results in the symmetric D matrix

where the components are as follows: 

where 

For an anisotropic material, you provide the symmetric D matrix explicitly.

D

D11 D12 D13 0 0 0

D12 D22 D23 0 0 0

D13 D23 D33 0 0 0

0 0 0 D44 0 0

0 0 0 0 D55 0

0 0 0 0 0 D66

=

D11
Ex

2 Ezνyz
2 Ey–( )

Ddenom
----------------------------------------,= D12

ExEy Ezνyzνxz Eyνxy+( )
Ddenom

-----------------------------------------------------------------,–=

D13
ExEyEy νxyνyz νxz+( )

Ddenom
----------------------------------------------------------,–= D22

Ey
2 Ezνxz

2 Ex–( )
Ddenom

----------------------------------------,=

D23
EyEz Eyνxyνxz Exνyz+( )

Ddenom
-----------------------------------------------------------------,–= D33

EyEz Eyνxy
2 Ex–( )

Ddenom
-----------------------------------------------,=

D44 Gxy= ,    D55 Gyz= ,  and D66 Gxz=

Ddenom EyEzνxz
2 ExEy– 2νxyνyzνxzEyEz ExEzνyz

2 Ey
2νxy

2
+ + +=
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Mixed Formulation
Mixed formulations are used for nearly incompressible materials. The solution is to add 
the negative mean stress as a new dependent variable, p (pressure).

The stress-strain relation for linear elastic material for 3D is

The stress σ is separated in a deviatoric part, σd,  and a mean part, −p:

where 

and m is a six-dimensional column vector. Inserting the stress-strain relation for 
isotropic materials results in the following expressions for the deviatoric stress and the 
vector m:

where

p
σx σy σz+ +

3
-------------------------------⎝ ⎠
⎛ ⎞–=

σ Dεel σ0+ D ε εth– ε0–( ) σ0+= =

σ σd mp–=

σd Dd ε εth– ε0–( ) σ0d+=

σ0 σ0d p0–=

p0
σ0x σ0y σ0z+ +

3
----------------------------------------⎝ ⎠
⎛ ⎞–=

σd Dd

εx

εy

εz

εxy

εyz

εxz

εx0

εy0

εz0

εxy0

εyz0

εxz0

– α T Tref–( )m– σ0 p0+( )+=
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The equation for the pressure becomes

where G is the shear modulus and K is the bulk modulus.

For orthotropic and anisotropic materials some scaling is performed to get a system of 
equations that produces symmetric matrices. The equations for the stress and the 
pressure become

where, n, Dd, and m are defined as

Dd G

4
3
--- 2

3
---–

2
3
---– 0 0 0

2
3
---–

4
3
--- 2

3
---– 0 0 0

2
3
---–

2
3
---–

4
3
--- 0 0 0

0 0 0 2 0 0
0 0 0 0 2 0
0 0 0 0 0 2

=

m

1
1
1
0
0
0

=

p
K
---- mT ε εth– ε0–( )

p0
K
------–+ 0=

K E
3 1 2ν–( )
------------------------=

σ σd np–=

σd Dd ε εth– ε0–( ) σ0d+=

σ0 σ0d p0–=

p0
σ0x σ0y σ0z+ +

3
----------------------------------------⎝ ⎠
⎛ ⎞–=

9p
Dsum
-------------- mT ε εth– ε0–( )

9p0
Dsum
--------------–+ 0=
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This produces symmetric matrices.

Note: The mixed formulation creates indefinite matrices, which affects the selection 
of iterative solvers. See “Selecting Iterative Solvers” on page 127 for more 
information.

The mixed formulation are useful not only for linear elastic material but also for elasto-
plastic and hyperelastic materials. 

In the mixed formulation the pressure is interpolated using a polynomial of one order 
less than the one used for the displacement variables.

If loss factor damping is used with frequency response analysis, the loss information 
appears also in the pressure equation. The equation with loss factor damping for 
isotropic material is

and the equation for orthotropic and anisotropic materials is

mi
3di

Dsum
--------------=

ni mi= i 1 … 3, ,=

ni 0.5mi= i 4 … 6, ,=

Dsum Dij

i 1 … 3, ,=

j 1 … 6, ,=

∑=

di D1i D2i D3i+ +=

Ddij Dij
didj

Dsum
--------------–= i 1 … 3, ,= j 1 … 6, ,=

Ddij Dij 0.5
didj

Dsum
--------------–= i 4 … 6, ,= j 1 … 6, ,=

p
1 jη+( )K

------------------------- mTε
mT εth ε0+( )

1 jη+( )
---------------------------------

p0
1 jη+( )K

-------------------------––+ 0=

K E
3 1 2ν–( )
------------------------=
 7 :  C O N T I N U U M  A P P L I C A T I O N  M O D E S



where η is the loss factor.

E L A S T O - P L A S T I C  M A T E R I A L S

In an elasto-plastic material the stress-strain relationship is

where εp is the plastic strain vector.

The variable εp and a vector κ of state parameters describe the state of a plastic 
deformation. To describe the evolution of these variables, use the rate equations 

where v is a vector whose variables form the solution vector (with parameters such as 
displacements and temperature) and λ is the plastic multiplier. The dot stands for 
differentiation with respect to pseudo-time or time. The plastic multiplier is 
determined by the complementarity conditions 

where F is the yield function. The functions F, G, and H often take a simpler form 
when expressed in terms of the generalized stress, Σ,

where σ is the vector of stress components, and χ is the vector of conjugate forces. The 
function f1 is often a linear function (matrix D). For associated plasticity, which is the 
rule,

For non-associated plasticity, which is very uncommon, 

9p
1 jη+( )Dsum

----------------------------------- mTε
mT εth ε0+( )

1 jη+( )
---------------------------------

9p0
1 jη+( )Dsum

-----------------------------------––+ 0=

σ Dεel σ0+ D ε εp εth–– ε0–( ) σ0+= =

ε· p λH εp κ v, ,( ) κ· λG εp κ v, ,( )=,=

F εp κ v, ,( ) 0 λ 0 F εp κ v, ,( )λ,≥,≤ 0=

Σ σ
χ

f1 ε εp v,–( )

f2 εp κ v, ,( )
= =

H σ χ,( )
σ∂

∂ F σ χ,( ) G σ χ,( )
χ∂

∂ F σ χ,( )–=,=

H σ χ,( )
σ∂

∂ Q σ χ,( ) G σ χ,( ) –=,
χ∂

∂ Q σ χ,( )=
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where Q is a plastic potential.

Now consider some special cases where the effective stress function, , is often the 
von Mises stress.

Perfect (or Ideal) Plasticity

 

where Y0 is the yield stress.

Isotropic Hardening

where εpe is the effective plastic strain, and Y is the yield stress. The function f2 is 
often nonlinear.

Kinematic Hardening

where f3 often is a linear function.

In cases with kinematic hardening, the plastic strain is a subset of the state parameters. 
Then you only need the rate equation 

and the complementarity conditions 

You can thus write the generalized stress, Σ, as

These formulas also hold for cases without kinematic hardening if you enlarge the 
vector of state parameters to include the plastic strain. From now on this discussion 
assumes this definition of κ, leading to the following special cases:

φ

κ empty F, φ σ( ) Y0– H
σ∂

∂F
= = =

κ εpe χ, Y f2 εpe( )= F σ Y,( ), φ σ( ) Y– G
σ∂

∂F
– 1= = = = =

κ εp χ, σshift f3 εp( )= F φ σ σshift–( ) Y0–= G, ,
σshift∂

∂F
–= = =

κ· λG κ v,( )=

F κ v,( ) 0 λ 0 F κ v,( )λ,≥,≤ 0=

Σ σ
χ

f κ v,( )= =
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Perfect (or Ideal) Plasticity

Isotropic Hardening

where εpe is the effective plastic strain, and Y is the yield stress. The function f2 is often 
nonlinear.

Kinematic Hardening

where f3 often is a linear function.

Postprocessing
The effective plastic strain is calculated from the equation

The plastic strain can be calculated in the node points like any other variable but this 
may cause problems because evaluating the plastic strain involves solving an equation 
system. 

For postprocessing purposes, Gauss-point variables are an alternative to the stresses, 
plastic strains, and effective plastic strain discussed above. Gauss-point variables are 
normally better because they are the values that were calculated during the solution 
process. The Gauss-point variables have the suffix Gp appended to their names, for 
example, sxGp instead of sx.

The elasto-plastic material model requires that you use a solver that can follow the load 
history, that is, you need to use the nonlinear parametric or transient solver. You 
cannot use the nonlinear static solver together with an elasto-plastic material model.

κ εp F, φ σ( ) Y0– G,
σ∂

∂F
= = =

κ
εp

εpe

χ, Y f2 εpe( )= F, φ σ( ) Y,– G σ∂
∂F

Y∂
∂F

–

= = = =

κ εp χ, σshift f3 εp( )= F φ σ σshift–( ) Y0–= G, ,
σ∂

∂F
= = =

εpe ε· pe td

0

t

∫=

ε· pe
2

3
------- ε· px ε· py–( )

2
ε· py ε· pz–( )

2
ε· px ε· pz–( )

2
6ε· pxy

2
6ε· pyz

2
6ε· pxz

2
+ + + + +=
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H Y P E R E L A S T I C  M A T E R I A L S

A hyperelastic material is defined from its strain energy function, Ws, which is a 
function of the strain state. The stress in such a material is computed from the strain 
energy function Ws, In the following, assume that the First Piola-Kirchhoff stresses P 
and the displacement gradient  are used, so that

 (7-3)

For an isotropic material, Ws can only be a function of the strain invariants. In a total 
Lagrangian formulation it is convenient to use the right Cauchy-Green tensor C = FTF 
for the representation of the strain. The invariants are:

where J ≡ det ( F  ). Due to the incompressibility, it is often a good idea to work with 
modified invariants, where the two first invariants have no dependency on the volume 
change. Such invariants can be defined as

COMSOL Multiphysics calculates the first Piola-Kirchhoff stress P by symbolic 
differentiation of the strain energy expression.

The hyperelastic material models directly supported are:

Neo-Hookean   

 (7-4)

Mooney-Rivlin   

u∇

P
Ws∂

u∇∂
-----------=

I1 trace C( ) C11 C22 C33+ += =

I2
1
2
--- I1

2 trace C2( )–( )=

I3 det C( ) J2
= =

I1 I1J

2
3
---–

=

I2 I2J

4
3
---–

=

Ws
1
2
---µ I1 3–( ) 1

2
---κ Jel 1–( )2

+=
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 (7-5)

The quantity Jel is defined in Equation 7-9 below.

Instead of the normal approach—using the conjugate pair formed by the second Piola-
Kirchhoff stress and the Green-Lagrange strain—use the first Piola-Kirchhoff stress, P, 
and its conjugate strain, the displacement gradient, . This makes it possible to 
utilize the capability of COMSOL Multiphysics to automatically differentiate an 
expression, thus making it easy to modify only the strain energy function. The first 
Piola-Kirchhoff stresses are calculated as

The variation of the energy can then be expressed as

Materials that are nearly incompressible cannot be solved using only displacement 
variables. The remedy is to introduce the pressure, p, as a dependent variable. The 
hyperelastic material model supports both the normal displacement-based formulation 
and the so-called mixed formulation that includes the pressure. The pressure is related 
to the volume change through the relation

 (7-6)

where κ is the bulk modulus. 

The energy equations where the pressure is a dependent variable are:

Neo-Hookean   

 (7-7)

Mooney-Rivlin   

 (7-8)

Ws C10 I1 3–( ) C01 I2 3–( ) 1
2
---κ Jel 1–( )2

+ +=

u∇

P
∇u∂

∂Ws=

xj∂
∂ui

⎝ ⎠
⎜ ⎟
⎛ ⎞

test

Pij

i j,
∑

p κ Jel 1–( )–=

Ws
1
2
---µ I1 3–( ) p Jel 1–( )–

p2

2κ
------–=

Ws C10 I1 3–( ) C01 I2 3–( ) p Jel 1–( ) p2

2κ
------––+=
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It can be shown that these equations results in the same energy and gives the correct 
contributions to the displacement and pressure equations as Equation 7-4 and 
Equation 7-5.

The second Piola-Kirchhoff stress, S, and the Cauchy stress, σ, can then be calculated 
from the first Piola-Kirchhoff stress:

Thermal Expansion
If thermal expansion is present, a stress-free volume change occurs. In this case, Jel in 
the constitutive relations above must be regarded as the elastic part of the total volume 
change, that is

 (7-9)

Thermal Strain

Thermal strain depends on the present temperature, T, the stress-free reference 
temperature, Tref, and the thermal expansion vector, αvec

Depending on the material model, you set up αvec up differently: For an isotropic 
material

S F 1– P=

σ J 1– PFT
=

Jel
J

Jth
-------- J

1 εth+( )3
-------------------------= =

εth

εx

εy

εz

γxy

γyz

γxz th

αvec T Tref–( )= =
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for an orthotropic material

and for an anisotropic material you enter the full thermal expansion vector as input:

E N T R O P Y

For a linear thermoelastic solid, the entropy per unit volume is:

where T0 is the reference temperature, the volumetric heat capacity ρCP is assumed 
independent of the temperature, and

 (7-10)

where σ is the stress vector, and αvec is the thermal expansion vector. For an isotropic 
material, Equation 7-10 simplifies into

αvec

α
α
α
0
0
0

=

αvec

αx

αy

αz

0
0
0

=

αvec

αx

αy

αz

2αxy

2αyz

2αxz

=

S ρCP T T0⁄( )log Selast+=

Selast αvec σ⋅=
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  (7-11)

The entropy is a function of state and thus independent of the strain rate. The stress 
vector σ in the definitions Equation 7-10 and Equation 7-11 corresponds to no 
damping when used in a frequency response analysis, because the damping represents 
the rate-dependent (viscoelastic) effects in the material.

If you model the damping in the structural analysis via the loss factor, use the following 
definition for the elastic part of the entropy:

where η is the loss factor, and j is the imaginary unit. For more details, see “Loss Factor 
Damping” on page 122, and the example “Heat Generation in a Vibrating Structure” 
on page 703 of the Structural Mechanics Module Model Library.

Initial Stress and Strain

Initial stress refers to the stress before the system applies any loads, displacements, or 
initial strains, written as

The initial strain is the one before the system has applied any loads, displacements, or 
initial stresses

Selast α σx σy σz+ +( )=

Selast αvec σ jηDε–( )⋅=

σ0

σx0

σy0

σz0

τxy0

τyz0

τxz0

=

ε0

εx0

εy0

εz0

2εxy0

2εyz0

2εxz0

=
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Follower Loads

Follower loads are loads that change direction as the body deforms. The most common 
type of follower load is a pressure acting on a surface. In this case the force changes 
size due to the stretching of the surface and direction due to the change in normal 
direction. The following section only considers this type of follower loads.

T H E O R Y

The continuum application modes are formulated in the reference frame (the default). 
All forces must be specified as force/undeformed area in a fixed coordinate system (not 
in a system following the body). This makes it difficult to model a pressure acting on 
a surface because the force changes direction due to the deformation. There is also an 
area effect due to the stretching of the surface. The relation between the deformed area 
da and the undeformed area dA is needed. To handle this, the software uses a 
deformed frame that computes both the deformed area and the deformed normal 
direction (n). The force is calculated as

where P are the follower pressure.

Plane Stress
In a plane stress condition the out-of-plane deformation causes the thickness to 
change, and this area effect is included explicitly. The equation transforms to

Axial Symmetry
The extra r in the circumferential integration of the force expressions is transformed 
to r + uaxi to account for the deformation.

Implementation

The COMSOL Multiphysics implementation of these equations in the application 
modes for structural analysis is based on the principle of virtual work expressed in 
global or local stress and strain components. The principle of virtual work states that 
the sum of virtual work from internal strains is equal to work from external loads.

FdA Pnda Pn da
dA
--------dA–=–=

FdA Pn da
dA
--------dA 1

z∂
∂w

+⎝ ⎠
⎛ ⎞–=
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The total stored energy, W, for a linear material from external and internal strains and 
loads equals

The principle of virtual work states that 

,

and in order to derive the expression for the variation of W you differentiate 
symbolically, reaching the expression

The principle of virtual work for the axial symmetry case reads

To avoid division by r, the true radial displacement, u is replaced in the above equation 
by a new dependent variable

.

If you define the material in a local user-defined coordinate system, the variational 
equation in COMSOL Multiphysics is expressed in local instead of global stresses and 
strains.

W 1
2
--- ε– xσx εy– σy εz– σz 2εxy– τxy 2εyzτyz– 2εxz– τxz( ) utFV+⎝ ⎠
⎛ ⎞ vd

V
∫=

utFS s utFL l U
p
∑

t
FP .+d

L
∫+d

S
∫+

δW 0=

δW ε– xtestσx εytest– σy εztest– σz

2εxytest– τxy 2εyztestτyz– 2εxztest– τxz utest
t FV+

(

) v

utest
t FS sd

S
∫ utest

t FL ld
L
∫ Utest

t FP .+ + +

d

V
∫=

δW r ε– rtestσr εϕtest– σϕ εztestσz 2– εrztest– τrz

r uor⋅ testFr wtestFz+ +

(

) A

r r uor⋅ testFr wtestFz+( ) sd
S
∫ r uor⋅ testFr wtestFz +( ) 2π⁄

+

+

d

A
∫

0

=

=

uor u
r
---=
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To create the strain tensor in local coordinates, transform the global strain tensor

where T is the local-to-global coordinate-system transformation matrix.

Then calculate the local stress tensor from the local strain, and the global stress tensor 
by transforming the local stress tensor

S E T T I N G  U P  E Q U A T I O N S  F O R  D I F F E R E N T  A N A L Y S E S

All application modes in the Structural Mechanics Module support static, 
eigenfrequency, transient, frequency-response, parametric, and quasi-static transient 
analyses. Each type might solve a different equation or employ a different solver. You 
control this choice with the Analysis type property that appear in the Application Mode 

Properties dialog box for the corresponding application mode.

Static , Parametric , and Quasi-Static Transient Analysis
These analyses all use the same equation, the difference being what solver that is used. 
In the following, static analysis is used as short for all the above analyses because they 
use the same equations.

COMSOL Multiphysics’ implementation is based on the stress and strain variables. 
The normal and shear strain variables depend on the displacement derivatives 
(described in general 3D terms in the section “Theory Background” on page 164); the 
normal and shear stress variables depend on the strains (described in general 3D terms 
in the section“Stress-Strain Relationship” on page 166). 

Using the shear and stress variables, you can express the principle of virtual work as

If you describe the material in a local coordinate system, δW is expressed in local 
stresses and strains. 

εl TTεgT=

σg TσlT
T

=

δW ε– xtestσx εytest– σy εztest– σz

2εxytest– τxy 2εyztestτyz– 2εxztest– τxz utest
T FV+

(

) v

utest
T FS sd

S
∫ utest

T FL ld
L
∫ Utest

T

p
∑ FP+ + +

d

V
∫

0

=

=
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Transient Analysis
For transient problems consider Newton’s second law

.

It defines the equation of motion with no damping.

To model viscous damping, COMSOL Multiphysics uses Rayleigh damping, where 
you specify two damping coefficients. As an example, consider a system with a single 
degree of freedom. The equation of motion for such a system with viscous damping is

.

In the Rayleigh damping model, you express the damping parameter ξ in terms of the 
mass m and the stiffness k as

The Rayleigh damping proportional to mass and stiffness is added to the static weak 
term.

Frequency Response Analysis
You specify harmonic loads using two components:

• The amplitude value, Fx

• The phase, FxPh 

To derive the equations for the steady-state response from harmonic excitation loads

assume a harmonic response with the same angular frequency as the excitation load 

ρ∂2u

∂t2
---------- ∇– c u∇⋅ F=

md2u

dt2
---------- ξdu

dt
------- ku+ + f t( )=

ξ αdMm βdKk+=

Fxfreq Fx f( ) ωt FxPh f( ) π
180
----------+⎝ ⎠

⎛ ⎞

Ffreq

Fxfreq

Fyfreq

Fzfreq

,=

cos⋅=
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You can also describe this relationship using complex notation

where

Eigenfrequency Analysis
The eigenfrequency equations are derived by assuming a harmonic displacement field, 
similar as for the frequency response formulation. The difference is that this analysis 
type uses a new variable jω explicitly expressed in the eigenvalue.

The eigenfrequency f is then derived from jω as

In the eigenfrequency analysis no damping is added to the equations.

u uamp ωt φu+( )

u
u
v
w

=

cos=

u Re uampe
jφuejωt( ) Re ũe

jωt
( )  where ũ uampe

jφu= = =

u Re ũe
jωt

( )=

Fxfreq Re Fx ω( )e
jFxPh f( ) π

180
----------

ejωt

⎝ ⎠
⎜ ⎟
⎛ ⎞

Re Fx
˜ ejωt( )= =

Fx
˜ Fx f( )e

jFxPh f( ) π
180
----------

=

F
˜

Fx
˜

Fy
˜

Fz
˜

=

jω λ–=

f Im jω( )
2π

-------------------=
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Damped Eigenfrequency Analysis
This analysis type is similar to the eigenfrequency analysis except that it adds viscous 
damping terms to the equation. The analysis type supports Rayleigh damping. In 
addition to the eigenfrequency you can also look at the quality factor, Q, and decay 
factor, δ, for the model:

Contact Modeling

COMSOL Multiphysics solves contact problems using an augmented Lagrangian 
method. This means that the software solves the system in a segregated way. 
Augmentation components are introduced for the contact pressure Tn and the 
components Tti of the friction traction vector Tt. An additional iteration level is added 
where the usual displacement variables are solved separately from the contact pressure 
and traction variables. The algorithm repeats this procedure until it fulfills a 
convergence criterion.

In the following equations F is the deformation gradient matrix. When looking at 
expressions evaluated on the slave boundaries, the expression map(E) denotes the 
value of the expression E evaluated at a corresponding master point, and g is the gap 
distance between the slave and master boundary. 

Both the contact map operator map(E) and the gap distance variable are defined by 
the contact element elcontact (see the documentation of elcontact on page 55 of 
the COMSOL Multiphysics Reference Guide for details). For each slave point where 
the operator or gap is evaluated, a corresponding master point is sought by searching 
in the direction normal to the slave boundary.

Q Im λ( )
2Re λ( )
-------------------=

δ Re λ( )=

Master

Slave

x

m(x)

g
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Note that before the boundaries come in contact, the master point found is not 
necessarily the point on the master boundary closest to the slave point. However, as 
the boundaries approach one another, the master point converges to the closest point 
as the gap distance goes to zero.

Using the special gap distance variable, the penalized contact pressure Tnp is defined 
on the slave boundary as

 (7-12)

where g is the gap distance between the slave and master boundary, and pn is the user 
defined normal penalty factor.

The penalized friction traction Ttp is defined on the slave boundary as:

 (7-13)

where Tttrial is defined as

 (7-14)

and

 (7-15)

where x are the space coordinates. 

In Equation 7-14 pt is the user-defined friction traction penalty factor, and xm
old is the 

value of xm in the last time step, and 

 (7-16)

is the vector of slip since the last time step (approximated using a backward Euler step). 

Ttcrit is defined as

 (7-17)

In Equation 7-17 µ is the friction coefficient, cohe is the user-defined cohesion sliding 
resistance, and Ttmax is the user-defined maximum friction traction.

Tnp

Tn png– if g 0≤

Tne

png
Tn

---------–

otherwise⎩
⎪
⎨
⎪
⎧

=

Ttp min
Ttcrit
Tttrial

-------------------- 1,⎝ ⎠
⎛ ⎞Tttrial=

Tttrial Tt pt– map F( ) xm xm
old–( )=

xm map x( )=

map F( ) xm xm
old–( )

Ttcrit min µTnp cohe+ Ttmax,( )=
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In the following equation δ is the variation (represented by the test operator in 
COMSOL Multiphysics). The contact interaction gives the following contribution to 
the weak equation on the slave boundary:

 (7-18)

where wcn and wct are contact help variables defined as:

 (7-19)

 (7-20)

where i is the augmented solver iteration number and friction is a Boolean variable 
stating if the parts are in contact.

F R I C T I O N

The friction model is either no friction or Coulomb friction.

The friction coefficient µ is defined as

 (7-21)

where µs is the static coefficient of friction and µd is the dynamic friction coefficient. 
vs is the slip velocity, and dcfric is a decay coefficient.

Tnpδg Ttp m F( )δxm⋅+( ) A wcnδTn wct δTt⋅+( ) Ad
slave
∫+d

slave
∫

wcn Tnp i, Tn i 1+,–=

wct friction Ttp n Ttp⋅( )n–( )( )i Tt i 1+,–=

µd µs µd–( )e dcfric vs–   if dynamic friction+

µs                    otherwise
⎩
⎪
⎨
⎪
⎧
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App l i c a t i o n  Mode De s c r i p t i o n

This section describes how to define a model using the continuum application modes 
in the Structural Mechanics Module. It reviews the following subsections:

• Application mode properties

• Scalar variables

• Material

• Constraints

• Loads

• Thermal coupling

• Damping

• Initial stresses and strains

• Perfectly matched layers (PMLs)

• Contact
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Properties

To set or examine application mode properties, go to the Physics>Properties menu to 
open the Application Mode Properties dialog box. Here you control various global 
settings for the model:

Application Mode Properties dialog box for the structural mechanics application modes.

• Default element type: The selected finite element type that makes up the discretized 
finite element model is the default on all new subdomains, and the choice does not 
affect subdomains already created. Available elements are:

-  Lagrange - Linear

-  Lagrange - Quadratic

-  Lagrange - Cubic

-  Lagrange - Quartic

-  Lagrange - Quintic

-  Lagrange - U2P1

-  Lagrange - U3P2

-  Lagrange - U4P3

-  Lagrange - U5P4

• Analysis type: This drop-down list shows the various analyses you can perform; the 
default is Static. Your choice affects both the equations and which solver COMSOL 
Multiphysics uses when the Auto select solver option in the Solver Parameters dialog 
box is active. 

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER

Static Stationary 

Static elasto-plastic material Parametric
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• Large deformation: This list controls whether or not the model should include large 
deformations, which only the Principle of virtual work supports (see next item). The 
default is Off.

• Specify eigenvalues using: This list controls how to work with eigenmode analyses. 
Here you should specify Eigenvalue or Eigenfrequency; this property is enabled only 
for eigenfrequency and linear-buckling analyses.

• Create frame: This list controls whether or not to create a deformed frame. The 
default is Off. A deformed frame is needed in contact modeling and to define 
follower forces but can also be used in a multiphysics context to define some other 
physics on.

• Eigenfrequency; this property is enabled only for eigenfrequency, damped 
eigenfrequency and linear-buckling analyses.

• Weak constraints: Controls whether or not weak constraints are active. Use weak 
constraints for accurate reaction-force computation. When weak constraints are 
enabled, all constraints are weak by default, but it is possible to change this setting 
for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 301 in the COMSOL Multiphysics Modeling Guide).

Scalar Variables

There are three different scalar variables:

• Excitation frequency, freq, which is applicable only for frequency response analysis.

Eigenfrequency Eigenvalue

Damped Eigenfrequency Eigenvalue

Time dependent Time dependent

Frequency response Parametric

Parametric Parametric

Quasi-static transient Time dependent

Linear buckling Eigenvalue

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER
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• Initial condition for the time in the previous time step, t_old_ini, which is 
applicable only for contact modeling using dynamic friction.

• Complex angular frequency, jomega, which is applicable only for eigenfrequency 
analysis. You normally do not need to edit the complex angular frequency.

The Application Scalar Variables dialog box in a frequency response analysis.

When you select a frequency response analysis, the parametric solver becomes the 
default solver, which makes it easy to perform a frequency sweep over several excitation 
frequencies in one analysis. In this case, choose Solve>Solver Parameters, and in the 
dialog box that appears go to the General page. In the Parameter area, enter 
freq_smsld in the Parameter name edit field. Values that you enter in the Parameter 

values edit field override the excitation frequency you might have entered in the 
Application Scalar Variables dialog box.

To access the excitation frequency f use the variable freq and to access the angular 
excitation frequency ω use omega.
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Material Properties

You define material properties on the Material page in the Subdomain Settings dialog 
box. This page has two lists: Material model and Coordinate system. Now consider the 
options available for each of these lists:

• Material model: When you select the type of material, a set of appropriate material 
properties appear in the dialog box.

- Isotropic: This material has the same properties in all directions.

Material properties for an isotropic material.

- Orthotropic: This material has different material properties in different directions, 
and its stiffness depends on the properties Ei, νij, and Gij (see page 166 for 
details). In addition, thermal expansion depends on the parameter αi (see page 
178 for details).
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Material properties for an orthotropic material.

- Anisotropic: This material has different material properties in different directions, 
and the stiffness comes from the symmetric elasticity matrix, D (see page 166 
for details). Thermal expansion depends on the thermal expansion vector, αvec 
(see page 178 for details).
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Material properties for an anisotropic material.

The Elasticity Matrix dialog box for entering the components of the D matrix for an 
anisotropic material.

- Elasto-plastic: A nonlinear material with possible hardening (see page 173 for 
details).
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Material properties for an elasto-plastic material.

The Elasto-Plastic Material Settings dialog box for specification of elasto-plastic material 
data.

- Hyperelastic: A hyperelastic material based on a strain energy density function, 
often used to model rubberlike materials (see page 176 for details).
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ic
Material properties for a hyperelastic material.

• Coordinate system: In this second list on the Material page you select the coordinate 
system on which the material properties are defined. Use it for orthotropic and 
anisotropic materials that are defined in another coordinate system other than the 
global system or if you need stresses and strains in a local coordinate system for 
postprocessing. The Coordinate system list is disabled if no user-defined coordinate 
systems are available. To open the Coordinate System Settings dialog box, go to the 
Options menu and choose Coordinate Systems.

• Use mixed U-P formulation (nearly incompressible material): Controls whether to use 
a mixed formulation adding the negative mean pressure as a dependent variable to 
solve for. This can also be controlled from the Predefined element list on the Element 
page. Nearly incompressible materials means a Poisson’s ratio close to 0.5. See page 
170 for details.

TABLE 7-1:  MATERIAL PROPERTIES FOR VARIOUS MATERIAL MODELS

PARAMETER VARIABLE DESCRIPTION MATERIAL MO

 E E Young's modulus Isotropic/ 
elasto-plast

 ν nu Poisson's ratio Isotropic/ 
elasto-plast

 ρ rho Density All

 α alpha Thermal-expansion coefficient Isotropic

  th thickness The thickness of the geometry All 
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The index i in the parameters Ei and αi in Table 7-1 refers to the space coordinates xi 
and represents the following names for the different application modes:

Example: Ei for axisymmetry stress-strain means Er, , and Ez.

The parameter νij in Table 7-1 refers to the space coordinates xixj and is defined for 
the following combinations of i and j for the different application modes:

 Ei Ei Young's modulus in the xi direction Orthotropi

 νij nuij Poisson's ratio for the xixj-plane Orthotropi

 Gij Gij Shear modulus for the xixj-plane Orthotropi

 αi alphai Thermal-expansion coefficient in the 
xi direction

Orthotropi

 D Elasticity matrix for the anisotropic case Anisotropic

 αvec Thermal-expansion vector for the 
anisotropic case

Anisotropic

 σys Sys Yield stress level Elasto-plast

 σyfunc Syfunc Yield function Elasto-plast

 σyhard Syhard Hardening function for isotropic hardening Elasto-plast

 ETiso ETiso Isotropic-tangent modulus Elasto-plast

 ETkin ETkin Kinematic-tangent modulus Elasto-plast

 C10 C10 Mooney-Rivlin material parameter Hyperelasti

 C01 C01 Mooney-Rivlin material parameter Hyperelasti

 µ mu Initial shear modulus Hyperelasti

 κ kappa Initial bulk modulus Hyperelasti

TABLE 7-1:  MATERIAL PROPERTIES FOR VARIOUS MATERIAL MODELS

PARAMETER VARIABLE DESCRIPTION MATERIAL MO

APPLICATION MODE  x1  x2  x3

Plane Stress and Plane Strain x y z

Solid x y z

Axisymmetry Stress-strain r z

APPLICATION MODE  x1x2  x2x3  x1x3

Plane Stress and Plane Strain  xy  yz  xz

Solid  xy  yz  xz

Axisymmetry Stress-strain  r z  rz

ϕ

Eϕ

ϕ ϕ
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and the parameter Gij is defined for these combinations:

Note: You can change the default names for the space coordinates in the same way as 
you can the names of the dependent variables.

Now examine the various material properties in Table 7-1.

Young’s modulus   It defines a material’s modulus of elasticity, E. For an isotropic 
material it is the spring stiffness in Hooke’s law, which in 1D form is

where σ is the stress and ε is the strain. An orthotropic material uses one value of 
Young’s modulus for each direction, Ei as defined on page 166.

Poisson’s ratio   Denoted by ν, it defines the normal strain in the perpendicular 
direction, generated from a normal strain in the other direction and follows the 
equation

.

An orthotropic material defines three values of νij.

Note: νij is defined differently depending on the application field, so review page 166 
for the definition within COMSOL Multiphysics. It is easy to transform among 
definitions, but you must check which one your material uses.

Shear Modulus   Denoted by Gij, it defines the relationship between engineering shear 
strain and shear stress. It is applicable only to an orthotropic material and follows the 
equation

APPLICATION MODE  x1x2  x2x3  x1x3

Plane Stress and Plane Strain  xy

Solid  xy  yz  xz

Axisymmetry Stress-strain  rz

σ Eε=

ε⊥ υεl l–=
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.

Density   This entry specifies ρ, the material’s density. 

Thermal expansion coefficient    It defines how much a material expands due to an 
increase in temperature following the equation

where εth is the thermal strain, and α is the thermal expansion coefficient. With it you 
model thermal strain for an isotropic material. For an orthotropic material, three values 
of αi are defined for the three perpendicular directions.

Thickness (th)   This property defines the out of plane thickness of the geometry for the 
Plane Stress and Plane Strain application modes.

Elasticity matrix   It defines the elasticity matrix, D, for anisotropic materials (see page 
167 for details). For the Plane Stress and Plane Strain application modes D is defined 
as a 4-by-4 matrix, since the out of plane shear stress and shear strain components are 
zero.

Thermal expansion vector   It defines the thermal expansion vector, αvec, for 
anisotropic materials (see page 178 for details).

Yield stress level (σys)   This parameter gives the stress level where plastic deformation 
starts. In the theory section this parameter is named Y0.

Yield function (σfunc)   This function detects if plasticity has occurred. In the theory 
section this parameter is named . 

Isotropic tangent modulus   This parameter is the tangent modulus used for isotropic 
hardening. This parameter together with σys defines the f2 function from the theory 
section as

εij
τij
Gij
--------=

εth α T Tref–( )=

φ

f2 εpe( ) σys
ETiso

1
ETiso

E
--------------–

------------------------εpe+=
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Kinematic tangent modulus   This parameter is the tangent modulus used for kinematic 
hardening. This parameter is used to calculate the σshift parameter from the theory 
section as

Hardening function (σyhard)   This hardening function applies to isotropic hardening. 
This parameter together with σys defines the f2 function from the theory section as 

This definition implies that you have to subtract the yields stress level (σys) when 
defining your hardening function.

Mooney-Rivlin material parameters   Hyperelastic material model parameters.

Initial shear modulus   Used for Neo-Hookean hyperelastic material model.

Initial bulk modulus   Used for Neo-Hookean and Mooney-Rivlin hyperelastic material 
models.

Constraints

A constraint specifies the displacement of certain parts of a structure. You can define 
constraints on all domain levels: points, edges, faces/boundaries, and subdomains in 
3D; points, boundaries, and subdomains in 2D. To control a constraint, go to the 
Constraint page that appears in the following dialog boxes that you find in the Physics 
menu: Physics>Subdomain Settings, Physics>Boundary Settings, Physics>Edge Settings, 
and Physics>Point Settings. The following figure shows the Boundary Settings dialog 

σshift
ETkin

1
ETkin

E
---------------–

------------------------- 2
3
--- εp⋅ ⋅=

f2 εpe( ) σys σyhard εpe( )+=
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box for the Solid, Stress-Strain application mode, but the Constraints settings area has 
the same appearance in all structural mechanics continuum application modes.

An example of a typical Constraint page, taken here from the Solid, Stress-Strain 
application mode Boundary Settings dialog box.

Within the dialog box the Constraint condition list lets you control what type of 
constraint you want to define. You can choose from the following options:

CONSTRAINT CONDITION BOUNDARY SUBDOMAIN USE WHEN

Free √ √ The domain has no constraint

Fixed √ √ The displacement in the domain is fixed
in all directions

Roller √ The normal displacement is constrained

Prescribed displacement √ √ The displacement in any direction need 
to be prescribed

Symmetry plane √ The boundary is a symmetry plane

x-y symmetry plane √ The selected coordinate system’s xy-
plane is a symmetry plane

y-z symmetry plane √ The selected coordinate system’s yz-
plane is a symmetry plane

x-z symmetry plane √ The selected coordinate system’s xz-
plane is a symmetry plane

Antisymmetry plane √ The boundary is an antisymmetry plane

x-y antisymmetry plane √ The selected coordinate system’s xy-
plane is an antisymmetry plane
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The symmetry or antisymmetry condition has the following interpretation.

The Coordinate system list lets you control in which coordinate system you want the 
constraint defined. Available options are:

• Global coordinate system

• Tangent and normal coordinate system (available only on boundaries)

• User-defined coordinate systems if any local coordinate systems are defined.

y-z antisymmetry plane √ The selected coordinate system’s yz-
plane is an antisymmetry plane

x-z antisymmetry plane √ The selected coordinate system’s xz-
plane is an antisymmetry plane

Prescribed velocity √ √ The velocity in any direction need to be
prescribed, only available for frequency 
response analysis

Prescribed acceleration √ √ The acceleration in any direction need 
to be prescribed, only available for 
frequency response analysis

CONSTRAINT CONDITION BOUNDARY SUBDOMAIN USE WHEN

CONDITION X-DISPLACEMENT Y-DISPLACEMENT Z-DISPLACEMENT

x-y symmetry plane √

y-z symmetry plane √

x-z symmetry plane √

x-y antisymmetry plane √ √

y-z antisymmetry plane √ √

x-z antisymmetry plane √ √
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When you select Prescribed displacement a number of new options appears in the dialog 
box, and the Constraint page takes on this appearance:

The Constraint page showing the Prescribed displacement options.

You can prescribe a constraint in two ways:

• In standard notation (select this option by clicking the Standard notation button), 
you constrain each displacement direction independently. The check boxes adjacent 
to the Rx, Ry, and Rz edit fields activate the constraint, whereupon you enter the 
value/expression of the displacement (the default value is 0).

• In general notation (select this option by clicking the General notation, Hu=R button) 
lets you specify constraints as any linear combination of displacements components. 
For instance, in the 2D case, use the relationship

.

Enter values for the H matrix and R vector in corresponding dialog boxes by 
clicking the corresponding Edit buttons. For example, to achieve the condition u = 
v, use the settings

H u
v

R=
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,

which force the domain to move only diagonally in the xy-plane.

The H Matrix dialog box for the example in the text.

In a frequency response analysis you have the possibility to specify not only a harmonic 
displacement but also a harmonic velocity or acceleration. You specify a prescribed 
velocity or acceleration in the same way as Prescribed displacement using Standard 

notation by first selecting Prescribed velocity or Prescribed acceleration in the Constraint 

condition list.

Constraint page showing the Prescribed acceleration settings.

Loads

“Load” is a general term for a force applied to a structure. In the Structural Mechanics 
Module you can specify loads on all domain types using the Load page that appears in 
the following dialog boxes that you find on the Physics menu: Subdomain Settings, 
Boundary Settings, Edge Settings, and Point Settings.

H 1 1–

0 0
,= R 0

0
=
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The Boundary Settings dialog box for the Plane Strain application mode shown here is 
representative of load pages for all domain levels in all structural mechanics application 
modes.

The loads on all levels except the point level are given as distributed loads using a force 
density such as; force/length, force/area, or force/volume. 

For boundaries you have the option to specify between different types of loads using 
the Type of load list. You select between distributed load and follower load (distributed 
load is the default setting).

F O L L O W E R  L O A D S

Follower loads are loads that depend on the deformation. The most common case is a 
pressure directed along the negative normal direction to a surface that deforms. In the 
following, follower loads imply such a load. Follower loads are only available on 
boundaries.

All loads must be applied in the undeformed reference frame; the software then 
computes the follower load using a frame that deforms with the structure. Both the 
direction and the size of the load change as the structure deforms. The Create frame 
application mode property is automatically set to On as soon as you specify a follower 
force.

Follower loads are only meaningful in a large deformation analysis. The Large 
deformation application mode property is automatically set to On as soon as you specify 
a follower force.
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You select Follower load from the Type of load list on the Load page. You specify the 
pressure in the P edit field.

The Boundary Settings dialog box for the Plane Strain application mode showing the 
follower load setting.

D I S T R I B U T E D  L O A D S

Distributed load is the default setting on boundaries. On all other levels a distributed 
load is the only way to specify a load. For boundaries you select between distributed 
loads and follower loads using the Type of load list.

For plane stress and plane strain, two option buttons allow you to choose how to 
specify the load using the thickness. The following table shows how to define the loads 
on different domains in different application modes; the entries give the SI unit in 
parenthesis.

Within the dialog box, the Coordinate system list lets you control in which coordinate 
system you want to define the load. Available options are:

• Global coordinate system

APPLICATION MODE POINT EDGE BOUNDARY SUBDOMA

Plane Stress, 
Plane Strain

force (N) force/area (N/m2) or 
force/length (N/m)

force/volu
or force/a

Axisymmetry, 
Stress-Strain

total force along the 
circumferential (N)

force/area (N/m2) force/volu

Solid, Stress-
Strain

force (N) force/length 
(N/m)

force/area (N/m2) force/volu
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• Tangent and normal coordinate system (available only on boundaries)

• User-defined coordinate systems, if any local coordinate systems are defined

For a frequency response analysis you have additional input data. To control the 
analysis type, use the Application Mode Properties dialog box. When frequency response 
is the analysis type, the Load page takes on this appearance:

The Load page that appears for frequency response analysis.

For frequency response analysis, the application mode splits the harmonic load into 
two parameters:

• The amplitude, F

• The phase (FPh)

Together they define a harmonic load whose amplitude and phase shift can vary with 
the excitation frequency, f

.

For subdomains, you have additional options to control if and how the analysis should 
include thermal strains (explained in the following section).

Thermal Coupling

Material expands with temperature, causing thermal strains to develop in the material. 
The thermal strains, taken together with the initial strains and elastic strains from 
structural loads, form the total strain

Ffreq F f( ) 2πf FPh f( )+( )cos⋅=
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where 

.

Thermal coupling means that the analysis includes thermal expansion. Details on 
thermal coupling appear on page 178. You specify thermal effects on the Load page in 
the dialog box that appears when you choose Physics>Subdomain Settings.

You specify thermal effects on the Load page.

The Include thermal expansion check box instructs the model to add thermal effects. 
Specify the strain temperature, T, and reference temperature, Tref, in the Temp and 
Tempref edit fields, but you specify the thermal expansion coefficient on the Material 
page (see page 193). T and Tref can be any expression and are typically another 
dependent variable for temperature solved for in a COMSOL Multiphysics heat 
transfer application mode. Any type of analysis can use this temperature coupling.

Note: Special approach is required if the structural analysis is performed in the 
frequency domain. This includes the following analysis types: Frequency response, 
Eigenfrequency, and Damped eigenfrequency. The coupled displacement-temperature 
field presents thermoelastic oscillations of small amplitude, which are initialized to 

ε εel εth ε0+ +=

εth α T Tref–( )=
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zero. You need to set the strain reference temperature Tempref to zero, and use a 
special form of the heat balance equation. For more details, see the example “Heat 
Generation in a Vibrating Structure” on page 703 of the Structural Mechanics 
Module Model Library.

Damping

In transient and frequency response analyses you have the possibility to model 
undamped or damped problems. In the Structural Mechanics Module you can specify 
damping on the subdomain level using the Damping page that appears in the Subdomain 

Settings dialog box. From the Damping models list you can select No damping, Rayleigh, 
or Loss factor, and the contents of the dialog box changes for each of these damping 
models.

Damping page when Rayleigh damping is selected.

Note: Loss factor damping is valid only for frequency response analysis. If you choose 
transient analysis and loss factor damping, COMSOL Multiphysics solves the model 
with no damping.
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Table 7-2 and the subsequent text describe the parameters that define damping:

Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

Loss factor   Defines the loss factor η for the loss factor damping model.

Initial Stress and Strain

An analysis can include initial stress and strain, which is the stress/strain state in the 
structure before the model applies any constraint or load. Initial strain can, for 
instance, describe moisture-induced swelling, and initial stress can describe stresses 
from heating. In fact, you can think of initial stress and strain as different ways to 
express the same thing. To specify them, go to the Initial Stress and Strain page in the 
Physics>Subdomain Settings dialog box.

Dialog box for setting up initial stress and strain.

TABLE 7-2:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

αdM alphadM Mass-damping parameter Rayleigh

βdK betadK Stiffness-damping parameter Rayleigh

η eta Loss factor Loss factor
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You control the option to include initial stress and strain independently using like-
named two check boxes.

In the following table, the index l for parameter σ0l/sli and ε0l/eli refers to the 
space coordinates xl.

The index l runs over the following coordinate names for the different application 
modes.

Example: σ0l for axial symmetry stress-strain means σ0r, , and σ0z.

The parameters σ0lk/slki and ε0lk/elki in the first table refer to the space 
coordinates xlxk and are defined for the following combinations of l and k for the 
different application modes:

Perfectly Matched Layers (PMLs)

In frequency response analysis of elastic waves, you can use perfectly matched layers to 
simulate absorbing boundaries. A PML is strictly speaking not a boundary condition 
but an additional domain that absorbs the incident radiation without producing 
reflections. It provides good performance for a wide range of incidence angles and is 
not particularly sensitive to the shape of the wave fronts. The PML formulation 
introduces a complex-valued coordinate transformation under the additional 

PARAMETER VARIABLE DESCRIPTION

σ0l sli Initial normal stress

τ0lk slki Initial shear stress

ε0l eli Initial normal strain

ε0lk elki Initial shear strain

APPLICATION MODE   x1   x2   x3 

Plane Stress and Plane Strain  x  y  z

Solid, Stress-Strain  x  y  z

Axial Symmetry, Stress-Strain  r  z

APPLICATION MODE  x1x2  x2x3  x1x3 

Plane Stress and Plane Strain xy

Solid, Stress-Strain xy yz xz

Axial Symmetry, Stress-Strain rz

ϕ

σ0ϕ
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requirement that the wave impedance should not be affected. The following sections 
describe how to create Cartesian, cylindrical, and spherical PMLs for elastic waves.

For an account of elastic waves in solids, see Chapters 4 and 5 of Ref. 1. For 
background information about PMLs in elastodynamics, see Ref. 2.

P M L  I M P L E M E N T A T I O N

For a PML that absorbs waves in the coordinate direction ξ, the Structural Mechanics 
Module uses the following coordinate transformation inside the PML:

 (7-22)

The scaled PML width, L; the coordinate of the inner PML boundary, ξ0; and the 
(actual) width of the PML, δξ, are input parameters for each orthogonal absorbing 
coordinate direction.

The scaling exponent, n is an input parameter for each PML subdomain. The default 
value of n is 1, giving a linear scaling that works well in most cases, and the useful range 
is roughly between 1 and 2; increasing the exponent allows you to use fewer mesh 
elements to resolve wavelengths much smaller than the scaled PML width.

Usually, set L equal to one wavelength. The wavelength depends on the type of elastic 
wave you are considering. For example, for longitudinal (acoustic) waves, the 
wavelength is given by (Ref. 1)

where f is the frequency, E is Young’s modulus, ν is Poisson’s ratio and ρ is the density. 
If your analysis includes several wave types of different wavelengths, set L to the 
longest one. For this case, you can also try to set the scaling exponent, n, equal to 2.

The parameters ξ0 and δξ get default settings that the software deduces from the drawn 
geometry and stores in so-called guess variables. You can inspect the values of the guess 
variables on the Variables page of the Subdomain Settings - Equation System dialog box 
or at the corresponding node of the Model Tree.

The default settings defined by the guess variables work nicely in most cases, but they 
might fail for PML subdomains of nonstandard shape. Examples of geometries that 
work nicely are shown in the following figures for each of the available PML types:

• Cartesian—PMLs absorbing in Cartesian coordinate directions.

ξ' sign ξ ξ0–( ) ξ ξ0–
n L

δξn
--------- 1 i–( )=

λ 1
f
--- 1 ν–( )

1 ν+( ) 1 2ν–( )
---------------------------------------E

ρ
----=
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• Cylindrical—PMLs absorbing in cylindrical coordinate directions from a specified 
axis. For axisymmetric geometries the cylinder axis is the z-axis.

• Spherical—PMLs absorbing in the radial direction from a specified center point.

For each of the above PML types, you can choose the coordinate directions in which 
the PML absorbs waves, that is, for which directions a coordinate transformation of 
the type Equation 7-22 applies. To allow complete flexibility in defining a PML 
there is, in addition, a fourth option:

• User defined—General PMLs or domain scaling with user-defined coordinate 
transformations.

Figure 7-1: A cube surrounded by typical PML regions of the type “Cartesian.”
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Figure 7-2: A cylinder surrounded by typical cylindrical PML regions.

Figure 7-3: A sphere surrounded by a typical spherical PML region.
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S E T T I N G  U P  A  P M L

To model an absorbing boundary using PMLs, you need an auxiliary subdomain 
outside the boundary. On the PML page in the Subdomain Settings dialog box, you can 
select different types of PMLs depending on what kind of wave you have:

The PML type None is default. To add a PML, select one of the other types.

Cartesian PMLs
When choosing the Cartesian PML type you can use a user-defined coordinate system 
to define the directions. If you want a curved coordinate system you must use the 
cylindrical or spherical PML type.

Select the check box for the directions in which you want the waves to be absorbed. 
For each of these directions, enter the scaled PML width, L in the associated edit field. 
Make sure all material properties are the same in the PML as in the adjacent 
subdomain.

Cylindrical PMLs
In 2D, a cylindrical PML always absorbs waves in the radial direction. In the other 
dimensions, you can decide how the PML absorbs the wave: in the radial direction, the 
z direction, or both.

Select the directions in which you want the PML to absorb the waves and enter the 
scaled PML widths in those directions. To define a cylindrical PML you also need to 
enter the center point of the cylindrical coordinates and, in 3D, the cylinder axis 
direction.

Spherical PMLs
A spherical PML always absorbs waves in the radial direction. Enter the scaled PML 
width, L. Define the spherical coordinates by entering the center point.

PML TYPE APPLICATION MODE DESCRIPTION

None all No PML

Cartesian Solid, Stress-Strain; Plane 
Stress; and Plane Strain

Absorbs waves in the 
specified Cartesian 
coordinate directions

Cylindrical all Absorbs cylindrical waves

Spherical Solid, Stress-Strain; Axial 
Symmetry, Stress-Strain

Absorbs spherical waves

User defined all Define your own scaled 
space variables
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User-Defined PMLs
When using a PML, the algorithm scales the equation in this domain so that instead 
of the coordinates used in the rest of the model, the coordinates PMLx, PMLy, and 
PMLz appear in the equation. If you want to scale the equation in some other way than 
the automatic PML options provide, use a user-defined PML. In this case you enter 
your own User-defined PML coordinates.

R E F E R E N C E S

1. L.M. Brekhovskikh and V. Goncharov, Mechanics of Continua and Wave 
Dynamics, 2nd ed., Springer-Verlag, 1994.

2. W.C. Chew and Q.H. Liu, “Perfectly Matched Layers for Elastodynamics: A New 
Absorbing Boundary Condition,” J. Comp. Acoustics, vol. 4, pp. 341–359, 1996.

Contact Modeling

You can model contact between two boundaries. The boundaries need to be 
connected to a subdomain active in the same application mode. To be able to model 
contact you need the following:

• An application mode modeling the deformation that supports contact modeling: 
The Plane Strain; Plane Stress; Axial Symmetry, Stress-Strain; or the Solid Stress-
Strain application mode.

• A deformed frame controlled by the application mode. This is done by setting the 
application mode property Create frame to On. The program does this automatically 
when you add a contact pair.

• Use of assembly mode, if the parts are in contact initially. In this case select Use 

Assembly from the Draw menu. Read more about assemblies in the section “Using 
Assemblies” on page 351 in the COMSOL Multiphysics Modeling Guide.

• A contact pair. A contact pair consists of a number of slave and master boundaries. 
The slave is constrained not to penetrate the master boundary. You can create 
contact pairs from the Contact Pairs dialog box, which you open from the Physics 
menu. A description of how to create contact pairs appears later in this section. 
Additionally, if some parts of the boundaries are in initial contact, you can use the 
Create Pairs dialog box to automatically detect and define contact pairs. For more 
information about the Create Pairs dialog box, see the section “Creating Pairs” on 
page 353 in the COMSOL Multiphysics Modeling Guide.

• Contact parameters, specified to suit your model. You can inspect and change the 
contact parameters in the Boundary Settings dialog box by selecting the appropriate 
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contact pair on the Pair page. There are three different pages, described further on 
in this section, to do this on:

-  Contact

-  Contact, Initial

-  Contact, Advanced

• Solver parameters, specified to suit your model. You can set the parameters for the 
augmented and nonlinear solvers in the Solver Settings dialog box, which is 
described in the section “Nonlinear Solver Settings” on page 368 in the COMSOL 
Multiphysics User’s Guide. You can find recommendations for solver settings 
specifically for contact models on page 129 of this book.

Note: The current version supports contact in the continuum application modes: 
Plane Stress; Plane Strain; Axial Symmetry, Stress-Strain; and Solid, Stress-Strain.

Note: You cannot use contact pairs together with the transient solver. Use the 
parametric solver with the time t as the parameter to solve contact problems with 
friction.

This section provides information about how to set up contact pairs and specify contact 
parameters. You can read about the theory behind the implementation of the contact 
modeling method on page 186 and about tips for creating a contact model on page 
118.

For general information about modeling with pairs, see the section “Specifying Physics 
Settings on Pairs” on page 361 in the COMSOL Multiphysics Modeling Guide.
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T H E  C O N T A C T  P A I R S  D I A L O G  B O X

To define contact pairs, choose Physics>Contact Pairs. This opens the Contact Pairs 
dialog box.

Boundaries Page
Each pair has a name. The application modes use this name to refer to the pair. The 
name must be unique.

The two boundary lists show the master and slave domains of the pair selected in the 
list to the left. The check boxes beside the domain numbers indicate which domains 
belong to the master and the slave, respectively.

Clicking the Check Selected buttons below the lists selects the check boxes of the 
boundaries highlighted in the list. This is equivalent to selecting the individual check 
boxes and is a quick way to select multiple check boxes. Clicking the Clear Selected 

button similarly clears the check boxes of the selected domains.

Use the buttons Select Master and Select Slave to select the master and slave domains 
in the main window and in the selection lists.

Clicking the arrow button between the selection lists interchanges the master and slave 
domains. 

For best results you should consider the guidelines on page 118 when selecting your 
master and slave boundaries.
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Advanced Page
On the Advanced page in the Contact Pairs dialog box you can define the names of the 
contact pair’s coupling operators.

When creating a contact pair COMSOL Multiphysics automatically defines the 
operators and gives them a name. The names have to be unique within the whole 
model. The application modes use the operators to set up the contact condition 
preventing the slave from penetrating the master.

A map operator evaluates its argument on one side of the pair and makes the result 
available on the other side. In the previous figure you can see two operators: 
mst2slv_cp2, mapping from the master of the pair to the slave, and slv2mst_cp2, 
mapping in the other direction. For example, if u is a variable on the master side you 
can use the expression mst2dst_cp2(u) on the slave side.

The application modes create a number of variables on the boundaries of the contact 
pair. To make the variable names unique the software adds a suffix to them. You can 
edit the suffix name in the Suffix for contact variables edit field. A special variable is the 
contact variable stating if the boundaries are in contact or not, which you can use in 
logical expressions. The expression if(contact_cp1,1,2) on the slave side evaluates 
to 1 for points where the boundaries are in contact and to 2 in the other points. You 
can edit the name of the contact variable in the Contact variable determining contact 
edit field.

B O U N D A R Y  S E T T I N G S  D I A L O G  B O X

The Boundary Settings dialog box, which you can open from the Physics menu, has 
three pages dedicated for contact settings: the Contact; Contact, Initial; and Contact, 

Advanced pages. In the following you can find a description of these.
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Contact Page
You specify the most important settings for your contact problem on the Contact page.

The Contact page for the Plane Stress application mode.

The Active pair check box lets you select if you want to use the contact pair in this 
application mode or not. If you want to model friction between the contact pairs, select 
Coulomb from the Friction model list.

The following table specifies the contact pair parameters on the Contact page:

PARAMETER DESCRIPTION SI UNIT NO FRICTION COULOMB

offset An optional offset specifying 
at what distance from the 
geometrical boundary 
contact appears, positive in 
the normal direction

m √ √

pn The normal penalty factor Pa/m √ √

pt The tangential penalty 
factor

Pa/m √

µstat Static friction coefficient - √

cohe Cohesion sliding resistance, 
the friction force at zero 
contact pressure

Pa √

Ttmax The maximum tangential 
traction

Pa √
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The convergence is sensitive to the value of the penalty factors. Their value should be 
of the same order as the stiffness of the boundary divided by a typical length scale, that 
is, the mesh size. The default value for both the normal and tangential penalty factors 
is set according to

 (7-23)

The Young’s modulus is denoted E and the smallest mesh size on the slave boundary, 
hmin, is included in order to get a typical length scale. The auglagiter variable is the 
iteration number in the augmented Lagrange solver. It is used to make the penalty 
parameter soft at the beginning (to help the solver get started) and to gradually make 
it stiffer (to speed up convergence).

The default values, using Young’s modulus only work for linear isotropic materials, for 
which the Young’s modulus is defined. For other types of materials you need to 
substitute E with a suitable value or define it as a constant or expression variable. Read 
more about selecting the penalty factor on page 119.

If you select the Exponential dynamic friction model check box you get a friction 
coefficient that varies between the static and dynamic friction coefficient depending on 
the slip velocity and the dcfric decay coefficient in the following way.

 (7-24)

µdyn Dynamic friction coefficient, 
only used with the dynamic 
friction option

- √

dcfric Decay coefficient, only used 
with the dynamic friction 
option

s/m √

PARAMETER DESCRIPTION SI UNIT NO FRICTION COULOMB

p E
hmin
------------ min 10 3– 5auglagiter⋅ 1( , )⋅=

µdyn µstat µdyn–( )e dcfric vs–
+
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Contact, Initial Page
You specify the initial conditions for your contact problem on the Contact, Initial page.

The Contact, Initial page for the Plane Strain application mode.

The following table specifies the contact pair parameters on the Contact, Initial page:

Turn to page 120 to read about how the initial contact pressure can influence your 
contact model.

PARAMETER DESCRIPTION SI UNIT NO FRICTION COULOMB

Tn The initial value for the 
contact pressure.

Pa √ √

contactold The initial value for the 
contact variable in the 
previous step.

√

Ttxi The initial value for the 
friction force components.

Pa √

ximold The initial value for the 
coordinates of the master 
point in the previous step.

m √
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Contact, Advanced Page
You have the option to specify more advanced contact pair settings on the Contact, 

Advanced page.

The Contact, Advanced page for the Plane Strain application mode.

You specify what search method to use in the Search method list. The default option is 
Fast. Under some rare circumstances this method can fail to detect contact and find the 
corresponding master points. Then select the more robust but slower option Direct 
instead.

You have two options to calculate the contact tolerance: Automatic or Manual. That is, 
at what distance between the two bodies they are regarded as being in contact (used 
for friction and multiphysics contact). You select this from the Contact tolerance list. 
Automatic means that the software calculates the tolerance from the size of the 
bounding box of the total geometry. Manual means that you specify the value yourself 
in the mantol edit field.

In a similar way as for the contact tolerance you have the option to specify the Search 

distance. The search distance sets the radius from any slave point within which the 
program looks for possible contact between the slave and master boundary. A shorter 
distance speeds up the search algorithm because the vast majority of boundary 
elements can quickly be excluded from the search process. But a too small value might 
result in missed contact detection.

The Automatic setting means that the program calculates the search distance from the 
size of the bounding box of the total geometry. If the total size of the geometry is not 
representative for the size of the contact areas, you can use the Manual setting and 
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specify the value yourself in the mandist edit field. A suitable search radius is usually on 
the order of the largest mesh elements involved in the contact process.
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 8
M i n d l i n  P l a t e s
A plate is a thin planar structure, its thickness as a rule being less than one tenth 
of its width. In contrast to the plane stress and plane strain 2D cases, the forces are 
either applied in the direction normal to the plate, or as moments about directions 
 227
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in the plane where the plate lies. The main deformation takes place in the out-of-plane 
direction. There are two main groups of plates:

• Thin plates

• Thick plates

In thin plate theory the transverse shear deformation is neglected, in the same way as 
Euler beams neglect shear deformations. 

In thick plate theory the transverse shear deformation is included. The Mindlin plate 
is based on the following engineering assumption: a plane originally perpendicular to 
the mid surface remains plane after loading, but not necessarily perpendicular to the 
deformed mid surface. The change in angle accounts for the transverse shear 
deformation.

The element in this application mode is a discrete Reissner-Mindlin triangle. This 
element has six nodes and a total of twelve degrees of freedom. These are the two 
rotations and one transversal displacement at each corner node and the normal 
rotations at the triangle midsides; see O. C. Zienkiewicz (Ref. 1) for details.

Variables and Space Dimensions

The dependent variables are the global displacement w in the z direction and the 
rotations θx and θy around the global x- and y-axes.

Reference

1. O. C. Zienkiewicz: “Plate bending elements with discrete constraints: new 
triangular elements,” Computer & Structures, vol. 35, no. 4, 1990.
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Th eo r y  Ba c k g r ound

Shape Function

The degrees of freedom are defined by a shape function object shdrm. The degree of 
freedom names and variable names are constructed from the input arguments.

shdrm('w','thx','thy')

The shdrm shape function object defines the following dependent variables, derivatives 
of dependent variables and shear strain components.

The shape functions are of order 1 for the out-of-plane displacements, partly order 2 
for rotations (rotations about triangle sides vary linearly), and partly order 1 for shears 
(shear components along triangle sides are constant). See shdrm on page 160 in the 
Structural Mechanics Module Reference Guide for details.

VARIABLE NAME DOF DESCRIPTION

w w w Global displacement in z direction

θx thx thx Rotation about global x-axis

θy thy thy Rotation about global y-axis

thn thn Midside rotation about axis perpendicular 
to side (with a direction convention)

thxx x derivative of rotation about global x-axis

thxy y derivative of rotation about global x-axis

thyy y derivative of rotation about global y-axis

thyx x derivative of rotation about global y-axis

γxz gxz Shear strain component

γyz gyz Shear strain component

∂θx
∂x
---------

∂θx

∂y
---------

∂θy

∂y
---------

∂θy

∂x
---------
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In-Plane Strain-Displacement/Rotation Relation

The in-plane strain components depends on the rotation derivatives defined by the 
shdrm shape function and the z coordinate in the plate.

The total strain ε consists of thermal (εth), initial (εi), and elastic strains(εel)

Transverse Strain Components

The average transverse shear components is defined directly by the shdrm shape 
function. 

In-Plane Stress-Strain Relation

The in-plane stress components in the plate are described by the symmetric stress 
tensor

consisting of 2 normal stresses (σx and σy) and two or, if the symmetry is used, one 
shear stress τxy. The stress-strain relation for linear conditions including initial stress 
and strain and thermal effects reads:

 (8-1)

where Dp is the 3-by-3 elasticity matrix in plane stress form. The stress and strain 
components are described on vector form with the three stress and strain components 
in column vectors defined as

ε
εx

εy

γxy

z

∂θy

∂x
---------

∂θx

∂y
---------–

∂θy
∂y
---------

∂θx
∂x
---------–⎝ ⎠

⎛ ⎞

zΘ= = =

ε εel εth εi+ +=

σ
σx τxy

τyx σy

= τxy τyx=

σ Dpεel σi+ Dp ε εth– εi–( ) σi+= =
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Note: In the following descriptions the compact notation σ and ε will be used 
meaning either the stress/strain vector or tensor depending on the situation.

The in-plane elasticity matrix Dp and the more basic matrix, the flexibility or 
compliance matrix Dp

−1 (the inverse of Dp), are defined differently for isotropic, 
orthotropic, and anisotropic materials. For isotropic material the Dp

−1 matrix looks 
like

where E is the modulus of elasticity or Young’s modulus and ν is Poisson’s ratio, 
defining the contraction in the perpendicular direction. Inverting Dp

−1 symbolically 
results in

where E is Young’s modulus and ν is Poisson’s ratio. For an orthotropic material the 
Dp

−1 matrix looks like.

σ
σx

σy

τxy

= ε
εx

εy

γxy

=

Dp
1– 1

E
----

1 ν– 0
ν– 1 0

0 0 2 1 ν+( )

=

Dp
E

1 ν2
–

---------------

1 ν 0
ν 1 0

0 0 1 ν–
2

------------

=

Dp
1–

1
Ex
------

νyx

Ey
--------– 0

νxy

Ex
--------–

1
Ey
------ 0

0 0 1
Gxy
---------

=
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The Dp
−1 matrix is symmetric so the material is defined using the coefficients on the 

lower-diagonal part of the matrix. It is important that the material data has been 
derived using the same definition of ν as above; if not, the material data need to be 
transformed.

Note: νij is defined in different ways depending on the application field. It is easy to 
transform between the different definitions but you need to check what definition 
your material uses.

Inverting the Dp
−1 matrix symbolically using only the Ex, Ey, νxy, and Gxy coefficients 

results in the following symmetric Dp matrix.

where the components are as follows 

 

where 

For an anisotropic material the symmetric Dp matrix is given explicitly.

Note: For an anisotropic material the Dp matrix should be given in plane stress form, 
using the equation σz = 0 to eliminate εz. If material data is given in full 3D form they 
need to be transformed to plane stress form using the σz=0 condition.

Dp

Dp11 Dp12 0

Dp12 Dp22 0

0 0 Dp33

=

Dp11
Ex

2

Ddenom
--------------------= Dp12

ExEyνxy

Ddenom
----------------------=

Dp22
ExEy

Ddenom
--------------------= Dp33 Gxy=

Ddenom Ex Ey– νxy
2

=
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Transverse Stress-Strain Relation

The average shear strain γm is defined as

where:

• G is the shear modulus

• Q is the plate shear force/length

• th is the thickness of the plate

• Sf is the shear factor

The shear factor is defined so that the average strain and the real strain should result in 
equal virtual work through the thickness.

Assuming a parabolic stress and strain distribution through the plate results in Sf = 1.2, 
this holds for homogeneous plates.

For the general case the relation looks like

Where Ds looks as follows for the different material models:

• Isotropic

• Orthotropic

γm
Q

G th
Sf
------⋅

---------------=

γτ zd
th
∫ th Q⋅ γm=

Qy

Qx

th D⋅ s
γyzm

γxzm

=

Ds

E
2 1 ν+( )Sf
--------------------------- 0

0 E
2 1 ν+( )Sf
---------------------------

=
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• Anisotropic: The full elasticity matrix including shear factors Ds is given explicitly.

Thermal Strain

The thermal strain is only included for the in-plane strain components. The 
temperature is assumed to vary linearly through the thickness.

The plate can only handle the temperature difference through the plate, ∆T. The 
thermal strain as a function of the z-coordinate and the temperature gradient is

 (8-2)

Depending on the material model, αvec is set up differently:

• Isotropic

• Orthotropic

• Anisotropic: The full thermal expansion vector is given as input.

Ds

Gyz
Sfyz
----------- 0

0
Gxz
Sfxz
-----------

=

T T0 ∆T z
th
------+=

εth

εx

εy

γxy th

αvec∆T z
th
-----= =

αvec

α
α
0

=

αvec

αx

αy

0

=
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Initial Load and Strain

I N - P L A N E  M O M E N T S  A N D  C U R V A T U R E

The initial stress means the stress before any loads, displacements, and initial strains 
have been applied.

The initial stress distribution is given as initial plate moments.

The initial strain is the strain before any loads, displacements, and initial stresses have 
been applied.

The initial strain distribution is given as initial curvature and warping.

I N I T I A L  S H E A R  F O R C E S  A N D  T R A N S V E R S A L  S T R A I N S

The out-of-plane initial shear stress is given as shear forces.

The initial shear strain is given as average shear strains γyzi and γxzi.

Implementation

The implementation is based on the principle of virtual work. The principle of virtual 
work states that the virtual work from any variation in internal strain and external loads 

σi

σxi

σyi

τxyi

=

Mxpi σxiz zd
th
∫= Mypi σyiz zd

th
∫= Mxypi τxyiz zd

th
∫=

εi

εxi

εyi

2εxyi

zΘi= =

εxi zθyxi= εxi z– θxyi= εxyi
z
2
--- θyyi θxxi–( ) z

2
---θyymxxi= =

Qyi τyzi zd
th
∫= Qxi τxzi zd

th
∫=
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are zero. The in-plane part of the virtual work is expressed using the internal plate 
moments

The out-of-plane part is expressed using the internal shear forces:

The variation of the total stored energy W from external and internal strain and load is

If the material is described in a local user-defined coordinate system, the variational 
equation is expressed in local instead of global plate moments and shear forces. 

The rotational derivatives can be transformed as a tensor.

where Tcoord is the local to global coordinate system transformation matrix.

The local plate moments are then calculated from the local rotational derivatives.

Mp

Mxp

Myp

Mxyp

z Dp ε εth– εi–( ) σi+[ ] zd
th
∫

z2 Dp Θ
αvec∆T

th
--------------------– Θi–⎝ ⎠

⎛ ⎞ zd Mpi+

th
∫

th( )3

12
-------------- Dp Θ

αvec∆T
th

--------------------– Θi–⎝ ⎠
⎛ ⎞ Mpi+

= = =

=

Qp
Qyp

Qxp

zτ zd
th
∫ th D⋅ s

γyzm

γxzm

γyzi

γxzi

– Qpi+= = =

δW
∂θy

∂x
---------⎝ ⎠
⎛ ⎞

test
Mxp

∂θx

∂y
---------⎝ ⎠
⎛ ⎞

test
– Myp

∂θy
∂y
---------

∂θx
∂x
---------–⎝ ⎠

⎛ ⎞
test

Mxyp

2Qypγyztest 2Qxpγxztest wtestFzg θxtestMxg θytestMyg

+

+ + + + +

⎝

⎠

⎛

⎞ Ad

A
∫–=

θyx
1
2
--- θyy θxx–( )

1
2
--- θyy θxx–( ) θ– xy

l

Tcoord
T

θyx
1
2
--- θyy θxx–( )

1
2
--- θyy θxx–( ) θ– xy

Tcoord=
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The global plate moments are calculated by transforming the local plate moments.

The shear strains transforms as

The global shear forces are calculated by transforming the local shear forces.

Mp TcoordMplTcoord
T

=

γxz

γyz l

Tcoord
T γxz

γyz

=

Qxp

Qyp

Tcoord
Qxp

Qyp l

=
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App l i c a t i o n  Mode De s c r i p t i o n

This section describes how to define a Mindlin Plate model. It is divided into the 
following sections:

• Properties

• Scalar Variables

• Material

• Constraint

• Load

• Thermal Coupling

• Initial Stress and Strain

• Postprocessing

Properties

The Application Mode Properties dialog box is opened from the Physics menu.

In the Application Mode Properties dialog box you control different global settings for 
the model.

• Analysis type: A list of different analyses to perform. It affects both the equations and 
what solver to use through the Auto select solver option in the Solver Parameters 
dialog box. The available analysis types use the following solvers.

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER

Static Stationary

Eigenfrequency Eigenvalue

Time dependent (Transient) Time dependent

Frequency response Parametric
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• Weak constraints: Controls whether or not weak constraints are active. Use weak 
constraints for accurate reaction-force computation. When weak constraints are 
enabled, all constraints are weak by default, but it is possible to change this setting 
for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 301 in the COMSOL Multiphysics Modeling Guide).

Scalar Variables

There are two different scalar variables:

• Excitation frequency, freq, applicable only for frequency response analysis.

• Complex angular frequency, jomega, applicable only for eigenfrequency analysis. 
You normally do not need to edit the complex angular frequency. 

The Scalar Variables menu item on the Physics menu is enabled only when Frequency 

Response, Damped Eigenfrequency, or Eigenfrequency is selected as Analysis type in the 
Application Mode Properties dialog box.

The excitation frequency is the frequency of the harmonic loads in a frequency 
response analysis.

When frequency response is selected as analysis type, the default solver is the parametric 
solver making it easy to perform a frequency sweep over several excitation frequencies 
in a single analysis. In this case freq_smdrm is entered as the Parameter name on the 
Parametric page in the Solver Parameters dialog box and the values entered in the 
Parameter values edit field override the excitation frequency entered in the Application 

Scalar Variables dialog box.

Parametric Parametric

Quasi-static transient Time dependent

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER
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Material

The material properties are defined on the Material page in the Subdomain Settings 

dialog box.

The Material page has two lists:

• Material model: Select the type of material. Depending on the selection, different 
material properties are shown reflecting the chosen material model.

- Isotropic: The material has the same material properties in all directions. The 
Material page for an isotropic material is shown above.

- Orthotropic: The material has different material properties in different directions. 
The in-plane stiffness is defined from the material properties Ex, Ey, νxy, and Gxy; 
see page 230 for details. The out-of-plane shear stiffness is defined from the 
properties Gyz, Gxz, Sfyz, Sfxz; see page 233 for details. The thermal expansion is 
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defined from the αx and αy; see page 234 for details.The Material page for an 
orthotropic material is shown below.

- Anisotropic: The material has different material properties in different directions, 
and the stiffness is defined from the symmetric elasticity matrices Dp and Ds; see 
page 230 and page 233 for details. The thermal expansion is defined from the 
thermal expansion vector αvec; see page 234 for details. The Material page for an 
anisotropic material is shown below.
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IAL 

pic

pic

pic

pic

tropic 

tropic 
• The Elasticity matrix dialog boxes for entering of the Dp and Ds matrices 
components are shown below.

• The Thermal expansion vector dialog box for entering of the αvector is shown below.

• Coordinate system: Select the coordinate system where the material properties are 
defined. This is used for orthotropic and anisotropic materials defined in another 
coordinate system than the global or if postprocessing variables are needed in a local 
coordinate system. The Coordinate system list is disabled if no user-defined 
coordinate systems are available. The Coordinate System Settings dialog box is found 
on the Options menu. Read more about creation of coordinate systems and their use 
in “Coordinate Systems” on page 144.

The material properties for the union of all different material models are shown in the 
table below.

PARAMETER VARIABLE DESCRIPTION MATER
MODEL

 E E Young's modulus Isotro

 ν nu Poisson's ratio Isotro

 Sf Sf Shear factor Isotro

 ρ rho Density All

 th thickness Thickness All

 α alpha Thermal expansion coefficient Isotro

 Ex, Ey Ex, Ey Young's modulus in the x and y directions Ortho

 νxy nuxy Shear modulus for the xy-plane Ortho
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tropic 

tropic 

tropic

tropic

tropic

tropic

IAL 
Young’s modulus    Defines the modulus of elasticity, E, of the material. For an isotropic 
material, it is the spring stiffness in Hooke’s law, shown below in 1D form 

 

where σ is the stress and ε is the strain. Orthotropic material uses one value of Young’s 
modulus for each direction, Ei defined on page 230.

Poisson’s ratio   Denoted by ν, Poisson’s ration defines the normal strain in the 
perpendicular direction, generated from a normal strain in the other direction.

For orthotropic material νxy is defined, see page 230 for details.

Note: νij is defined in different ways depending on the application field (see page 230 
for details on the definition in the Structural Mechanics Module). It is easy to 
transform between the different definitions, but you need to check what definition 
your material uses.

Shear Factor   Denoted by Sf, affects the out-of-plane shear stiffness, for homogeneous 
material Sf = 1.2.

Shear Modulus   Denoted by Gij, defines the relation between engineering shear strain 
and shear stress, it is only used for orthotropic material.

 Gxy, Gyz, Gxz Gxy, Gyz, Gxz Poisson's ratio for the xy-, yz-, and xz-planes Ortho

 Sfyz, Sfxz Sfyz, Sfxz Shear factor for the yz- and xz-planes Ortho

 αx, αy alphax, 
alphay

Thermal expansion coefficient in the x and y 
directions

Ortho

 Dp In-plane elasticity matrix for the anisotropic case Aniso

 Ds Out-of-plane elasticity matrix for the anisotropic 
case

Aniso

 αvec Thermal expansion vector for the anisotropic 
case

Aniso

PARAMETER VARIABLE DESCRIPTION MATER
MODEL

σ Eε=

ε⊥ νεl l–=
A P P L I C A T I O N  M O D E  D E S C R I P T I O N  |  243



244 |  C H A P T E R
Density   This material property, ρ, specifies the density of the material. 

Thickness   Defines the thickness of the plate.

Thermal expansion coefficient    Defines how much a material expands due to an 
increase in temperature. 

where εth is the thermal strain, ∆T is the temperature difference through the plate, and 
α is the thermal expansion coefficient. It is used to model thermal strain for an 
isotropic material. For an orthotropic material two different thermal expansion 
coefficients, αi, are defined for the two perpendicular directions.

Shear Factor Orthotropic Material   Denoted by Sfyz and Sfxz, these individual shear 
factors for orthotropic materials affect the out-of-plane shear stiffness.

In-plane elasticity matrix   Defines the in-plane elasticity matrix Dp, used for 
anisotropic materials. See page 230 for details.

Out-of-plane elasticity matrix   Defines the out-of-plane elasticity matrix Ds, used for 
anisotropic materials. See page 233 for details.

Thermal expansion vector   Defines the thermal expansion vector αvec, used for 
anisotropic materials. See page 234 for details.

Constraint

A constraint specifies the out-of plane displacement and rotations of certain parts of a 
plate. Constraints can be defined on all domain levels such as points, boundaries, and 
subdomains. The constraint is controlled from the Constraint page in the Subdomain 

Settings, Boundary Settings, and Point Settings dialog boxes. Normally, you only apply 
constraints to boundaries.

γij
τij
Gij
--------=

εth α∆T z
th
------=
 8 :  M I N D L I N  P L A T E S



Below is the Boundary Settings dialog box.

With the Coordinate system list you control in what coordinate system the constraint is 
defined. Available options are:

• Tangential and normal coordinate system.

• Global coordinate system.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in “Coordinate Systems” on page 
144.

Using the tangential and normal coordinate system you select the constraint condition 
on the boundary. Available conditions are:

• Free

• Simply supported—the displacement is constrained and the normal rotation is set to 
zero. 

• Fixed—the displacement and tangential rotation is constrained.

• Rotation constrained—the tangential rotation is constrained.

• General notation—the H matrix and R vector in the relation Hu = R is specified.

 H
w
θt

θn

R=
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Note: For the simply supported, fixed, and rotational constrained condition the 
normal rotation is set to zero, resulting in better convergence.

For other coordinate systems the Constraint page looks like any other Constraint page 
in the Structural Mechanics Module.

The constraint can be described using standard or general notation. You select the type 
of notation using the Standard notation button and the General notation, Hu=R button.

In standard notation you constrain the displacement and rotations independently. The 
check box in front of Rz, Rx, and Ry activates the constraint, and you can then enter the 
value or expression for the displacement in the edit fields. The default value is 0.

In general notation, the H matrix and R vector in the relation

make it possible to specify constraints as any linear combination of displacement and 
rotation component. The H matrix and R vector are entered in special matrix dialog 
boxes by clicking the corresponding Edit buttons. For example, you can achieve the 
condition θx = θy using the settings

H
w
θx

θy

R=
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/m2), 
The H Matrix dialog box for the above example is

Loads

Load is a general name for forces and moments applied to the structure. You can 
specify loads on all domain types. To do so, click the Load tab in the Subdomain Settings, 
Boundary Settings, and Point Settings dialog boxes. The following picture shows the 
Point Settings dialog box, but the page looks similar on all domain levels.

In the subdomain and boundary domains dialog boxes you have an option to specify 
the load in different ways using the thickness. The loads can be defined on different 
domains in the following way. The SI unit is shown in parenthesis.

H
0 1 1–

0 0 0
0 0 0

,= R 0
0

=

POINT BOUNDARY SUBDOMAIN

force (N), 
moment (Nm)

force/area (N/m2), moment/area (N/m) or 
force/length (N/m), moment/length (N)

force/volume (N/m3), moment/
volume (N/m2) or force/area (N
moment/area (N/m)
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With the Coordinate system list you control in what coordinate system the load is 
defined. Available options are:

• Global coordinate system

• Tangential and normal coordinate system, only available on boundaries

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the coordinate system section.

The frequency response analysis type requires additional input. The analysis type is 
controlled from the Application Mode Properties dialog box. When frequency response 
is selected as analysis type, the Load page changes appearance:

For frequency response analysis the harmonic load is split into 3 different parameters:

• The amplitude value, F

• The amplitude factor, FAmp (a dimensionless number; the default value is 1)

• The phase (FPh). 

Together they define a harmonic load whose amplitude and phase shift can vary with 
the excitation frequency, f:

On subdomains additional options are available controlling if and how thermal strains 
should be included in the analysis. They are explained in the next section.

Ffreq F FAmp f( ) 2πf FPh f( )+( )cos⋅ ⋅=
 8 :  M I N D L I N  P L A T E S



Thermal Coupling

Material expands with temperature, which causes thermal strains to develop in the 
material. The plate can only handle temperature difference through the plate. The 
thermal strains together with the initial strains and elastic strains from structural loads 
form the total strain.

where 

Thermal coupling means that the thermal expansion is included in the analysis. For 
details on thermal coupling, see page 234. Thermal effects are specified on the Load 
page in the Subdomain Settings dialog box.

The Include thermal expansion check box adds thermal effects. In the dT edit field the 
temperature difference through the plate, ∆T is specified. The thermal expansion 
coefficient is specified on the Material page described in “Material” on page 240. ∆T 
can be any expression and is typically another variable solved for in a COMSOL 
Multiphysics heat transfer application mode. The temperature coupling can be used in 
any type of analysis.

ε εel εth εi+ +=

εth α∆T z
th
------=
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Damping

In transient and frequency response analyses you have the possibility to model 
undamped or damped problems. In the Structural Mechanics Module you can specify 
damping on the subdomain level using the Damping page that appears in the Subdomain 

Settings dialog box. From the Damping models list you can select No damping, Rayleigh, 
or Loss factor, and the layout of the dialog box changes for each model.

Damping page when Rayleigh damping is selected.

Note: Loss factor damping is valid only for frequency response analysis. If you choose 
transient analysis and loss factor damping, COMSOL Multiphysics solves the model 
with no damping.

Table 8-1 and the subsequent text describe the parameters that define damping:

Mass damping parameter   It defines the Rayleigh damping model’s mass damping, 
αdM.

TABLE 8-1:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

 αdM alphadM Mass-damping parameter Rayleigh

 βdK betadK Stiffness-damping parameter Rayleigh

 η eta Loss factor Loss factor
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Stiffness damping parameter   It defines the Rayleigh damping model’s stiffness 
damping, βdK.

Loss factor   It defines the loss factor η for the loss factor damping model.

Initial Load and Strain

Initial stress and strain can be included in the analysis. For the plate formulation this 
transforms to initial internal plate moments and shear forces and initial curvatures and 
initial average shear strains. Initial load and strain can be viewed as different ways to 
express the same thing. Initial load and strain are specified on the Initial Load and Strain 
page in the Subdomain Settings dialog box.

The option to include initial forces and moments and initial curvature and strain is 
controlled independently using the two check boxes Include initial forces and moments 
and Include initial strain and curvature.

Postprocessing

The predefined postprocessing variables include: all non-zero stress and strain tensor 
components, principal stresses and strains, in-plane and out-of-plane forces, bending 
and torsional moments, and von Mises and Tresca effective stresses. The stress and 
strain tensor components and effective stresses can be evaluated at an arbitrary distance 
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from the mid surface. This height is controlled from the Postprocessing page in the 
Subdomain Settings dialog box.

With the Evaluate at list you control where the stress and strain should be evaluated, 
available options are:

• Top of plate (default)

• Midplane of plate

• Bottom of plate

• Specified height

Select Specified height to specify a postprocessing height explicitly using the height edit 
field.

The displacement and rotations in radians and, for a transient analysis, the velocity and 
angular velocity can be plotted.
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B e a m s
A beam is a slender structure which is assumed to be fully described by the 
properties—area, moments of inertia, density—of the cross section. Beams are the 
choice for modeling reinforcements in 3D solids and shell structures, as well as in 
2D solids under the plane stress assumption. Naturally, they can also model lattice 
works, both planar and three-dimensional.

Beams can sustain loads and moments in any direction, both distributed and on 
individual nodes. The beam’s ends and interconnections can be free, simply 
supported, or clamped. In fact, the simplified boundary conditions are usually 
responsible for most of the difference that may be found between a beam solution 
and a full 3D solid simulation of the same structure. Point constraints are 
well-behaved, in contrast to the solid case. Discrete point masses and mass 
moments of inertia can be used.

The Structural Mechanics Module’s beam application modes are based on the 
principle of virtual work. The resulting equation can equivalently be viewed as a 
weak formulation of an underlying PDE. The beam application modes use special 
shape function classes to define stresses and strains, which are used in setting up the 
weak form equation.
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Th eo r y  Ba c k g r ound

Shape functions

The degrees of freedom are defined by a shape function object, different shape 
functions for the in-plane and 3D Euler beam.

I N - P L A N E  E U L E R  B E A M

The shape function object for the in-plane Euler beam application mode is

appl.shape{1}=sheulbps('u','v','th')

The shape function class defines the following variables:

See sheulbps on page 166 of the Structural Mechanics Module Reference Guide for 
details.

3 D  E U L E R  B E A M

The shape function object for the 3D Euler beam application mode is:

appl.shape{1}=sheulb3d('u','v','w','thx','thy','thz',point)

The shape function class defines the following variables.

VARIABLE NAME DESCRIPTION

 u u Global displacement in x direction

 v v Global displacement in y direction

 θ th Rotation angle about an axis pointing out from the xy-plane 
(global z-axis)

ths Tangential derivative along the edge direction of the rotation 
angle θ

thss The second tangential derivative of the rotation angle θ

uvts The tangential derivative of the axial displacement in the edge 
direction

VARIABLE NAME DESCRIPTION

 u u Global displacement in x direction

 v v Global displacement in y direction

∂θ
∂s
------

∂2θ
∂s2
---------

∂uaxi
∂s

--------------
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See sheulb3d on page 162 of the Structural Mechanics Module Reference Guide for 
details.

Strain-Displacement/Rotation Relation

The axial strain depends on the rotation derivative and axial displacement derivative 
defined by the shape function and the z coordinate in the beam. For the 2D case it 
becomes

 w w Global displacement in z direction

 θx thx Rotation angle about the global x-axis

 θy thy Rotation angle about the global y-axis

 θz thz Rotation angle about the global z-axis

 ul ul Displacement in local x direction

 vl vl Displacement in local y direction

 wl wl Displacement in local z direction

 θxl thxl Rotation angle about the local x-axis

 θyl thyl Rotation angle about the local y-axis

 θzl thzl Rotation angle about the local z-axis

thxs Tangential derivative along the edge direction of the rotation 
angle about the local x-axis

thys Tangential derivative along the edge direction of the rotation 
angle about the local y-axis

thyss The second tangential derivative of the rotation angle about 
the local y-axis

thzs Tangential derivative along the edge direction of the rotation 
angle about the local z-axis

thzss The second tangential derivative of the rotation angle about 
the local z-axis

uvwts The tangential derivative of the axial displacement in the edge 
direction

VARIABLE NAME DESCRIPTION

∂θxl
∂s

----------

∂θyl
∂s

----------

∂2θyl

∂s2
-------------

∂θzl
∂s

----------

∂2θzl

∂s2
-------------

∂uaxi
∂s

--------------
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The total strain ε consists of thermal (εth), initial (εi), and elastic strains(εel)

For the 3D case there are two rotational derivatives.

Stress-Strain Relation

The stress-strain relation in the beam is described by 

The stress-strain relation for linear conditions including initial stress and strain and 
thermal effects reads:

where E is known as Young’s modulus or the modulus of elasticity.

Thermal Strain

The temperature is assumed to vary linear across the beam’s cross section. For the 
in-plane beam it becomes

The thermal strain as a function of the z-coordinate and the temperature gradient is

In the 3D beam the temperature depends on both y and z:

ε z∂θ
∂s
------

∂uaxi
∂s

--------------+=

ε εel εth εi+ +=

σ Eε=

σ Eεel σi+ E ε εth– εi–( ) σi+= =

T Tm ∆T z
hz
------+=

εth α Tm ∆T z
hz
------ Tref–+⎝ ⎠

⎛ ⎞=

T Tm ∆Tz
z
hz
------ ∆Ty

y
hy
------+ +=

εth α Tm ∆Tz
z
hz
------ ∆Ty

y
hy
------ Tref–+ +⎝ ⎠

⎛ ⎞=
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Initial Load and Strain

The initial stress means the stress before any loads, displacements, and initial strains 
have been applied.

The initial stress distribution is given as initial moment and initial normal force, for the 
2D beam 

In 3D there is an additional bending moments and a torsional moment.

The initial strain is the strain before any loads, displacements, and initial stresses have 
been applied. The initial strain distribution is given as initial curvature and initial axial 
strain, for the 2D beam

In 3D there are two initial rotational derivatives and an initial torsional derivative.

Implementation

The implementation is based on the principle of virtual work, which states that the sum 
of virtual work from internal strains and external loads equals zero:

In 2D the beam moment is defined as

Mi σiz Ad
A
∫= Ni σi Ad

A
∫=

εi z ∂θ
∂s
------⎝ ⎠
⎛ ⎞

i

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

i
+=

δW δ ε– elσ uTF Vd+( )
V
∫ 0= =

M σz Ad
A
∫ z Eεel σi+( ) zd

A
∫

z E z∂θ
∂s
------

∂uaxi
∂s

--------------+⎝ ⎠
⎛ ⎞ z ∂θ

∂s
------⎝ ⎠
⎛ ⎞

i

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

i
+⎝ ⎠

⎛ ⎞–

α Tm ∆T z
hz
------ Tref–+⎝ ⎠

⎛ ⎞

–

σi+

⎝

⎠

⎜

⎟

⎛

⎞
zd

A
∫

z2 E ∂θ
∂s
------ ∂θ

∂s
------⎝ ⎠
⎛ ⎞

i
– α∆T

hz
--------–⎝ ⎠

⎛ ⎞ Ad
A
∫ σiz zd

A
∫+ EIyy

∂θ
∂s
------ ∂θ

∂s
------⎝ ⎠
⎛ ⎞

i
– α∆T

hz
--------– Mi+

= = =

=

=

T H E O R Y  B A C K G R O U N D  |  257



258 |  C H A P T E R
In 3D there is an additional bending moment and torsional moment.

The torsion of the beam is defined using a torsional constant J given by

In a similar way as for the bending part a torsional moment is defined as

The normal force is defined as

Using the beam moment and normal force the expression for the virtual work becomes 
very compact, for the 2D beam it becomes

For 3D it becomes

J M
Gθ
--------l=

Mxl GJ
∂θxl
∂s

----------
∂θxl
∂s

----------⎝ ⎠
⎛ ⎞

i
–⎝ ⎠

⎛ ⎞ Mxi+=

N σ Ad
A
∫ Eεel σi+( ) zd

A
∫

E z∂θ
∂s
------

∂uaxi
∂s

--------------+⎝ ⎠
⎛ ⎞ z ∂θ

∂s
------⎝ ⎠
⎛ ⎞

i

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

i
+⎝ ⎠

⎛ ⎞– α Tm ∆T z
hz
------ Tref–+⎝ ⎠

⎛ ⎞– σi+
⎝ ⎠
⎜ ⎟
⎛ ⎞

zd
A
∫

E
∂uaxi

∂s
--------------

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

i
–⎝ ⎠

⎛ ⎞ α Tm Tref–( )–⎝ ⎠
⎛ ⎞ Ad

A
∫ σi zd

A
∫+

EA
∂uaxi

∂s
--------------

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

i
–⎝ ⎠

⎛ ⎞ α Tm Tref–( )– Ni+

= = =

=

=

δW M ∂θ
∂s
------⎝ ⎠
⎛ ⎞

test
N

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

test
+⎝ ⎠

⎛ ⎞ xd
L
∫=

δW Myl
∂θyl
∂s

----------⎝ ⎠
⎛ ⎞

test
Mzl

∂θzl
∂s

----------⎝ ⎠
⎛ ⎞

test
N

∂uaxi
∂s

--------------⎝ ⎠
⎛ ⎞

test
Mxl

∂θxl
∂s

----------⎝ ⎠
⎛ ⎞

test
+ + +⎝ ⎠

⎛ ⎞ xd
L
∫=
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App l i c a t i o n  Mode De s c r i p t i o n

This section describe how to define a beam model. It is divided into the following 
sections:

• Properties

• Scalar Variables

• Material

• Cross Section

• Constraint

• Load

• Discrete Mass

• Thermal Coupling

• Initial Load and Strain

• Postprocessing

Properties

To open Application Mode Properties dialog box, choose Physics>Propertries.

In the Application Mode Properties dialog box you control global settings for the model.

• Analysis type: A list of different analyses to perform. It affects both the equations and 
what solver to use through the Auto select solver option in the Solver Parameters 
dialog box. The available analysis types use the following solvers. 

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER

Static Stationary 

Eigenfrequency Eigenvalue
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• Weak constraints: Controls whether or not weak constraints are active. Use weak 
constraints for accurate reaction-force computation. When weak constraints are 
enabled, all constraints are weak by default, but it is possible to change this setting 
for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 301 in the COMSOL Multiphysics Modeling Guide).

Scalar Variables

There are two different scalar variables:

• Excitation frequency, freq, which is applicable only for frequency response analysis.

• Complex angular frequency, jomega, which is applicable only for eigenfrequency 
analysis. You normally do not need to edit the complex angular frequency. 

The Scalar Variables menu item on the Physics menu is enabled only when you have 
selected Frequency Response, Damped Eigenfrequency, or Eigenfrequency as Analysis type 
in the Application Mode Properties dialog box.

The excitation frequency is the frequency of the harmonic loads in a frequency 
response analysis.

When you have selected frequency response as the analysis type, the default solver is 
the parametric solver making it easy to perform a frequency sweep over several 
excitation frequencies in a single analysis. In this case, enter freq_smeul3d in the 

Time dependent Time dependent

Frequency response Parametric

Parametric Parametric

Quasi-static transient Time dependent

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER
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Parameter name edit field on the Parametric page in the Solver Parameters dialog box. 
The values entered in the Parameter values edit field then override the excitation 
frequency entered in the Application Scalar Variables dialog box.

Material Properties

The material properties are defined on the Material page in the Boundary Settings dialog 
box for the 2D in-plane Euler beam and in the Edge Settings dialog box for the 3D 
Euler beam.

The material properties are shown in the table below.

Young’s modulus    Defines the modulus of elasticity, E of the material. It is the spring 
stiffness in Hooke’s law, shown below in 1D form 

 

where σ is the stress and ε is the strain.

PARAMETER VARIABLE DESCRIPTION COMMENT

 E E Young's modulus 

 ν nu Poisson's ratio Only 3D Euler beam

 ρ rho Density

 α alpha Thermal expansion coefficient

σ Eε=
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Poisson’s ratio   Denoted by ν, defines the normal strain in the perpendicular direction, 
generated from a normal strain in the other direction.

Used to calculate the shear modulus G, used in the torsional part of the 3D Euler 
beam.

Density   This material property, ρ, specifies the density of the material. 

Thermal expansion coefficient    Defines how much a material expands due to an 
increase in temperature. 

where εth is the thermal strain, ∆Ty and ∆Tz are the temperature difference over the 
cross section of the beam in the y and z directions, and α is the thermal expansion 
coefficient. Tm is the temperature in the middle and Tref is the stress free reference 
temperature.

ε⊥ υεl l–=

εth α Tm ∆Tz
z
h
--- ∆Ty

y
h
--- Tref–+ +⎝ ⎠

⎛ ⎞=
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nly

nly

nly

nly

nly
Cross Section

The cross-sectional properties are defined on the Cross-Section page in the Edge Settings 
or Boundary Settings dialog box.

The following table lists the cross-section properties:

3D beams modeled on edges need a local coordinate system for a number of reasons:

• Input data—you need a coordinate system to specify input data such as area moment 
of inertia.

PARAMETER VARIABLE DESCRIPTION COMMENT

 A A Cross-sectional area

 Iyy Iyy Area moment of inertia about local y-axis

 Izz Izz Area moment of inertia about local z-axis 3D Euler beam o

 J J Torsional constant 3D Euler beam o

 heighty (hy) heighty Total section height in the y direction

 heightz (hz) heightz Total section height in the z direction 3D Euler beam o

 localxp localxp x-coordinate for point defining local xy-plane 3D Euler beam o

 localyp localyp y-coordinate for point defining local xy-plane 3D Euler beam o

 localzp localzp z-coordinate for point defining local xy-plane 3D Euler beam o
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• Postprocessing—if you want to look at bending moments or shear forces, you must 
know the direction of the coordinate system.

• Loads—if you want to apply loads in a local coordinate system you need to be able 
to specify it.

If your beam’s cross section is a square or circle (solid or tube), the area moments of 
inertia are the same independent of direction, so the beam is totally symmetric and you 
do not need to worry about the local coordinate system unless you are interested in 
looking at results defined using the local coordinate system. Such results are bending 
moments, shear forces, local displacements and rotations. 

The coordinate system is defined in the following way. The x direction is in the edge 
direction. The positive edge direction can be checked by plotting the edge arc length 
parameter s1 and see in what direction it increases. You can also plot the tangential 
variable t1x, t1y, and t1z to check the direction of the edge. The coordinates of an 
additional point (localxp, localyp, and localzp), specified on the Cross-Section 
page in the Edge Settings dialog box, defines the local xy-plane with the positive 
y direction defined so that the point lies in the positive quadrant. See the previous 
dialog box and the following figure.

For the creation of a local coordinate system to be possible, the point cannot coincide 
with the edge or the edge extension. If you do this you get an error message: Point 

defining beam local xy-plane coincides with edge.
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This error might occur even if you have a totally symmetric cross section and do not 
have to worry about the direction. If this happens you must enter coordinates far away 
from your edge and not along the edge extension. You can do this for a number of 
edges at the same time using a point far away from the geometry.

Note: The default settings for the global coordinates of the point are [1,1,0].

Usually a number of edges in a plane have the same orientation. It is then easy to select 
all edges and specify a point anywhere in the same plane, not coinciding with an edge 
or an edge extension.

Constraint

A constraint specifies the displacement and rotation of a certain part of the beam. 
Constraints can be defined on all valid domain levels such as points, edges, and 
boundaries. The constraint is controlled from the Constraint page in the Boundary 

Settings, Edge Settings, and Point Settings dialog boxes.

An example of a beam application mode Constraint page, taken here from the 3D Euler 
Beam application mode Points Settings dialog box.
A P P L I C A T I O N  M O D E  D E S C R I P T I O N  |  265



266 |  C H A P T E R

CONSTRA

Free

Pinned tion

Fixed fixed 

No rotat ns

Prescribe  to be 

Symmetr

x-y symm metry 

y-z symm metry 

x-z symm metry 

Antisymm

x-y antis

y-z antisy

x-z antis

Prescribe ed to 
e 

Prescribe ction 
 

The figure shows the Constraint page of the Edge Settings dialog box for the 3D Euler 
beam application mode. The page looks similar on all domain levels in both of the 
beam application modes, differing only regarding the variables to constrain:

• For the 2D Euler beam, two displacement and one rotation.

• For the 3D Euler beam, three displacements and three rotations.

Within the dialog box, the Constraint condition list lets you control what type of 
constraint you want to define. You have the following options to choose between:

INT CONDITION POINT BOUNDARY/
EDGE 

USE WHEN

√ √ The domain has no constraint

√ √ The displacement in the domain is fixed in all direc

√ √ The displacement and rotations in the domain are 
in all directions

ion √ √ The rotations in the domain are fixed in all directio

d displacement √ √ The displacement or rotation in any direction need
prescribed

y plane √ (2D only) The boundary is a symmetry plane

etry plane √ √ The selected coordinate system’s xy-plane is a sym
plane

etry plane √ √ The selected coordinate system’s yz-plane is a sym
plane

etry plane √ √ The selected coordinate system’s xz-plane is a sym
plane

etry plane √ (2D only) The boundary is an antisymmetry plane

ymmetry plane √ √ The selected coordinate system’s xy-plane is an 
antisymmetry plane

mmetry plane √ √ The selected coordinate system’s yz-plane is an 
antisymmetry plane

ymmetry plane √ √ The selected coordinate system’s xz-plane is an 
antisymmetry plane

d velocity √ √ The velocity and angular velocity in any direction ne
be prescribed, only available for frequency respons
analysis

d acceleration √ √ The acceleration or angular acceleration in any dire
need to be prescribed, only available for frequency
response analysis
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The symmetry or antisymmetry condition has the following interpretation.

With the Coordinate system list you control in what coordinate system the constraint is 
defined. Available options are:

• Global coordinate system

• Tangential and normal coordinate system, only available on boundaries for the 2D 
Euler beam.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the coordinate system chapter.

• Beam local coordinate system, only available on edges for the 3D Euler beam.

CONDITION X-DISP. Y-DISP. Z-DISP. X-ROT. Y-ROT. Z-ROT.

x-y symmetry plane √ √ √

y-z symmetry plane √ √ √

x-z symmetry plane √ √ √

x-y antisymmetry plane √ √ √

y-z antisymmetry plane √ √ √

x-z antisymmetry plane √ √ √
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When you select Prescribed displacement a number of new option appears in the dialog 
box and the Constraint page takes on this appearance:

The Constraint page showing the Prescribed displacement options.

You can prescribe a constraint in two ways:

• In standard notation you constrain each displacement direction independently. The 
check box in front of Rx, Ry, Rz, Rthx, Rthy, and Rthz activates the constraint, the value/
expression of the displacement/rotation can then be entered in the edit fields. The 
default value is 0.

• In general notation, the H matrix and R vector in the relation

make it possible to specify constraints as any linear combination of the available 
variables.

For the 2D Euler beam application mode the relation is

For the 3D Euler beam application mode the relation is

Hu R=

H
u
v
θ

R=
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The H matrix and R vector are entered in special matrix dialog boxes by clicking the 
corresponding Edit buttons. For example the condition u = v in the 2D Euler beam 
application mode can be achieved using the settings

which force the domain to move only diagonally in the xy-plane.

The H Matrix dialog box for the above example is 

In a frequency response analysis you have the possibility to specify not only a harmonic 
displacement and rotation but also a harmonic velocity/angular velocity or 

H

u
v
w
θx

θy

θz

R=

H
1 1– 0
0 0 0
0 0 0

= R
0
0
0

=
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acceleration/angular acceleration. You specify the Prescribed velocity and Prescribed 

acceleration in the same way as Prescribed displacement using Standard notation.

Constraint page showing the Prescribed acceleration settings.

Load

Load is a general name for forces and moments applied to, the structure. Loads can be 
specified on all domain types. You specify loads on the Load page in the Boundary 

Settings, Edge Settings, and Point Settings dialog boxes. The following picture shows the 
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Boundary Settings dialog box for the 2D Euler beam application mode, but the page 
looks similar on all domain levels.

The loads/moments are defined in the following way. The SI unit is shown in 
parenthesis.

With the Coordinate system list you control in what coordinate system the load is 
defined. Available options are:

• Global coordinate system 

• Tangential and normal coordinate system, only available on boundaries for the 2D 
Euler beam.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the coordinate system section.

• Beam local coordinate system, only available on edges for the 3D Euler beam.

For the frequency response analysis type, additional input data is specified. You control 
the analysis type from the Application Mode Properties dialog box. If you select 
frequency response as analysis type, the Load page changes appearance to looks like the 
following image:

DOMAIN TYPE LOAD (UNIT) MOMENT (UNIT)

point force (N) moment (Nm)

edge, boundary force/length (N/m) moment/length (N)
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For frequency response analysis the harmonic load is split into 3 different parameters:

• The amplitude value (F, M) 

• The amplitude value factor (FAmp, MAmp) (a dimensionless number; the default 
value is 1)

• The phase (FPh, MPh) 

Together they define a harmonic load whose amplitude and phase shift can vary with 
the excitation frequency f:

On the edge and boundary domain levels additional options are available controlling 
if and how thermal strains should be included in the analysis. They are explained in the 
section “Thermal Coupling” on page 274.

Discrete Mass

Discrete mass or mass moment of inertia are concentrated to a point in contrast to 
distributed mass modeled through the density and area of the beam. You specify 

Ffreq F FAmp f( ) 2πf FPh f( )+( )cos⋅ ⋅=
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discrete mass and mass moment of inertia on the Mass page in the Point Settings dialog 
box.

With the Coordinate system list you control in what coordinate system the principal 
mass moment of inertias are defined (only possible for 3D Euler beams). Available 
options are:

• Global coordinate system.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in “Coordinate Systems” on page 
144.

The mass properties are shown in the following table:

PARAMETER VARIABLE DESCRIPTION SI UNIT COMMENT

m m Mass kg

Jx Jx Mass moment of inertia about x-axis kg·m2 Only 3D Euler beam

Jy Jy Mass moment of inertia about x-axis kg·m2 Only 3D Euler beam

Jz Jz Mass moment of inertia about x-axis kg·m2

αdM alphadM Mass damping parameter 1/s
A P P L I C A T I O N  M O D E  D E S C R I P T I O N  |  273



274 |  C H A P T E R
Thermal Coupling

Material expands with temperature, which causes thermal strains to develop in the 
material. The beams can handle any temperature variation along the beam, and linear 
variation across the beam. The thermal strains together with the initial strains and 
elastic strains from structural loads form the total strain.

where

Thermal coupling means that the thermal expansion is included in the analysis. Details 
on thermal coupling is found on page 256. Thermal effects are specified on the Load 
page in the Edge Settings and Boundary Settings dialog boxes.

The Include thermal expansion check box adds thermal effects. In the Temp and Tempref 
edit fields the strain temperature in the middle of the cross section, Tm and stress free 
reference temperature Tref are specified. In the dTy and dTz edit fields the temperature 
difference across the beams cross section, ∆Ty and ∆Tz is specified. The thermal 
expansion coefficient are specified on the Material page, described in the Material 
section on page 261. Tm, Tref, ∆Ty, and ∆Tz can be any expression and are typically 

ε εel εth εi+ +=

εth α Tm ∆Tz
z
hz
------ ∆Ty

y
hy
------ Tref–+ +⎝ ⎠

⎛ ⎞=
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another variable solved for in an application mode. The temperature coupling can be 
used in any type of analysis.

Damping

In transient and frequency response analyses you have the possibility to model 
undamped or damped problems. In the Structural Mechanics Module you can specify 
damping in the subdomain level using the Damping page that appears in the Boundary 

Settings (2D) or Edge Settings (3D) dialog box. From the Damping models list you can 
select No damping, Rayleigh, or Loss factor, and the layout of the dialog box changes for 
each model.

Damping page when Rayleigh damping is selected.

Note: Loss factor damping is valid only for frequency response analysis. If you choose 
transient analysis and loss factor damping, the model will be solved with no damping.

Table 9-1 and the following text describe the parameters that define damping:

TABLE 9-1:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

 αdM alphadM Mass-damping parameter Rayleigh

 βdK betadK Stiffness-damping parameter Rayleigh

 η eta Loss factor Loss factor
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Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

Loss factor   Defines the loss factor η for the loss factor damping model.

Initial Load and Strain

Initial stress and strain can be included in the analysis. For the beam formulations the 
initial stresses transforms to initial internal beam moments, initial torsional moment, 
and initial normal force. The initial strains consists of initial curvatures, initial torsional 
angle derivative, and initial axial strain. Initial load and strain can be viewed as different 
ways to express the same thing. Initial load and strain are specified on the Initial Load 

and Strain page in the Edge Settings and Boundary Settings dialog boxes.

The option to include initial forces and moments and initial curvature and strain is 
controlled independently using the two check boxes Include initial axial force and 

moments and Include initial strain and curvature.
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I n - P l a n e  Eu l e r  B e am

Use the In-Plane Euler Beam application mode to analyze planar lattice works of 
uniaxial beams.

In-plane Euler beams are defined on edges in 2D. All settings for the application mode 
are described in “Application Mode Description” on page 259.

Variables and Space Dimensions

The degrees of freedom (dependent variables) are the global displacements u and v in 
the global x and y directions and the rotation θ about the global z-axis.
I N - P L A N E  E U L E R  B E A M  |  277



278 |  C H A P T E R
3D Eu l e r  B e am

Use the 3D Euler Beam application mode to model three-dimensional frameworks of 
uniaxial beams.

3D Euler beams are defined on edges in 3D. All settings for the application mode 
appear in “Application Mode Description” on page 259.

Variables and Space Dimensions

The degrees of freedom (dependent variables) are the global displacements u, v, w in 
the global x, y, z directions and the global rotations θx, θy, and θz about the global x-, 
y-, and z-axes.
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T r u s s e s
Trusses are elements that can only sustain axial forces. They have displacements as 
degrees of freedom. Trusses are sometimes referred to as bars or spars. They live on 
boundaries in 2D and edges in 3D. The truss application modes support the same 
analysis types as the continuum application modes. You can use trusses to model 
truss works where the edges are straight but also to model sagging cables like the 
deformation of a wire exposed to gravity. In such applications trusses are often 
referred to as cable elements.
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Th eo r y  Ba c k g r ound

Trusses is modeled using Lagrange shape function. The Lagrange shape function 
makes it possible to specify both normal strains and Green-Lagrange strains to handle 
small strains as well as large deformations.

Strain-Displacement Relation

The axial strain εn is calculated by expressing the global strains in tangential derivatives 
and projecting the global strains on the edge.

 (10-1)

where t is the edge tangent vector and εgT is defined as

 (10-2)

The strains can be expressed as either engineering strains for small displacements or 
Green strains for large displacements. The Green strain tensor used for large 
displacements is defined as

 (10-3)

The engineering strain tensor used for small displacements is defined as

 (10-4)

The axial strain written out becomes

 (10-5)

εn ttεgTt=

εgT

εxT εxyT εxzT

εxyT εyT εyzT

εxzT εyzT εzT

=

εijT
1
2
---

xj∂
∂ui

T
xi∂

∂uj

T
xi∂

∂uk

T
xj∂

∂uk

T

⋅+ +
⎝ ⎠
⎜ ⎟
⎛ ⎞

=

εijT
1
2
---

xj∂
∂ui

T
xi∂

∂uj

T

+
⎝ ⎠
⎜ ⎟
⎛ ⎞

=

εn tx εxTtx εxyTty εxzTtz+ +( ) +=

ty εxyTtx εyTty εyzTtz+ +( ) +

tz εxzTtx εyzTty εzTtz+ +( )
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Stress-Strain Relation

The constitutive relation for the axial stress including thermal strain and initial stress 
and strain is

 (10-6)

Implementation

Using the principle of virtual work results in the following weak formulation

 (10-7)

where the summation stands for summation over all points in the geometry. Replacing 
the integration over the cross section with the cross-sectional area (A) and the volume 
forces with line forces, the equation becomes

 (10-8)

Straight Edge Option

The optional constraint to enforce the nodes to lie on the straight line between the end 
points of the edge are formulated as follows:

Starting with the large displacement case, let xd1 and xd2 be the deformed position of 
the two end points of the edge

 (10-9)

where ui is the displacement, and xi is the coordinate (undeformed position) at end 
point i. The equation for the straight line through the end points is

 (10-10)

where t is a parameter along the line, and a is the direction vector for the line. a is 
calculated from the deformed position of the end points as 

 (10-11)

σn E εn α T Tref–( )– εni–( ) σni+=

δW d εnσn– utFV+( ) Vd
V
∫ utFPi

i
∑+=

δW εntestσnA– utest
t FL+( ) Ld

L
∫ utest

t FPi

i
∑+=

xdi ui xi+=

x u+ xd1 ta+=

a xd2 xd1–=
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The constraints for the edge is derived by substituting the parameter t from one of the 
scalar equations in Equation 10-10 into the remaining ones. In 2D the constraint 
equations become

 (10-12)

In 3D the two constraints equations become

 (10-13)

To avoid problems when the edge is directed in one of the coordinate axes directions, 
a third constraint is added. This constraint is a linear combination of the two earlier 
constraints:

 (10-14)

You need a linear constraint in order for the solution of the small displacement 
problem to become independent of the solver. The linear relation for the displacement 
is

 (10-15)

where uax is the axial displacement along the edge, and xn are a linear parameter along 
the edge

 (10-16)

Eliminating uax from Equation 10-15 results in the following linear constraint in 2D

 (10-17)

and the following three linear constraints in 3D:

x u xd1–+( )ay y v yd1–+( )ax–

x u xd1–+( )az z w zd1–+( )ax–

y v yd1–+( )az z w zd1–+( )ay–

y v yd1–+( )ax x u xd1–+( )ay–

u
u1 xn2 xn–( ) u2 xn xn1–( )+

xn2 xn1–( )
------------------------------------------------------------------------ uax x2 x1–( )+=

xn
x x2 x1–( ) y y2 y1–( ) z z2 z1–( )+ +

x2 x1–( )2 y2 y1–( )2 z2 z1–( )2
+ +

--------------------------------------------------------------------------------------------=

u1 xn2 xn–( ) u2 xn xn1–( )+

xn2 xn1–( )
------------------------------------------------------------------------ u– y2 y1–( ) –

v1 xn2 xn–( ) v2 xn xn1–( )+

xn2 xn1–( )
---------------------------------------------------------------------- v– x2 x1–( ) 0=
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 (10-18)

u1 xn2 xn–( ) u2 xn xn1–( )+

xn2 xn1–( )
------------------------------------------------------------------------ u– z2 z1–( ) –

w1 xn2 xn–( ) w2 p xn1–( )+

xn2 xn1–( )
----------------------------------------------------------------------- w– x2 x1–( ) 0=

v1 xn2 xn–( ) v2 xn xn1–( )+

xn2 xn1–( )
---------------------------------------------------------------------- v– z2 z1–( ) –

w1 xn2 xn–( ) w2 xn xn1–( )+

xn2 xn1–( )
-------------------------------------------------------------------------- w– y2 y1–( ) 0=

v1 xn2 xn–( ) v2 xn xn1–( )+

xn2 xn1–( )
---------------------------------------------------------------------- v– x2 x1–( ) –

u1 xn2 xn–( ) u2 xn xn1–( )+

xn2 xn1–( )
------------------------------------------------------------------------ u– y2 y1–( ) 0=
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App l i c a t i o n  Mode De s c r i p t i o n

This section describes how to define a truss model. It is divided into the following 
sections:

• Properties

• Scalar Variables

• Material

• Cross Section

• Constraint

• Load

• Thermal Coupling

• Initial Stress and Strain

Properties

To open the Application Mode Properties dialog box, choose Properties from the Physics 
menu.
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In the Application Mode Properties dialog box you control different global settings for 
the model.

• Default element type: The selected finite element type that makes up the discretized 
finite element model is the default on all new boundaries/edges, and the choice 
does not affect boundaries/edges already created. Available elements are:

-  Lagrange - Linear

-  Lagrange - Quadratic

-  Lagrange - Cubic

-  Lagrange - Quartic

-  Lagrange - Quintic

• Analysis type: A list of different analyses to perform. It affects both the equations and 
what solver to use through the Auto select solver option in the Solver Parameters 
dialog box. The available analysis types use the following solvers:

• Large deformation: This list controls whether or not the model should support large 
deformations.

• Specify eigenvalues using: This list controls how to work with eigenmode analyses. 
Here you should specify Eigenvalue or Eigenfrequency/Critical load factor; this 
property is enabled only for eigenfrequency and linear-buckling analyses.

• Weak constraints: Controls whether or not weak constraints are active. Use weak 
constraints for accurate reaction-force computation. When weak constraints are 
enabled, all constraints are weak by default, but it is possible to change this setting 
for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 301 in the COMSOL Multiphysics Modeling Guide).

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER

Static Stationary 

Eigenfrequency Eigenvalue

Time dependent (Transient) Time dependent

Frequency response Parametric

Parametric Parametric

Quasi-static transient Time dependent

Linear Buckling Eigenvalue
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Scalar Variables

There are two different scalar variables:

• Excitation frequency, freq, which is applicable only for frequency response analysis.

• Complex angular frequency, jomega, which is applicable only for eigenfrequency 
analysis. You normally do not need to edit the complex angular frequency. 

The Scalar Variables menu item on the Physics menu is enabled only when Frequency 

response, Damped eigenfrequency, or Eigenfrequency is selected as Analysis type in the 
Application Mode Properties dialog box.

The excitation frequency is the frequency of the harmonic loads/constraints in a 
frequency response analysis.

When Frequency response is selected as analysis type, the default solver is the parametric 
solver, making it easy to perform a frequency sweep over several excitation frequencies 
in a single analysis. In this case, enter freq_smtr2d as the Parameter name on the 
Parametric page in the Solver Parameters dialog box. Doing so makes the values entered 
in the Parameter values edit field override the excitation frequency entered in the 
Application Scalar Variables dialog box.
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Material

The material properties are defined on the Material page in the Boundary Settings dialog 
box for the In-Plane Truss and in the Edge Settings dialog box for the 3D Truss.

The material properties are shown in the table below.

Young’s modulus    Defines the modulus of elasticity, E of the material. It is the spring 
stiffness in Hooke’s law, shown below in 1D form 

 

Density   This material property, ρ, specifies the density of the material. 

Thermal expansion coefficient    Defines how much a material expands due to an 
increase in temperature.

where εth is the thermal strain, T is the strain temperature and Tref is the stress free 
reference temperature.

PARAMETER VARIABLE DESCRIPTION

 E E Young’s modulus 

 ρ rho Density

 α alpha Thermal expansion coefficient

σ Eε=

εth α T Tref–( )=
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The Constrain edge to be straight (truss) and Allow edge to have sag (cable) buttons 
control the addition of an additional constraint, forcing the edge to be straight. The 
default is to add the constraint. Using this additional constraint removes the need to 
use a mesh with only one element per edge. The problem with internal nodes is that 
they makes the problem singular because the truss only has stiffness in the axial 
direction. The same applies when using higher-order elements. The additional 
constraint increases the solution time, especially for large 3D and transient problems. 
The remedy to this is to turn off the constraint option (click the Allow edge to have sag 

(cable) button) and use linear elements together with a very coarse mesh consisting of 
only one element/edge. 

For problems where you want to model the sag and do not have a straight line between 
the edge points, click the Allow edge to have sag (cable) button and use that setting 
together with the Large deformation option and a suitable mesh with internal nodes.

Cross-Section Properties

You define cross-sectional properties on the Cross Section page in the Edge Settings/
Boundary Settings dialog box.

The only cross-section property in these application modes is the cross-section area:

PARAMETER VARIABLE DESCRIPTION COMMENT

 A A Cross-section area
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Constraints

A constraint specifies the displacement of a certain part of the truss. Constraints can be 
defined on all valid domain levels such as points and edges/boundaries. You control 
the constraints from the Constraint page in the Boundary Settings, Edge Settings, and 
Point Settings dialog boxes.

The following figure shows the Boundary Settings dialog box for the 3D Truss 
application mode, but the page looks similar on all domain levels in both truss 
application modes.

An example of a truss Constraint page, taken here from the 3D Truss application mode 
Edge Settings dialog box.

Within the dialog box, use the Constraint condition list to specify the type of constraint. 
You can choose from the following options:

CONSTRAINT CONDITION POINT BOUNDARY/
EDGE

USE WHEN

Free √ √ The domain has no constraint

Pinned √ √ The displacement in the domain is fixed

in all directions

Roller √ (2D only) The normal displacement is constrained

Prescribed displacement √ √ The displacement in any direction need 
to be prescribed

Symmetry plane √ (2D only) The boundary is a symmetry plane
A P P L I C A T I O N  M O D E  D E S C R I P T I O N  |  289



290 |  C H A P T E R
The symmetry or antisymmetry condition has the following interpretation.

The Coordinate system list lets you control in which coordinate system you want the 
constraint defined. Available options are:

• Global coordinate system 

• Tangential and normal coordinate system, only available on boundaries for the in-
plane truss.

x-y symmetry plane √ The selected coordinate system’s xy-
plane is a symmetry plane

y-z symmetry plane √ The selected coordinate system’s yz-
plane is a symmetry plane

x-z symmetry plane √ The selected coordinate system’s xz-
plane is a symmetry plane

Antisymmetry plane √ (2D only) The boundary is an antisymmetry plane

x-y antisymmetry plane √ The selected coordinate system’s xy-
plane is an antisymmetry plane

y-z antisymmetry plane √ The selected coordinate system’s yz- 
plane is an antisymmetry plane

x-z antisymmetry plane √ The selected coordinate system’s xz-
plane is an antisymmetry plane

Prescribed velocity √ √ The velocity in any direction need to be 
prescribed (only available for frequency 
response analysis)

Prescribed acceleration √ √ The acceleration in any direction need 
to be prescribed (only available for 
frequency response analysis)

CONSTRAINT CONDITION POINT BOUNDARY/
EDGE

USE WHEN

CONDITION X-DISPLACEMENT Y-DISPLACEMENT Z-DISPLACEMENT

x-y symmetry plane √

y-z symmetry plane √

x-z symmetry plane √

x-y antisymmetry plane √ √

y-z antisymmetry plane √ √

x-z antisymmetry plane √ √
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• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the section “Coordinate 
Systems” on page 144.

When you select Prescribed displacement a number of new options appears in the dialog 
box and the Constraint page takes on this appearance:

The Constraint page showing the Prescribed displacement options.

You can prescribe a constraint in two ways:

• In standard notation you constrain each displacement direction independently. The 
check box in front of Rx, Ry, and Rz activates the constraint, and you can then enter 
the value or expression for the displacement in the corresponding edit fields. The 
default value is 0 (no displacement).

• In general notation, the H matrix and R vector in the relation

make it possible to specify constraints as any linear combination of the available 
variables.

For the In-Plane Truss application mode the relation is

For the 3D Truss application mode the relation is

Hu R=

H u
v

R=
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To enter the H matrix and the R vector, use special matrix dialog boxes that you 
open by clicking the corresponding Edit buttons. For example, you can achieve the 
condition u = v in the In-Plane Truss application mode using the settings

,

which force the domain to move only diagonally in the x-y plane.

The H Matrix dialog box for the above example is 

In a frequency response analysis you have the possibility to specify not only a harmonic 
displacement but also a harmonic velocity or acceleration. You specify your Prescribed 

velocity and Prescribed acceleration in the same way as Prescribed displacement using 
Standard notation.

Constraint page showing the Prescribed acceleration settings.

H
u
v
w

R=

H 1 1–

0 0
= R 0

0
=
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Loads

A load is a general name for all forces applied to the structure. You can specify loads 
on all domain types using the Load page in the Boundary Settings, Edge Settings, and 
Point Settings dialog boxes. The following picture shows the Boundary Settings dialog 
box for the In-Plane Truss application mode, but the page looks similar on all domain 
levels.

The loads are defined in the following way. The SI unit is shown in parenthesis.

With the Coordinate system list you control in what coordinate system the load is 
defined. Available options are:

• Global coordinate system 

• Tangential and normal coordinate system, only available on boundaries for the in-
plane truss.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the section “Coordinate 
Systems” on page 144.

POINT EDGE, BOUNDARY

force (N) force/length (N/m)
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For the frequency response analysis type, you need to specify additional input data. The 
analysis type is controlled from the Application Mode Properties dialog box. When 
frequency response is selected as analysis type, the Load page changes appearance to

For frequency response analysis the harmonic load is split into 3 different parameters:

• the amplitude value, F

• the amplitude factor, FAmp (a dimensionless number; the default value is 1)

• the phase (FPh)

Together they define a harmonic load whose amplitude and phase shift can vary with 
the excitation frequency f.

On the edge and boundary domain level additional options are available controlling if 
and how thermal strains should be included in the analysis. They are explained in the 
section “Thermal Coupling” on page 295.

Ffreq F FAmp f( ) 2πf FPh f( )+( )cos⋅ ⋅=
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Discrete Mass

Discrete mass is concentrated to a point in contrast to distributed mass modeled 
through the density and area of the truss. You specify discrete mass on the Mass page 
in the Point Settings dialog box.

The mass properties are shown in the table below.

Thermal Coupling

Material expands with temperature, which causes thermal strains to develop in the 
material. The trusses can handle any temperature variation along the truss. The 
thermal strains together with the initial strains and elastic strains from structural loads 
form the total strain.

where 

PARAMETER VARIABLE DESCRIPTION SI UNITS

 m m Mass kg

 αdM alphadM Mass damping parameter 1/s

ε εel εth εi+ +=

εth α T Tref–( )=
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Thermal coupling means that the thermal expansion is included in the analysis. Details 
on thermal coupling is found on page 281. Thermal effects are specified on the Load 
page in the Edge Settings or Boundary Settings dialog box.

The Include thermal expansion check box adds thermal effects. In the Temp and Tempref 
edit fields you specify the strain temperature T and stress free reference temperature 
Tref, respectively. Use the Material page to define the thermal expansion coefficient 
(described in “Material” on page 287). T and Tref can be any expression and can be a 
dependent variable for temperature from another application modes solving the heat 
transfer problem. The temperature coupling can be used in any type of analysis.

Damping

In transient and frequency response analyses you have the possibility to model 
undamped or damped problems. In the Structural Mechanics Module you can specify 
damping on the subdomain level using the Damping page that appears in the Boundary 

Settings (2D) or Edge Settings (3D) dialog box. From the Damping models list you can 
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select No damping, Rayleigh, or Loss factor, and the layout of the dialog box changes for 
each model.

Damping page when Rayleigh damping is selected.

Note: Loss factor damping is valid only for frequency response analysis. If you choose 
transient analysis and loss factor damping, COMSOL Multiphysics solves the model 
with no damping.

Table 10-1 and the following text describe the parameters that define damping: 

Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

Loss factor   Defines the loss factor η for the loss factor damping model.

TABLE 10-1:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

 αdM alphadM Mass-damping parameter Rayleigh

 βdK betadK Stiffness-damping parameter Rayleigh

 η eta Loss factor Loss factor
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Initial Stress and Strain

The analysis can include initial stress and strain. You specify the initial stress and strain 
on the Initial Stress and Strain page in the Edge Settings or Boundary Settings dialog box.

It is possible to control the options to include initial stress and strain independently 
using the Include initial stress and Include initial strain check boxes.
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I n - P l a n e  T r u s s  App l i c a t i o n  Mode

Use the In-Plane Truss application mode to analyze planar lattice trusses or sagging 
cable-like structures.

In-Plane Truss application modes are defined on edges in 2D. All settings for the 
application mode are described in “Application Mode Description” on page 284.

Variables and Space Dimensions

The degrees of freedom (dependent variables) are the global displacements u and v in 
the global x and y directions, respectively.
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3D T r u s s  App l i c a t i o n  Mode

Use the 3D Truss application mode to model three-dimensional trusses or sagging 
cable-like structures.

3D Truss application modes are defined on edges in 3D. All settings for the application 
mode appear in “Application Mode Description” on page 284.

Variables and Space Dimensions

The degrees of freedom (dependent variables) are the global displacements u, v, and 
w in the global x, y, and z directions, respectively.
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S h e l l s
A shell is a thin-walled structure in 3D where you can assume a simple form for the 
displacement’s variation through the thickness. Using this approximation, it is 
possible to develop a model for the deformation that is closer to the 2D plane stress 
and Mindlin plate application modes than to the 3D solid. For this to give accurate 
results it is important that the structure can really be described as thin-walled. 
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When modeling using shells it is important to remember that the faces should be 
defined in the midplane of the real geometry.

A Shell application mode can be active either on free surfaces embedded in 3D or on 
the boundary of a solid 3D object. In the latter case, it can be used to model a 
reinforcement that stiffens the surface of a 3D solid.

The shell is described by its thickness and the material properties E, ρ, ν, αdM, and βdK. 
All properties are evaluated as constant within any mesh element but can vary from one 
element to the next.

The element used for the shell application mode is of Mindlin-Reissner type, which 
means that transverse shear deformation is accounted for. Because the element is a 
flat-faceted triangle, the membrane and bending actions are uncoupled. The 
membrane action is modeled by a constant-strain triangle with true drilling rotations 
(Allman triangle, D. J. Allman; see Ref. 1). The bending action is modeled by the 
bending part of an Argyris TRIC triangle element; see J. Argyris et al. (Ref. 2) and C. 
Pacoste (Ref. 3) for further details.

Note: The shell application mode requires a triangular mesh and will not work with a 
quadrilateral mesh.

The dependent variables are the displacements u, v, and w in the global x, y, and z 
directions, and the rotations θx, θy, and θz about the global coordinate axes. The 
degrees of freedom defined by the shell element correspond to the values of the 
dependent variables in the three triangle vertices.

In contrast to the rest of the Structural Mechanics Module, the Shell application mode 
contains a mixture between a user-modifiable variational equation and a low-level 
element. The stiffness and mass matrices are assembled directly by the low-level shell 
element class (see the documentation of elshell_arg2 in the COMSOL Multiphysics 
Reference Guide for details), but the constraints and loads are assembled by linear 
Lagrange elements. Therefore the Shell application mode has somewhat limited 
multiphysics capabilities: The presence of dependent variables in expressions for the 
material properties are not accounted for in the Jacobian. It is possible, however, to 
use the dependent variables of another application mode in the loads on the shell.
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App l i c a t i o n  Mode De s c r i p t i o n

This section describes how to define a shell model. It is divided into the following 
sections:

• Properties

• Scalar Variables

• Material

• Constraint

• Load

• Postprocessing

Properties

The Application Mode Properties dialog box is opened from the Physics menu.

In the Application Mode Properties dialog box you control different global settings for 
the model.

• Analysis type: A list of different analyses to perform. It affects both the equations and 
what solver to use through the Auto select solver option in the Solver Parameters 
dialog box. The available analysis types use the following solvers. 

ANALYSIS TYPE COMSOL MULTIPHYSICS SOLVER

Static Stationary 

Eigenfrequency Eigenvalue

Time dependent Time dependent

Frequency response Parametric

Parametric Parametric

Quasi-static transient Time dependent
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• Specify eigenvalues using: Controls if eigenvalues or eigenfrequencies should be used 
when specifying parameters for the eigenvalue solver and if the result is returned as 
eigenvalues or eigenfrequencies.

• Weak constraints: Controls whether or not weak constraints are active. Use weak 
constraints for accurate reaction-force computation. When weak constraints are 
enabled, all constraints are weak by default, but it is possible to change this setting 
for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 301 in the COMSOL Multiphysics Modeling Guide).

Scalar Variables

There are two different scalar variables:

• Excitation frequency, freq, which is applicable only for frequency response analysis.

• Complex angular frequency, jomega, which is applicable only for eigenfrequency 
analysis. You normally do not need to edit the complex angular frequency. 

The Scalar Variables menu item on the Physics menu is enabled only when Frequency 

Response, Damped Eigenfrequency, or Eigenfrequency is selected as Analysis type in the 
Application Mode Properties dialog box.

The excitation frequency is the frequency of the harmonic loads in a frequency 
response analysis. 

When Frequency response is selected as the analysis type, the default solver is the 
parametric solver making it easy to perform a frequency sweep over several excitation 
frequencies in a single analysis. In this case freq_smsh is entered as the Parameter name 
on the Parametric page in the Solver Parameters dialog box and the values entered in 
the Parameter values edit field override the excitation frequency entered in the 
Application Scalar Variables dialog box.
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Material

The material properties are defined on the Material page in the Boundary Settings dialog 
box.

The material properties are shown in the table below.

Young’s modulus    Defines the modulus of elasticity, E of the material. For an isotropic 
material, it is the spring stiffness in Hooke’s law, shown below in 1D form

 

where σ is the stress and ε is the strain.

PARAMETER VARIABLE DESCRIPTION

E E Young's modulus 

ν nu Poisson's ratio 

Sf Sf Shear factor

ρ rho Density

α alpha Thermal expansion coefficient

th thickness Thickness

αdM alphadM Mass damping parameter

βdK betadK Stiffness damping parameter

σ Eε=
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Poisson’s ratio   Denoted by ν, defines the normal strain in the perpendicular direction, 
generated from a normal strain in the other direction.

Shear Factor   Denoted by Sf, the shear factor affects the shear stiffness. For a 
homogeneous material, Sf = 1.2.

Density   This material property, ρ, specifies the density of the material.

Thermal expansion coefficient    Defines how much a material expands due to an 
increase in temperature:

where εth is the thermal strain and α is the thermal expansion coefficient. The thermal 
expansion coefficient models thermal strain in the material.

Thickness   Defines the thickness of the shell.

Mass damping parameter   Defines the Rayleigh damping models mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping models stiffness damping, 
βdK.

Constraint

A constraint specifies the displacements and rotations of certain parts of a shell. 
Constraints can be defined on all domain levels such as points, edges, and faces. The 
constraint is controlled from the Constraint page in the Boundary/Edge/Point Settings 
dialog boxes.

ε⊥ υεl l–=

εth α T Tref–( )=
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CONSTRA

Free

Pinned tions

Fixed fixed 

No rota ns

Prescrib  to be 

Symmetr

x-y symm metry 

y-z symm metry 

x-z symm metry 
Below is the Boundary Settings dialog box.

The Constraint page from the Boundary Settings dialog box.

Within the dialog box the Constraint condition list lets you control what type of 
constraint you want to define. You have the following options to choose between:

INT CONDITION EDGE BOUNDARY USE WHEN

√ √ The domain has no constraint

√ √ The displacement in the domain is fixed in all direc

√ √ The displacement and rotations in the domain are 
in all directions

tion √ √ The rotations in the domain are fixed in all directio

ed displacement √ √ The displacement or rotation in any direction need
prescribed

y plane √ The boundary is a symmetry plane

etry plane √ √ The selected coordinate system’s x-y plane is a sym
plane

etry plane √ √ The selected coordinate system’s y-z plane is a sym
plane

etry plane √ √ The selected coordinate system’s x-z plane is a sym
plane
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Antisym

x-y antis

y-z antis

x-z antis

Prescrib ed to 
e 

Prescrib ction 
 

CONSTRA
The symmetry or antisymmetry condition has the following interpretation.

With the Coordinate system list you control in what coordinate system the constraint is 
defined. Available options are:

• Tangential and normal coordinate system, only applicable on faces.

• Shell local coordinate system, only applicable on faces.

• Global coordinate system.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the coordinate system section.

metry plane  √ The boundary is an antisymmetry plane

ymmetry plane √ √ The selected coordinate system’s x-y plane is an 
antisymmetry plane

ymmetry plane √ √ The selected coordinate system’s y-z plane is an 
antisymmetry plane

ymmetry plane √ √ The selected coordinate system’s x-z plane is an 
antisymmetry plane

ed velocity √ √ The velocity and angular velocity in any direction ne
be prescribed, only available for frequency respons
analysis

ed acceleration √ √ The acceleration or angular acceleration in any dire
need to be prescribed, only available for frequency
response analysis

INT CONDITION EDGE BOUNDARY USE WHEN

CONDITION X-DISP Y-DISP Z-DISP X-ROT Y-ROT Z-ROT

x-y symmetry plane √ √ √

y-z symmetry plane √ √ √

x-z symmetry plane √ √ √

x-y antisymmetry plane √ √ √

y-z antisymmetry plane √ √ √

x-z antisymmetry plane √ √ √
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When you select Prescribed displacement a number of new option appears in the dialog 
box and the Constraint page takes on this appearance:

The Constraint page showing the Prescribed displacement options.

The constraint can be described using standard or general notation. This is controlled 
with the Standard notation button and the General notation, Hu=R button.

In standard notation you constrain the displacement and rotations independently. The 
check box in front of Rx, Ry, Rz, Rthx, Rthy, and Rthz activates the constraint, the value/
expression of the displacement can then be entered in the edit fields. The default value 
is 0.

In general notation, the H matrix and the R vector, related by the equation

let you specify constraints as any linear combination of displacement and rotation 
components. You enter the H matrix and the R vector in special matrix dialog boxes 

H

u
v
w
θx

θy

θz

R=
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by clicking the corresponding Edit buttons. For example the condition θx = θy can be 
achieved using the settings

The H Matrix dialog box for the above example is

In a frequency response analysis you have the possibility to specify not only a harmonic 
displacement and rotation but also a harmonic velocity/angular velocity or 
acceleration/angular acceleration. You specify your Prescribed velocity and Prescribed 

acceleration in the same way as Prescribed displacement using Standard notation.

Constraint page showing the Prescribed velocity settings.

H

0 0 0 1 1– 0
0 0 0 0 0 0
0 0 0 0 0 0
0 0 0 0 0 0
0 0 0 0 0 0
0 0 0 0 0

,= R 0
0

=
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Loads

Load is a general name for forces and moments applied to the structure. You can 
specify loads on all domain types. To do so, click the Load tab in the Boundary Settings, 
Edge Settings, and Point Settings dialog boxes. The following picture shows the Point 

Settings dialog box, but the page looks similar on all domain levels. 

In the Boundary Settings and Edge Settings dialog boxes you have an option to specify 
the load in different ways using the thickness. The loads can be defined on different 
domains in the following way. The SI unit is shown in parenthesis.

With the Coordinate system list you control in what coordinate system the load is 
defined. Available options are:

• Tangential and normal coordinate system, only applicable on faces.

• Shell local coordinate system, only applicable on faces.

• Global coordinate system.

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the coordinate system section.

POINT EDGE BOUNDARY/FACE

force (N), 
moment (Nm)

force/area (N/m2), moment/area (N/m) or 
force/length (N/m), moment/length (N)

force/volume (N/m3), 
moment/volume (N/m2) or 
force/area (N/m2), moment/
area (N/m)
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For the frequency response analysis type, additional input is specified. The analysis type 
is controlled from the Application Mode Properties dialog box. When frequency 
response is selected as analysis type, the Load page changes appearance:

For frequency response analysis the harmonic load is split in three different parameters:

• The amplitude value, F

• The amplitude factor, FAmp (a dimensionless number; the default value is 1)

• The phase (FPh). 

Together they define a harmonic load whose amplitude and phase shift can vary with 
the excitation frequency f.

Thermal Coupling

Material expands with temperature, which causes thermal strains to develop in the 
material. The thermal strains together with elastic strains from structural loads form 
the total strain.

where 

Ffreq F FAmp f( ) 2πf FPh f( )+( )cos⋅ ⋅=

ε εel εth+=
A P P L I C A T I O N  M O D E  D E S C R I P T I O N  |  313



314 |  C H A P T E R
Thermal coupling means that the thermal expansion is included in the analysis.

The temperature is assumed to vary linearly through the thickness of the shell.

Thermal effects are specified on the Load page in the Subdomain Settings dialog box.

The Include thermal expansion check box adds thermal effects. In the Temp, Tempref, 
and dT edit fields the strain temperature T, reference temperature Tref, and 
temperature difference through the shell dT are specified. The thermal expansion 
coefficient are specified on the Material page described in the Material section on page 
306. T, Tref, and dT can be any expression and are typically another variable solved for 
in a heat transfer application mode. The temperature coupling can be used in any type 
of analysis.

Damping

In transient and frequency response analyses you have the possibility to model 
undamped or damped problems. In the Structural Mechanics Module you can specify 
damping on the subdomain level using the Damping page that appears in the Boundary 

εth α T Tref–( )=

T T0 ∆T
zl

th
------+=
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Settings dialog box. From the Damping models list you can select No damping, Rayleigh, 
or Loss factor, and the layout of the dialog box changes for each model. 

Damping page when Rayleigh damping is selected.

Note: Loss factor damping is valid only for frequency response analysis. If you choose 
transient analysis and loss factor damping, COMSOL Multiphysics solves the model 
with no damping.

Table 11-1 and the following text describe the parameters that define damping: 

Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

TABLE 11-1:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

αdM alphadM Mass-damping parameter Rayleigh

βdK betadK Stiffness-damping parameter Rayleigh

η eta Loss factor Loss factor
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Loss factor   Defines the loss factor η for the loss factor damping model.

Postprocessing

The predefined postprocessing variables include all nonzero stress and strain tensor 
components, principal stresses and strains, in-plane and out-of-plane forces, bending 
and torsional moments, and von Mises and Tresca effective stresses. The stress and 
strain tensor components and effective stresses can be evaluated at an arbitrary distance 
from the mid surface. This height is controlled from the Postprocessing page in the 
Boundary Settings dialog box.

With the Evaluate at list you control where the stress and strain should be evaluated, 
available options are:

• Top of shell (default)

• Midplane of shell

• Bottom of shell

• Specified height

Select Specified height to specify a postprocessing height explicitly using the height edit 
field.

The displacements and rotations in radians and, for a transient analysis, the velocities 
and angular velocities can be plotted.
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On the Postprocessing page, you can also specify a local coordinate system. The 
evaluation height, including the top and bottom of shell options, refer to the z axis 
direction in this coordinate system. In postprocessing mode some of the 
postprocessing variables can be plotted in the shell local coordinate system (that is, not 
the local coordinate system (t1, t2, n) defined by the geometry face object). The shell 
local system can be used to specify loads and constraints on faces. The local system is 
defined by a point and a vector in the following way:

The point defines the side of the shell to where the local z-axis is pointing. The local 
z-axis coincides either with the normal vector or with its mirror image with respect to 
the surface. See also the figure below. 

A face geometry object has a unit normal vector n with the components nx, ny, and 
nz. The default setting of the point uses these components and the independent 
variables x, y, and z so that the direction of the local z-axis coincides with n. For 
example the x coordinate’s default setting is nx + x. 

The normal of a face geometry object can switch from one face to the next. The point 
is introduced as a means to specify the direction of the local z-axis irrespective of the 
details of the geometry representation. The point specifies the side where the local 
z-axis is positive.

The vector is used for defining the local x-axis. The vector is denoted xlocal and the 
components of the vector are denoted xlocalx, xlocaly, and xlocalz. The xlocal vector is 
projected onto the boundary surface. The projected vector xl defines the direction of 
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the local x-axis. The default settings use the geometry vector t1 as xlocal vector, for 
example the x component’s default setting is t1x.
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P i e z o e l e c t r i c  A p p l i c a t i o n  M o d e s  
This chapter describes the application modes for modeling piezoelectric effects in 
the Structural Mechanics Module.
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Th eo r y  Ba c k g r ound

The Piezoelectric Effect

The piezoelectric effect manifests itself as a transfer of electric to mechanical energy 
and vice-versa. It is observable in many crystalline materials, while some materials such 
as quartz, Rochelle salt, and lead titanate zirconate ceramics display the phenomenon 
strongly enough for the phenomenon to be of practical use.

The direct  piezoelectric effect consists of an electric polarization in a fixed direction 
when the piezoelectric crystal is deformed. The polarization is proportional to the 
deformation and causes an electric potential difference over the crystal.

The inverse piezoelectric effect, on the other hand, constitutes the opposite of the 
direct effect. This means that an applied potential difference induces a deformation of 
the crystal.

P I E Z O E L E C T R I C  C O N V E N T I O N S

The documentation and the user interface use piezoelectric conventions as far as 
possible. These conventions differ from those used in other structural mechanics 
application modes. For instance, the numbering of the shear components in the 
stress-strain relation differs, as the following section describes. However, the names of 
the stress and strain components remain the same as in the other structural mechanics 
application modes.

Piezoelectric Constitutive Relations

It is possible to express the relation between the stress, strain, electric field, and electric 
displacement field in either a stress-charge or strain-charge form:

S T R E S S - C H A R G E

S T R A I N - C H A R G E

T cES eTE–=

D eS εSE+=

S sET dTE+=

D dT εTE+=
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The naming convention differs in piezoelectric theory compared to structural 
mechanics theory, but the piezoelectric application modes use the structural mechanics 
nomenclature. The strain is named ε instead of S, and the stress is named σ instead of 
T. This makes the names consistent with those used in the other structural mechanics 
application modes.

The numbering of the strain and stress components is also different in piezo and 
structural mechanics theory, and it is quite important to keep track of this aspect in 
order to give the correct material data. In structural mechanics the following is the 
most common numbering convention, and it is also the one used in the other 
structural mechanics application modes:

In contrast, textbooks on piezoelectric effects and the IEEE standard on piezoelectric 
effects use the following numbering convention:

The piezoelectric application modes employ the immediately preceding piezo 
numbering convention to make it easier to work with materials data and avoid 
mistakes.

The constitutive relation using COMSOL Multiphysics symbols for the different 
constitutive forms are thus:

σ

σx

σy

σz

τxy

τyz

τxz

= ε

εx

εy

εz

γxy

γyz

γxz

εx

εy

εz

2εxy

2εyz

2εxz

= =

σ

σx

σy

σz

τyz

τxz

τxy

= ε

εx

εy

εz

γyz

γxz

γxy

εx

εy

εz

2εyz

2εxz

2εxy

= =
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S T R E S S - C H A R G E

S T R A I N - C H A R G E

Most material data appears in the strain-charge form, and you can easily transform into 
the stress-charge form. COMSOL Multiphysics allows you to use both constitutive 
forms; simply select one, and COMSOL Multiphysics makes any necessary 
transformations. The following equations transform strain-charge material data to 
stress-charge data

Material Models

In addition to modeling piezoelectric materials, the Piezoelectric application mode 
provides different material models for easier modeling of piezo components. This 
means, that in the subdomain settings of the application mode, you can define the 
material of each domain as: 

• Piezoelectric

• Decoupled, isotropic

• Decoupled, anisotropic

The Piezoelectric material operates as described in the chapter above, whereas using 
the two other material models, you can model structural and electrical problems or 
either of them independently.

The structural part of the Decoupled, isotropic and Decoupled, anisotropic material 
operates as the linear elastic material with small deformations as described in 
“Continuum Application Modes” on page 159“Structural Mechanics Application 

σ cEε eTE–=

D eε ε0εrSE+=

ε sEσ dTE+=

D dσ ε0εrTE+=

cE sE
1–

=

e d sE
1–

=

εS ε0εrT d sE
1– dT

–=
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Modes” on page 59. However, the initial stress and strain and thermal expansion are 
not supported within the Piezoelectric application mode. 

For the Decoupled, isotropic material you define the material using the Young’s 
modulus, E, and the Poisson ratio, ν. For the Decoupled, anisotropic material you 
define the full 6-by-6 elasticity matrix D. Note here, that you define D using the 
standard structural mechanics ordering. Thus the ordering of the D is different from 
the ordering of the piezoelectric cE matrix. 

Depending on the value of the Electrostatics formulation property (See “Electrical 
Formulations”  below), the electrical part of the Decoupled, isotropic and Decoupled, 
anisotropic material solves either the electrostatics equation:

where ε0 is the electrical permittivity of free space, εr is the relative electrical 
permittivity, and ρv is the volume charge density, or the quasi-static electric currents 
equation:

where σe is the electrical conductivity of the material (note that σ is used also for the 
structural stress vector).

In frequency response analysis the conductivity appears also into the electrostatics 
equation:

and thus you can define and use conductivity of the material independently of the 
Electrostatics formulation property.

For a Decoupled, isotropic material you define εr and σe as scalars, but for a Decoupled, 
anisotropic material you define them as 3-by-3 matrices.

Electrical Formulations

The default formulation of the equations in the Piezoelectric application modes is such 
that the resulting equation system with piezoelectric material is symmetric. This allows 
reduced memory requirements with solvers that utilize symmetry information. 

∇ ε0εr∇V( )⋅– ρv=

∇ σe jωε0+ εr( )∇V( )⋅– 0=

∇
σe

jω
------ ε+

0
εr⎝ ⎠

⎛ ⎞∇V⎝ ⎠
⎛ ⎞⋅– ρv=
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The drawback of this design is that by default the Piezoelectric application modes are 
not electrically compatible with the Electrostatics application mode found in the  
AC/DC Module and the MEMS Module, nor is it compatible with the Quasi-Statics 
-Electric, Electric currents application modes in the AC/DC Module.

The Piezoelectric application modes support an application mode property, 
Electrostatics formulation, which makes them compatible with the electrostatic or 
quasi-static application modes so that it is possible to couple them in a model. The 
Electrostatics formulation property has the following choices: 

• Symmetric, Electrostatics: The default implementation creates a symmetric equation 
system, but the application mode is not compatible with the other application 
modes.

• Unsymmetric, Electrostatics: This implementation creates an unsymmetric equation 
system which is compatible with the Electrostatics application modes.

• Unsymmetric, Electric currents: This implementation creates an unsymmetric 
equation system which is compatible with the Quasistatics - Electric, Electric 
currents application modes.

At the equation level the difference between these formulation is the following. The 
default formulation is that the variational electrical energy is written using a positive 
sign:

Here D is the electric displacement vector, and  is the test function for the Electric 
field. Ω is the integration domain.

On the other hand, the formulation compatible with the Electrostatics application 
mode uses variational electrical energy with the negative sign: 

Finally, the electric currents formulation uses the following variational electrical 
energy: 

where J is the electric current density vector, and  is the test function for the 
potential gradient.

δWe D E
ˆ

⋅( ) Ωd∫=

E
ˆ

δWe D E
ˆ

⋅( ) Ωd∫–=

δWe J ∇V̂⋅( ) Ωd∫=

∇V̂
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The use of the Unsymmetric, electric currents formulation sets certain limitations: you 
cannot model any charges, and any boundary conditions that use charges or electric 
displacement are written in terms of electric current. Also, this formulation only 
appears in the frequency response analysis.
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Th e  P i e z o e l e c t r i c  App l i c a t i o n  Mode s

This section describes the interface for defining a model using the piezoelectric 
application modes:

• Piezo Solid (in 3D)

• Piezo Plane Stress (in 2D)

• Piezo Plane Strain (in 2D)

• Piezo Axial Symmetry (in axisymmetric 2D)

It consists of the following sections:

• “Application Mode Properties” (the next section)

• “Scalar Variables” on page 327

• “Material Properties” on page 328

• “Electric Boundary Conditions” on page 338

• “Constraints” on page 342

• “Loads and Charges” on page 344

• “Structural Damping” on page 346

Application Mode Properties

To set or examine material properties, go to the Physics menu and open the Application 

Mode Properties dialog box.

Here you control various global settings for the model, which include:

• Default element type: A list of elements, where the selection becomes the default on 
all new subdomains. The default is to use second-order Lagrange elements.
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• Analysis type: A list of analyses to perform. It affects both the equations and which 
solver to use with the Auto select solver option in the Solver Parameters dialog box. 
The default is static analysis. You can also select transient, eigenfrequency, damped 
eigenfrequency, and frequency response analysis types.

• Specify eigenvalues using: A list controlling whether the application mode works with 
eigenvalues or eigenfrequencies.

• Electrostatics formulation: Select the electrical formulation to use:

- Symmetric, Electrostatic: the default setting.

- Unsymmetric, Electrostatic: for compatibility with the Electrostatics application 
mode.

- Unsymmetric, Electric currents: for compatibility with the application modes for 
electric currents in the AC/DC Module (Electric Currents in 3D, In-Plane 
Electric Currents in 2D, and Meridional Electric Currents in 2D axial symmetry). 
Available for frequency response analysis.

• Weak constraints: Controls whether or not weak constraints are active Use weak 
constraints for accurate reaction-force computation. When weak constraints are 
enabled, all constraints are weak by default, but it is possible to change this setting 
for individual domains.

• Constraint type: Constraints can be ideal or nonideal (see “Ideal vs. Non-Ideal 
Constraints” on page 301 in the COMSOL Multiphysics Modeling Guide).

Scalar Variables

The piezoelectric application modes have the following scalar variables:.

PROPERTY VARIABLE DEFAULT SI UNIT DESCRIPTION

ε0 epsilon0 8.854187817e-12 F/m Permittivity of vacuum

f freq 1e6 Hz Excitation frequency

jω jomega -lambda rad/s Complex angular frequency
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You control the scalar variables by going to the Physics menu and opening the 
Application Scalar Variables dialog box.

The excitation frequency (the frequency of the harmonic forces, potential, and 
displacement) is available only for frequency response analysis. The equations and 
documentation describing frequency response use the angular excitation frequency, 
ω = 2π f, which is available as the variable omega. The complex angular frequency is 
available for eigenfrequency analysis and damped eigenfrequency analysis.

When you select Frequency response as the analysis type, the default solver is the 
parametric solver. This default makes it easy to perform a frequency sweep over several 
excitation frequencies in one analysis. In this case enter freq as the Parameter name on 
the General page in the Solver Parameters dialog box. The values you enter in the 
Parameter values edit field override the excitation frequency you might have entered in 
the Application Scalar Variables dialog box.

Material Properties

The Subdomain Settings window has two pages where you define the material 
properties: the Structural page and the Electrical page. On top of both pages you find 
the Library material list and the Load button for importing and selecting data from the 
material libraries and the Material model list for selecting the material model for each 
domain. These settings are shared between the pages, and if you change the Structural 
page, the settings change also on the Electrical page. Note that loading a material from 
a material library does not change the material model, so you need to change it 
manually in the Material model list to match the type of material.

Everything else you see and define on the pages depends on the material model you 
select. Setting for different material model are described in the following chapters.
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S U B D O M A I N  S E T T I N G S  F O R  P I E Z O E L E C T R I C  M A T E R I A L

The piezoelectric material is a complete structural-electrical material, and thus you 
define all piezoelectric material properties on the Structural page. 

The Structural page has two lists in 3D, three lists in 2D, and three lists in axial 
symmetry:

• Constitutive form: Select the constitutive form from those in the following list. 
Depending on the selection, different material properties are shown in the dialog 
box.

- Stress-charge form: Define the constitutive relation of the material on the 
stress-charge form through the cE, e, and εrS matrices. The previous figure shows 
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the Material page for stress-charge, while the following figure shows the Elasticity 

matrix dialog box for entering the cE matrix.

The figure below shows the Relative permittivity dialog box for entering the εrS 
matrix components.

- Strain-charge form: You define the constitutive relation of the material on the 
strain-charge form through the sE, d, and εrT matrices (see page 322 for details). 
The following figure shows the Material page for strain-charge.

The next graphic shows the Coupling matrix, strain-charge form dialog box for 
entering the d matrix components.

• Material orientation (2D and axisymmetry only): Here you select how the 3D 
 1 2 :  P I E Z O E L E C T R I C  A P P L I C A T I O N  M O D E S



material properties are oriented relative the 2D/axial symmetric analysis plane. 
There are six options: xy, yz, zx, yx, zy, and the default xz-plane. The plane 
represents how the 3D material is oriented relative the 2D/axial symmetric analysis 
plane: The first letter indicates which 3D direction coincides with the x direction in 
2D or the r direction for axisymmetry; the second letter indicates which 3D 
direction coincides with the y direction in 2D or the z direction for axisymmetry. 
The material coordinates names are fixed and do not depend of the names of the 
space coordinates (independent variables), which have different defaults in 2D and 
axial symmetry.

Figure 12-1:Orientation of 3D material xyz relative the 2D analysis coordinate system XYZ.
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Figure 12-2: Orientation of 3D material xyz relative the axisymmetric analysis 
coordinate system r Z.

• Coordinate system: Select the coordinate system where the material properties are 
defined. This choice is useful if you want to define the material in a coordinate 
system other than the global system, or if you need results in a local coordinate 
system for postprocessing. The Coordinate system list contains only the global 
coordinate system unless you have made available a user-defined coordinate system. 
You find the Coordinate System Settings dialog box on the Options menu. Read more 
about creating a coordinate system and how to use it in “Coordinate Systems” on 
page 144.

The following table shows the material properties for the union of all constitutive 
forms and all piezoelectric application modes.

PARAMETER VARIABLE DESCRIPTION CONSTITUTIVE FORM

cE cElk Elasticity matrix Stress-charge

sE sElk Compliance matrix Strain-charge

e eik Coupling matrix, stress-charge form Stress-charge 

d Coupling matrix, strain-charge form Strain-charge
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Elasticity matrix   defines the stress-strain relation matrix cE

 

where σ is the stress, and ε is the strain.

Coupling matrix   defines the piezo coupling matrix e used in the stress-charge form of 
the constitutive equation

 

where σ is the stress, ε is the strain, and E is the electric field.

Compliance matrix   defines the strain-stress relation matrix sE

 

where σ is the stress, and ε is the strain.

Coupling matrix   defines the piezo coupling matrix d used in the strain-charge form of 
the constitutive equation

 

where σ is the stress, ε is the strain, and E is the electric field.

Relative permittivity    the relative permittivity, εrS and εrT, appears in the constitutive 
relation on stress-charge and strain-charge forms, respectively.

 εrS Relative permittivity matrix, 
stress-charge form

Stress-charge

 εrT Relative permittivity matrix, 
strain-charge form

Strain-charge

 ρ rho Density All

 th thickness Thickness of the geometry (2D only) All

PARAMETER VARIABLE DESCRIPTION CONSTITUTIVE FORM

σ cEε=

σ cEε eTE–=

ε sEσ=

ε sEσ dTE+=

D eε ε0εrSE+=

D dσ ε0εrTE+=
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Density   this material property, ρ, specifies the material’s density.

Thickness   this material property, thickness, specifies the material’s thickness and 
appears in 2D only. 

S U B D O M A I N  S E T T I N G S  F O R  D E C O U P L E D ,  I S O T R O P I C  M A T E R I A L

With this material model you specify material properties on the Structural page and the 
Electrical page.

You define the structural material properties on the Structural page: 

On the first row after the Material Model list you find the Enable structural equation 
check box. Use this check box to activate the structural equation or inactivate it to 
model only electrical problems. By default the Enable structural equation check box is 
selected. If this setting is selected you can define the following structural material 
properties: 

Young’s modulus    This material property, E, is the modulus of elasticity of the material. 
It is used to form the elasticity matrix D for the stress strain relationship as described 
in the chapter “Material Models” on page 322.

Poisson’s ratio   This material property, ν, defines the contraction of the structure in the 
perpendicular direction. It is used to form the elasticity matrix D for the stress strain 
relationship as described in the chapter “Material Models” on page 322.

Density   this material property, ρ, specifies the material’s density.
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Thickness   this material property, thickness, specifies the material’s thickness and 
appears in 2D only. 

You define the electrical material properties on the Electrical page: 

On the first row after the Material Model list you find the Enable electrical equation check 
box. Use this check box to activate the electrical equation or inactivate it to model only 
structural problems. If you select it and clear the Enable structural equation check box, 
only the electrical equation is active. By default the Enable electrical equation check box 
is selected. If this setting is selected you can define the following electrical material 
properties: 

Relative permittivity   This material property, εr, defines the isotropic relative electrical 
permittivity of the material.

Electric conductivity   This material property, σ, defines the isotropic electrical 
conductivity of the material. This setting only appears for frequency response analysis.

Thickness   this material property, thickness, specifies the material’s thickness and 
appears in 2D only.

S U B D O M A I N  S E T T I N G S  F O R  D E C O U P L E D ,  A N I S O T R O P I C  M A T E R I A L

With this material model you specify material properties on the Structural page and the 
Electrical page.
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You define the structural material properties on the Structural page: 

On the first row after the Material Model list you find the Enable structural equation 
check box. Use this check box to activate the structural equation or inactivate it to 
model only electrical problems. By default, Enable structural equation is selected. If this 
setting is selected you can define the following structural material properties: 

Material orientation    (2D and axisymmetry only): Here you select how the 3D material 
properties are oriented relative the 2D/axial symmetric analysis plane. There are six 
options: xy, yz, zx, yx, zy, and the default xz. This setting works the way same as for 
the piezoelectric material (See description on page 330).

Coordinate system    Select the coordinate system where the material properties are 
defined. This setting works the way same as for the piezoelectric material (See 
description on page 332).

Elasticity matrix   This material property, D, defines the elasticity matrix of the 
anisotropic material (See “Material Models” on page 322.). You define D as a 
symmetric 6-by-6 matrix: 

Density   this material property, ρ, specifies the material’s density.
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Thickness   this material property, thickness, specifies the material’s thickness and 
appears in 2D only. 

You define the electrical material properties on the Electrical page: 

On the first row after the Material Model list you find the Enable electrical equation check 
box. Use this check box to activate the electrical equation or inactivate it to model only 
structural problems. By default Enable electrical equation is selected. If this setting is 
selected you can define the following electrical material properties:

Material orientation    (2D and axisymmetry only) This is the same setting as the 
Material orientation in the Structural page.

Coordinate system    This is the same setting as the Coordinate system on the Structural 
page.

Relative permittivity   This material property, εr, defines the anisotropic relative 
electrical permittivity of the material. You define εr using a symmetric 3-by-3 matrix: 
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Electric conductivity   This material property, σ, defines the anisotropic electrical 
conductivity of the material. This setting only appears for frequency response analysis. 
You define σ using a symmetric 3-by-3 matrix: 

Thickness   this material property, thickness, specifies the material’s thickness and 
appears in 2D only.

P I E Z O E L E C T R I C  M A T E R I A L S  P R O P E R T I E S  L I B R A R Y

A library of about 25 common piezoelectric materials is available through the Materials/

Coefficients Library dialog box.“Piezoelectric Material Properties Library” on page 110

Electric Boundary Conditions

The electric boundary conditions in the piezoelectric application modes depend on the 
setting of the Electrostatics formulation property in the Application Mode Properties 
dialog box. You specify the electric boundary conditions on the Electric BC page in the 
Boundary Settings dialog box.

The Electric BC page also has a Boundary condition list where you select the type of 
electric boundary condition; the software enables different edit fields depending on 
the selected type.
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B O U N D A R Y  C O N D I T I O N S  F O R  E L E C T R O S T A T I C S

For the Unsymmetric, Electrostatic and Symmetric, Electrostatic formulations, the 
boundary conditions include:

Electric Displacement

This boundary condition specifies the normal component of the electric displacement 
at a boundary. Enter the components of the electric displacement D0.

Surface Charge

 

This boundary condition specifies the surface charge density ρs at an exterior boundary 
(left equation) or at the interior boundary between two media with electric 
displacement D1 and D2, respectively.

Zero Charge/Symmetry

This boundary condition specifies that the normal component of the electric 
displacement is zero. The Zero charge/Symmetry boundary condition is also useful at 
symmetry boundaries where the potential is symmetric with respect to the boundary.

Electric Potential

This boundary condition specifies the voltage V0 at the boundary. Because the 
application mode computes the electric potential, you must define its value at some 
boundary in the geometry to be fully determined.

Ground

This boundary condition is a special case of the previous one specifying zero potential. 
The Ground boundary condition is also be useful at symmetry boundaries, where the 
potential is antisymmetric with respect to the boundary.

Continuity

n D⋅ n D0⋅=

n– D⋅ ρs,= n D1 D2–( )⋅ ρs=

n D⋅ 0=

V V0=

V 0=

n D1 D2–( )⋅ 0=
T H E  P I E Z O E L E C T R I C  A P P L I C A T I O N  M O D E S  |  339



340 |  C H A P T E R
This boundary condition specifies that the normal component of the electric 
displacement is continuous across an interior boundary or across a boundary between 
a piezoelectric and an electrostatic domain if you use the Unsymmetric, Electrostatic 
formulation. Using the Symmetric, Electrostatic formulation the Continuity condition 
is only available for interior boundaries, where it is the default.

Floating Potential
This condition the potential on the boundary to a spatially constant value such that the 
total charge on the boundary equals the user defined total charge Q0:

You also define the group index, which defines how the boundaries are grouped in to 
a set of electrodes.

Axial Symmetry

This boundary condition is the natural Neumann boundary condition, which you use 
on the z-axis (r = 0) to maintain the symmetry conditions. The Axial Symmetry 
boundary condition is available only in the Piezo Axial Symmetry application mode.

B O U N D A R Y  C O N D I T I O N S  F O R  E L E C T R I C  C U R R E N T S

For the Unsymmetric, Electric currents formulations, the boundary conditions 
include:

Ground

This boundary condition is a special case of the previous one specifying zero potential. 
The Ground boundary condition is also be useful at symmetry boundaries, where the 
potential is antisymmetric with respect to the boundary.

Electric Potential

ρs

∂Ω
∫ Q0=

Er 0

r∂
∂Ez 0=

=

V 0=

V V0=
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This boundary condition specifies the voltage V0 at the boundary. Because the 
application mode computes the electric potential, you must define its value at some 
boundary in the geometry to be fully determined.

Current Flow

This boundary condition specifies the current flow. Enter the components of the 
current density J0.

Inward Current Flow

 

This boundary condition specifies the normal current density Jn at an exterior 
boundary.

Electric Insulation

This boundary condition specifies that the normal component of the electric current 
is zero; that is, the boundary is electrically insulated.

Current Source
The current source boundary condition

 

is applicable to interior boundaries that represent either a source or a sink of current.

Continuity

This boundary condition specifies that the normal component of the electric current 
is continuous across the interior boundary (where it is the default setting) or across a 
boundary between a piezoelectric and an domain with electric currents.

Floating Potential
This condition the potential on the boundary to a spatially constant value such that the 
total current through the boundary equals the user defined total current I0:

n J⋅ n J0⋅=

n– J⋅ Jn=

n J⋅ 0=

n J1 J2–( )⋅ Jn=

n J1 J2–( )⋅ 0=

n J⋅–

∂Ω
∫ I0=
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You also define the group index, which defines how the boundaries are grouped in to 
a set of electrodes.

Axial Symmetry
This boundary condition is the natural Neumann boundary condition, which you use 
on the z-axis (r = 0) to maintain the symmetry conditions. The Axial Symmetry 
boundary condition is available only in the Piezo Axial Symmetry application mode.

C O N V E R S I O N  O F  E L E C T R I C  B O U N D A R Y  C O N D I T I O N S

Some boundary conditions are applicable only for the formulations for electrostatics, 
whereas others apply only to the formulation for electric currents. Table 12-1 contains 
the boundary conditions that the software converts when changing from one 
formulation to the other:

Constraints

A constraint specifies the displacement or potential of certain parts of a structure. You 
can define constraints for the displacements on all domain levels including points, 
edges, faces/boundaries, and subdomains (in 3D), and points, boundaries, and 
subdomains (in 2D). In addition, you can define constraints for the potential on points 
and edges in 3D, and for points in 2D. To control them, go to the Constraint page in 
the Subdomain/Boundary/Edge/Point Settings dialog boxes, and set constraints on 
boundaries from the Electric BC page. The following figure shows the Boundary Settings 

TABLE 12-1:  BOUNDARY CONDITION CONVERSIONS

BOUNDARY CONDITION FOR ELECTROSTATICS BOUNDARY CONDITION FOR ELECTRIC CURRENTS

Electric displacement Current flow

Zero charge/Symmetry Electric insulation

Surface charge (exterior boundaries) Inward current flow

Surface charge (interior boundaries) Current source
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dialog box for the Piezo Solid application mode, but the page has the same appearance 
in all piezoelectric application modes.

Use the Constraint condition list in this dialog box to select the type of constraint that 
you want to define. See “Constraints” on page 79 for details.

The Coordinate system list lets you control in which coordinate system you want the 
constraint defined. Available options are:

• Global coordinate system

• Tangent and normal coordinate system, available only on boundaries

• User-defined coordinate systems, if any local coordinate systems are defined. (Read 
more about creating a coordinate system in the section “Coordinate Systems” on 
page 144.)

When you select Prescribed displacement a number of new options appears in the dialog 
box and the Constraint page takes on this appearance:

The Constraint page showing the prescribed displacement options.
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The check boxes adjacent to the Rx, Ry, and Rz edit fields activate the constraint, 
whereupon you enter the value/expression of the displacement (the default value is 0).

In a frequency response analysis you have the possibility to specify not only a harmonic 
displacement but also a harmonic velocity or acceleration. You specify the Prescribed 

velocity and Prescribed acceleration in the same way as Prescribed displacement.

Constraint page showing the prescribed velocity settings.

Loads and Charges

Load is a general name for forces applied to a structure. You can specify loads on all 
domain types. To do so, click the Load tab in the Boundary Settings dialog boxes or the 
Load/Charge tab in the Subdomain Settings, Edge Settings, and Point Settings dialog 
boxes, where you can also specify a charge density. The formulation for electric 
currents does not include charges, so in that case, the name of the tab is Load also in 
the Subdomain Settings, Edge Settings, and Point Settings dialog boxes. The following 
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 (N/m3) 
 (N/m2)

 (N/m3)

 (N/m3)
image shows the Edge Settings dialog box for the Piezo Solid application mode, but the 
tab looks similar on all domain levels in all piezoelectric application modes.

S P E C I F Y I N G  L O A D S

For plane stress and plane strain, option buttons allow you to specify the load in 
different ways using the thickness. The following table summarizes the options for 
defining loads on different domains in different application modes; the SI unit appears 
in parenthesis. 

With the Coordinate system list you control in which coordinate system the load is 
defined. Available options are:

• Global coordinate system

• Tangent and normal coordinate system, only available on boundaries

• User-defined coordinate systems, if there are any local coordinate systems defined. 

Read more about creation of coordinate system in the coordinate system section.

S P E C I F Y I N G  C H A R G E S

You can specify a charge on the Edge/Point level when you use a formulation for 
electrostatics. For plane stress and plane strain, option buttons allow you to specify the 
charge in different ways using the thickness. The following table summarizes the 

APPLICATION MODE POINT EDGE BOUNDARY SUBDOMAIN

Plane Stress,

Plane Strain

force (N) force/area (N/m2) or 
force/length (N/m)

force/volume
or force/area

Axial symmetry total force along the 
circumferential (N)

force/area (N/m2) force/volume

Solid force (N) force/length 
(N/m)

force/area (N/m2) force/volume
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options for defining charge on different domains in different application modes; the SI 
units appears in parenthesis.

To specify charge density on boundaries, click the Electric BC tab.

Structural Damping

For time-dependent analysis, you can specify viscous damping (structural damping) 
using Rayleigh damping, where the damping matrix is specified to be proportional to 
the mass and stiffness matrix:

For frequency response analysis you can specify viscous damping using either Rayleigh 
damping, loss factor damping, or equivalent viscous damping.

APPLICATION MODE POINT EDGE SUBDOMAIN

Plane Stress, 
Plane Strain

charge (C) charge/volume (C/m3) 
or charge/area (C/m2)

Axial symmetry total charge along 
the circumferential 
(C)

charge density (C/m3)

Solid force (C) charge/length 
(C/m)

charge density (C/m3)

C αdMM βdKK+=
 1 2 :  P I E Z O E L E C T R I C  A P P L I C A T I O N  M O D E S



To specify structural damping parameters, go to the Damping page in the Subdomain 

Settings dialog box, and choose the type of damping model from the Damping model 
list. The layout of the dialog box changes for each damping model.

The Damping page when loss factor damping is selected.

Note: Loss factor damping and equivalent viscous damping are valid only for 
frequency response analysis. If you choose a transient analysis and either of these 
damping types, COMSOL Multiphysics solves the model with no damping.

Table 12-2 and the following text describe the parameters that define damping:

Mass damping parameter   Defines the Rayleigh damping model’s mass damping, αdM.

Stiffness damping parameter   Defines the Rayleigh damping model’s stiffness 
damping, βdK.

Loss factor   Defines the loss factor η for the loss factor damping and equivalent viscous 
damping models.

TABLE 12-2:  PARAMETERS FOR DAMPING MODELS

PARAMETER VARIABLE DESCRIPTION DAMPING MODEL

αdM alphadM Mass-damping parameter Rayleigh

βdK betadK Stiffness-damping parameter Rayleigh

η eta Loss factor Loss factor, Equivalent viscous
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The Piezo Solid Application Mode

Use the Piezo Solid application mode for analysis of 3D structures that exhibit 
piezoelectric effects.

V A R I A B L E S  A N D  S P A C E  D I M E N S I O N S

The degrees of freedom (dependent variables) are the global displacements u, v, and 
w in the global x, y, and z directions, and the electric potential, V.

P D E  F O R M U L A T I O N

The implementation of this application mode uses the principle of virtual work, 
described in general terms in the section “Implementation” on page 181.

A P P L I C A T I O N  M O D E  V A R I A B L E S

For information about available application mode variables, see “Piezoelectric 
Application Modes” on page 58 in the Structural Mechanics Module Reference 
Guide.

The Piezo Plane Stress Application Mode

Use the Piezo Plane Stress application mode to analyze thin in-plane loaded plates that 
exhibit piezoelectric effects.

V A R I A B L E S  A N D  S P A C E  D I M E N S I O N S

The degrees of freedom (dependent variables) are the global displacements u and v in 
the global x and y directions, and the electric potential V.

P D E  F O R M U L A T I O N

The implementation of this application mode uses the principle of virtual work, which 
this manual describes in general terms in the section “Implementation” on page 181.

Application Mode Parameters
For details about the application mode parameters that define the loads, charges, 
material properties, constraints, and electric boundary conditions, see the sections 
earlier in this chapter.

A P P L I C A T I O N  M O D E  V A R I A B L E S

For information about available application mode variables, see “Piezoelectric 
Application Modes” on page 58 in the Structural Mechanics Module Reference 
Guide.
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The Piezo Plane Strain Application Mode

Use the Piezo Plane Strain application mode to compute the global displacements (u, 
v) in the x and y directions and the electric potential for a piezoelectric structure in a 
state of plane strain. The plane strain condition assumes that the εz, εyz, and εxz 
components of the strain tensor are zero.

VA R I A B L E S  A N D  S P A C E  D I M E N S I O N S

The degrees of freedom (dependent variables) are the global displacements u and v in 
the global x and y directions, and the electric potential V.

P D E  F O R M U L A T I O N

The implementation of this application mode uses the principle of virtual work, 
described in general terms in the section “Implementation” on page 181.Application 
Mode Parameters
For details about the application mode parameters that define the loads, charges, 
material properties, constraints, and electric boundary conditions, see the sections 
earlier in this chapter.

A P P L I C A T I O N  M O D E  V A R I A B L E S

For information about available application mode variables, see “Piezoelectric 
Application Modes” on page 58 in the Structural Mechanics Module Reference 
Guide.

The Piezo Axial Symmetry Application Mode

Use the Piezo Axial Symmetry application mode to analyze axisymmetric models of 
materials showing piezoelectric effects.

This application mode uses cylindrical the coordinates r, (phi), and z. It solves the 
equations for the global displacement (u, w) in the r and z directions. It assumes that 
the displacement v in the direction together with the , , , and  
components of the stresses and strains are zero. Loads are independent of , and it 
allows loads only in the r and z directions.

You can consider the domain where the software solves the equations as the 
intersection between the original axially symmetric 3D solid and the half plane , 
r ≥ 0. Therefore it is necessary to draw the geometry only in the half plane r ≥ 0. The 

ϕ

ϕ τrϕ τϕz γrϕ γϕz
ϕ

ϕ 0=
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software recovers the original 3D solid by rotating the 2D geometry about the z-axis 
as seen in the following figure:

The strain-displacement relations for the axial symmetry case for small displacements 
are:

To avoid division by r (which causes problems on the axis, where r = 0), the program 
automatically transforms the equations by multiplying by r. When using the principle 
of virtual work, you normally do not think of this multiplication as a transformation 
but merely as an integration around the circumference. Integrating over the volume, 
you must multiply the integrand by 2π r. The application mode introduces and solves 
for a new dependent variable

instead of the true radial displacement, u.

Note: r = 0 is the symmetry axis. x -> r and y -> z in the Piezo Axial Symmetry, 
application mode.

εr r∂
∂u

= εϕ
u
r
---= εz z∂

∂w
= γrz z∂

∂u
r∂

∂w
+=

uor u
r
---=
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VA R I A B L E S  A N D  S P A C E  D I M E N S I O N S

The degrees of freedom (dependent variables) are uor the radial displacement divided 
by r and w the global displacement in the z direction and the electric potential V.

P D E  F O R M U L A T I O N

The implementation of this application mode uses the principle of virtual work, 
described in general terms in the section “Implementation” on page 181.

Application Mode Parameters
For details about the application mode parameters that define the loads, charges, 
material properties, constraints, and electric boundary conditions, see the sections 
earlier in this chapter.

A P P L I C A T I O N  M O D E  V A R I A B L E S

For information about available application mode variables, see “Piezoelectric 
Application Modes” on page 58 in the Structural Mechanics Module Reference 
Guide.
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P r e d e f i n e d  M u l t i p h y s i c s  C o u p l i n g s
The Structural Mechanics Module contains predefined multiphysics couplings to 
facilitate easy set up of models with the most commonly occurring couplings. These 
predefined multiphysics couplings automatically add the necessary application 
modes with appropriate settings to your model and define the applicable couplings 
for the interaction between the different types of physics.
 353
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Th e rma l - S t r u c t u r e  I n t e r a c t i o n

The Thermal-Structure Interaction predefined multiphysics coupling combines a 
continuum application mode from the Structural Mechanics Module with a heat 
transfer application mode from the Heat Transfer Module or COMSOL Multiphysics. 
The coupling appears on the subdomain level, where the temperature from the heat 
transfer application mode acts as a thermal load for the structural mechanics 
application mode.

Theory Background

Read about constitutive equations including thermal expansion in the section dealing 
with the theory background for the continuum application modes, on page 164 of this 
manual.

Application Mode Description

A combination of the following two application modes make up the 
Thermal-Structure Interaction predefined coupling:

• A continuum application mode from the Structural Mechanics Module:

- Plane Strain or Plane Stress in 2D

- Axial Symmetry, Stress-Strain in 2D axisymmetry

- Solid, Stress-Strain in 3D

• The General Heat Transfer application mode from the Heat Transfer Module, if 
your license includes that module, or the Heat Transfer, Conduction application 
mode from COMSOL Multiphysics

This section describes settings specific to the Thermal-Structure Interaction 
predefined multiphysics coupling. Use the following table to locate the sections 
describing the individual application modes.

APPLICATION MODES APPLICATION MODE DESCRIPTION

Continuum application modes, 
Structural Mechanics Module

page 159
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A N A L Y S I S  TY P E

There are three available analysis types in the Model Navigator: a static analysis type, 
which uses the stationary solver, and the transient and quasi-static analysis types, which 
use the time-dependent solver.

S U B D O M A I N  S E T T I N G S

Both application modes of this predefined multiphysics coupling are active on all 
subdomains of the model. Thermal expansion is enabled for all subdomains in the 
structural mechanics application mode. In the graphical user interface, you can find 
this on the Load page of the Subdomain Settings dialog box for the structural mechanics 
application mode, where the predefined coupling automatically selects the Include 

thermal expansion check box. On the same page, the expression in the Temp edit field 
is the dependent variable for temperature from the heat transfer application mode, 
typically T.

B O U N D A R Y  S E T T I N G S

The Thermal-Structure Interaction predefined coupling does not define any coupled 
constraints or loads on the boundaries. You can set those individually for the structural 
and thermal analyses.

Example Model

See Chapter 15, “Thermal-Structure Interaction,” of the Structural Mechanics 
Module Model Library for models that exemplify thermal-structure interaction.

General Heat Transfer, Heat Transfer 
Module

page 22 in the Heat Transfer Module 
User’s Guide

Heat Transfer, Conduction, COMSOL 
Multiphysics

page 167 in the COMSOL 
Multiphysics Modeling Guide

APPLICATION MODES APPLICATION MODE DESCRIPTION
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F l u i d - S t r u c t u r e  I n t e r a c t i o n

The Fluid-Structure Interaction (FSI) predefined multiphysics coupling combines 
fluid flow with structural mechanics by using a Moving Mesh (ALE) application mode 
to capture the movement of the fluid domain. The structural mechanics application 
mode uses the large-deformation option, and the fluid flow application mode enables 
weak constraints that provide the fluid loads on the structure. The fluid flow 
application mode is defined on an ALE frame, whereas the structural mechanics 
application mode for the solid is defined on a reference frame. The FSI couplings 
appear on the boundaries between the fluid and the solid, and there are also predefined 
settings for the subdomain properties. These settings are grouped into easily 
identifiable groups that you assign to the relevant subdomains and boundaries.

Theory Background

The fluid flow is described by the Navier-Stokes equations (Equation 6-1 in the 
COMSOL Multiphysics Modeling Guide), which provide a solution for the velocity 
field u. The total force exerted on the solid boundary by the fluid is the negative of 
the reaction force on the fluid,

 (13-1)

where p denotes pressure, η the dynamic viscosity for the fluid, n the outward normal 
to the boundary, and I the identity matrix. Because the Navier-Stokes equations are 
solved in the spatial (deformed) coordinate system while the structural mechanics 
application modes are defined in the reference (undeformed) coordinate system, a 
transformation of the force is necessary. This is done according to

 (13-2)

where dv and dV are the mesh element scale factors for the spatial frame and the 
reference frame, respectively.

The FSI predefined multiphysics coupling computes the reaction force on the fluid by 
turning on the weak constraints option for the fluid application mode, which adds 
Lagrange multipliers as additional dependent variables. Due to the derivatives present 
in the boundary condition for the velocity field, non-ideal weak constraints are used. 

f n– pI η u∇ u∇( )T
+( )+( )⋅=

F f dv
dV
--------⋅=
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You can read about weak constraints in the section “Using Weak Constraints” on page 
300 of the COMSOL Multiphysics Modeling Guide.

Application Mode Description

A combination of the following three application modes make up the FSI predefined 
multiphysics coupling:

• A continuum application mode from the Structural Mechanics Module:

- Plane Strain in 2D

- Axial Symmetry, Stress-Strain in 2D axisymmetry

- Solid, Stress-Strain in 3D

• Moving Mesh (ALE) from COMSOL Multiphysics

• The Incompressible Navier-Stokes application mode from the Chemical 
Engineering Module, if the license includes that module, or from COMSOL 
Multiphysics

This section describes settings specific to the FSI predefined coupling. Use the 
following table to locate the sections describing the individual application modes.

P R O P E R T I E S

The FSI predefined multiphysics coupling change some of the application mode 
properties from their default settings according to the following table:

APPLICATION MODES APPLICATION MODE DESCRIPTION

Continuum application modes, 
Structural Mechanics Module

page 159

Moving Mesh (ALE), COMSOL 
Multiphysics

page 391 in the COMSOL 
Multiphysics Modeling Guide

Incompressible Navier-Stokes, 
COMSOL Multiphysics

page 130 in the COMSOL 
Multiphysics Modeling Guide

APPLICATION MODE PROPERTY SETTING

Continuum application modes Large deformation On

Moving Mesh (ALE) Smoothing method Winslow

Incompressible Navier-Stokes

Weak constraint Off

Constraint type Non-ideal
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A N A L Y S I S  TY P E

There are two available analysis types in the Model Navigator, a static analysis that uses 
the stationary solver and a transient analysis that uses the time-dependent solver.

S U B D O M A I N  S E T T I N G S

From within the Subdomain Settings dialog box for each application mode, you can 
assign a group of settings to each subdomain by selecting it from the Group list. The 
following groups are available:

• Fluid domain. This group contains subdomain settings for the fluid domain.

- In the structural mechanics application mode, this group makes this application 
mode inactive.

- In the Incompressible Navier-Stokes application mode, this group uses the 
default properties for the fluid. Change these properties to match the fluid in 
your model.

- In the Moving Mesh (ALE) application mode, this group defines free mesh 
displacement

• Solid domain. This group contains subdomain settings for the solid domain.

- In the structural mechanics application mode, this group uses the default 
properties for the solid. Change these properties to match the solid in your 
model.

- In the fluid flow application mode, this group makes this application mode 
inactive.

- In the Moving Mesh (ALE) application mode, this group defines physics-induced 
mesh displacement using the displacements from the structural mechanics 
application mode. Note that in 2D axisymmetry, these displacements are defined 
as prescribed mesh displacements because the dependent variables in the Axial 
Symmetry, Stress-Strain application mode differ from the actual displacements, 
which instead are available as variables. The following table shows the applied 
settings for the different space dimensions.

SPACE DIMENSION SELECTION EDIT FIELD EXPRESSION

2D Physics induced displacement dx u

dy v

3D Physics induced displacement dx u

dy v

dz w
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B O U N D A R Y  S E T T I N G S

You can apply predefined boundary settings by selecting a group from the Group list in 
the Boundary Settings dialog box for the application modes. Each of the following 
groups is available only in one of the application modes:

• Fluid load. This group, found in the structural mechanics application mode, defines 
the fluid load on the structure using the variable for the total force per area times a 
factor for the area effect, for example, T_x_ns*dvol_ale/dvol. The expression 
includes a factor for the area effect because the total force variable comes from the 
deformed mesh, whereas the forces in the structural mechanics application mode 
must be based on the undeformed area. This factor is the mesh element scale factor 
for the ALE frame divided by the mesh element scale factor for the reference frame. 
Also, for axisymmetric models, an additional factor (R+uaxi)/R takes the radial 
displacement into account.

• Structural velocity. This group, found in the fluid flow application mode, is only 
applicable for transient analysis, where the time derivatives of the structural 
displacements define the fluid’s velocity. Moving leaking wall is set as Boundary 

condition with components according to the following table.

2D axial symmetry Prescribed displacement dr uaxi_smaxi

dz w

SPACE DIMENSION EDIT FIELD EXPRESSION

2D uw ut

vw vt

3D uw ut

vw vt

ww wt

2D axial symmetry uw uaxi_t_smaxi

vw wt

SPACE DIMENSION SELECTION EDIT FIELD EXPRESSION
F L U I D - S T R U C T U R E  I N T E R A C T I O N  |  359



360 |  C H A P T E R
• Structural displacement. Use this setting in the Moving Mesh (ALE) application 
mode at the boundaries of the solid domain. The settings define the mesh 
displacements as the structural displacements, according to the table below.

• Fixed. This group, found in the Moving Mesh (ALE) application mode, defines the 
mesh displacements to be zero. Use this setting at the exterior boundaries of the 
fluid domain.

In addition to the above predefined settings, you typically define standard boundary 
conditions such an inflow velocities, slip, and no-slip conditions in the fluid flow 
application mode and one or several fixed boundaries in the structural mechanics 
application mode.

Example Model

“Obstacle in Fluid” on page 417 in the Structural Mechanics Module Model Library 
demonstrates a 3D static FSI simulation.

SPACE DIMENSION EDIT FIELD EXPRESSION

2D dx u

dy v

3D dx u

dy v

dz w

2D axial symmetry dr uaxi_smaxi

dz w
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F a t i g u e  A n a l y s i s
This chapter describes how to perform fatigue analysis using the Structural 
Mechanics Module together with COMSOL Script or MATLAB.
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Ba c k g r ound and I n t r o du c t i o n  t o  
F a t i g u e  Ana l y s i s

The term fatigue is used for describing the phenomenon where a component fails after 
repeated loadings and unloadings, even though the magnitude of each individual load 
is smaller than the ultimate stress of the material. The term was coined in the middle 
of the nineteenth century, when a number of railroad accidents draw attention to the 
subject. A vast majority of all structural failures even today are attributed to fatigue, so 
dimensioning against fatigue is of the utmost importance.

When a fatigue failure occurs, the process can be divided into three stages:

1 During a large number of load cycles (repeated loadings and unloadings), damage 
is accumulated on the micromechanical scale, and after some time a crack of 
macroscopic size is formed.

2 The macroscopic crack grows for each new load cycle.

3 When the crack has reached a certain size, the remaining material can no longer 
sustain the peak load, and the component fails.

Usually, the last two stages are considered within the topic of fracture mechanics, and 
the term fatigue applies mainly to Stage 1. Because the largest part of the life of the 
component is spent before it is possible to observe a macroscopic crack, most designs 
aim to avoid ever getting such a crack.

Phenomenology and Testing

The underlying reason for fatigue must be sought on the micromechanical scale, on 
which materials are not homogenous. In an alloy there are grains, whose boundaries 
cause stress concentrations. In a casting, there might even be pores that are formed 
during the solidification. Thus, on a local scale, the strains might be much larger than 
their macroscopic average values, and dislocations within the crystals are activated.

Because the location of these micromechanical irregularities are more or less randomly 
distributed, there is a large scatter in the number of cycles that a certain type of 
component can be subjected to, even if the external load is well defined. This scatter 
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makes it necessary to test many specimens when looking for fatigue data. Two 
examples of these statistical effects are:

• If two sets of bars with different diameters are tested in tension with the same 
nominal stress, the larger one will appear to have a shorter lifetime. The reason is 
that within a larger volume of material, the risk of finding a microscopic defect of a 
certain size is larger.

• If the same type of bar is tested in both tension and bending giving the same peak 
stress, the one tested in bending will appear to have longer lifetime. During bending 
only a small volume of the material is subjected to the highest stress.

A pioneer in the field of fatigue was the German engineer August Wöhler who 
presented a classical work in 1870. His name is used for diagrams showing stress 
amplitude (see Equation 14-2 on page 364) versus number of cycles to fatigue. They 
are called Wöhler curves or S-N curves. An example appears in Figure 14-1

Figure 14-1: Example of an S-N curve.

You usually obtain an S-N curve by testing at different stress levels and recording the 
number of cycles to failure. Several specimens are tested at each level, so that average 
and scatter can be computed, giving one point of the curve. Note that because the S-N 
curve gives the level at which a certain percentage (often 50%) of a population can be 
expected to fail, that value cannot always be directly used for dimensioning. 
Knowledge of the scatter in terms of the standard deviation is necessary to transform 
the given data to another, acceptable, level. For a certain number of cycles, a certain 
stress level is then connected to a probability of failure. The acceptable probability (and 
thus stress level) in a design of course differs between a passenger aircraft and a lawn 
mower.
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There are two different regimes of the fatigue phenomena: Low-cycle fatigue (LCF) 
and high-cycle fatigue (HCF). The border between the two is in no way exact, but 
usually a cycle count larger than 104 is considered as “high cycle.” Characteristic of 
LCF is that significant plastic strains occur on the macroscopic scale.

For some materials (for example, many steel and titanium alloys) a lowest stress level 
exists, below which fatigue does not occur irrespective of the number of load cycles. 
This level is called the fatigue limit or endurance limit. Many other materials such as 
aluminum and copper do not appear to have such a limit.

For a material having a fatigue limit, the S-N curve has a horizontal asymptote at large 
cycle numbers. Fatigue limits are often of the order of half the ultimate tensile 
strength.

Even for a material without a fatigue limit, such values are sometimes given. They 
actually represent the value of the S-N curve at a certain large number of cycles, for 
example, 5·107.

It is often possible to represent the central part of the S-N curve (which is in the HCF 
regime) by a straight line in a log-log diagram. This relation is called the Basquin 
equation, which states that

 (14-1)

Here Nf is the number of load reversals, so that 2Nf is the number of full cycles. σ´f 
and b are material parameters.

D E F I N I T I O N S  O F  F A T I G U E  Q U A N T I T I E S

In addition to the stress amplitude, the mean stress is also important for when fatigue 
cracks appear. A tensile mean stress decreases the fatigue life, while a compressive stress 
increases it. If σmax is the maximum stress over the cycle, and σmin is the minimum 
stress, the following definitions are used:

Stress amplitude:

 (14-2)

Stress range

 (14-3)

Mean stress:

σa σ'f 2Nf( )b
=

σa
σmax σmin–

2
--------------------------------=

∆σ σmax σmin–=
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 (14-4)

R-value:

 (14-5)

The R-value is the most commonly used parameter for describing the mean stress level.

The most common fatigue test is the one where the loading is fully reversed, that is 
having a zero mean stress (R = −1). The second fundamental test is the pulsating test, 
where the load varies between zero and a maximum value (R = 0). For cases with 
nonzero mean stresses, note that the S-N curve can be defined in terms of either the 
stress amplitude or the maximum stress. The functions used in the Structural 
Mechanics Module is specified through the stress amplitude and R-value.

Figure 14-2: Example of cyclic loading.

M E A N  S T R E S S  E F F E C T S

The mean stress effects can be represented in a Haigh diagram, a plot of the stress 
amplitude versus the mean stress for different number of load cycles (see Figure 14-3). 
Unfortunately, it is rare that enough data are available, so in practice rather crude 
simplifications are made. The most common mean stress corrections are the Goodman 
and the Gerber corrections. The Goodman correction approximates the curve in the 
Haigh diagram by a straight line, and the Gerber correction approximates it by a 
parabola. The simplified diagram appears in Figure 14-4. If data is available for both 

σm
σmax σmin+

2
---------------------------------=

R
σmin
σmax
-------------=
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R = −1 and R = 0, it is possible to use the bilinear approximation that Figure 14-4 also 
includes.

Figure 14-3: An example of a Haigh diagram.
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Figure 14-4: Simplified Haigh diagram.

There are a number of other factors that can affect the S-N curves:

• Environmental effects. A corrosive environment is negative for the fatigue life. A 
material usually having a fatigue limit might have none in a corrosive environment.

• Surface finish. Most data are obtained from polished specimens. Because 
microscopic irregularities are involved in the formation of fatigue cracks, a rough 
surface decreases fatigue life.

• Statistical size effects, as described earlier in this section.

• Residual stresses from manufacturing. This is sometimes used intentionally, for 
example, by shot peening that results in beneficial compressive stresses in the surface 
of the component.

L O W - C Y C L E  F A T I G U E

Low-cycle fatigue is sometimes referred to as “strain based.” The reason is that the 
relevant parameter for describing LCF is strain rather than stress. Note though that 
physically it is the strain that does the damage in HCF as well. Because HCF occurs in 
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the elastic regime, it is possible to use either stress or strain as the parameter, but the 
use of stress has historical and practical reasons.

The LCF analogy to the Basquin equation is the Coffin-Manson equation

 (14-6)

where ∆εp is the plastic strain range, and ε´f and c are material parameters. The 
implication is that the plastic strain range is a straight line when plotted in a log-log 
S-N–type diagram against the number of cycles.

It is also possible to combine the Basquin and Coffin-Manson equations into a single 
expression, covering the entire range of LCF and HCF:

 (14-7)

The first term represents the elastic strain, the second the plastic strain, and ∆ε is the 
total strain range. The following table lists the parameters in Equation 14-7.

PARAMETER DESCRIPTION

Fatigue ductility coefficient

Fatigue ductility exponent

Fatigue strength coefficient

Fatigue strength exponent

∆εp
2

--------- ε'f 2Nf( )c
=

∆ε
2

------
σ′f
E
------- 2Nf( )b ε′f 2Nf( )c

+=

εf′

c

σf′

b
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Figure 14-5: Strain-life curve.

As a criterion of the limit between LCF and HCF, you can use the transition life 2Nt. 
It is the intersection between the lines formed by the Basquin and the Coffin-Manson 
curves.

Because plastic strains are important in LCF, analysis of such problems are more 
complex than the analysis of the corresponding HCF problem. The plastic strain must 
be obtained either from a full elasto-plastic analysis, or from some kind of extrapolation 
of an elastic analysis.

Loading Aspects

So far, the only load considered has constant amplitude, and the effect of it is a uniaxial 
stress.

In reality, the loads often have variable amplitude, and possibly also varying mean 
stress. The reason can be either that the service cycle contains several different well 
defined loadings, or that the load is random by its nature.

It is known that the order in which different loads are applied can have an effect, but 
most fatigue analyses ignore this fact due to the difficulties involved in such an analysis. 
Instead they treat the effect of each load as independent.
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Assume that you have a set of stress cycles with amplitude/mean value pairs. Using the 
linear cumulative damage rule attributed to Palmgren and Miner, each such pair 
produces a relative damage

 (14-8)

where Ni is the number of cycles to fatigue if only loads from pair i were acting.

In practice, all pairs with similar values are grouped together in classes (“bins”), 
represented by its class midpoint. If the number of cycles stored in bin i is ni, the 
corresponding relative damage is

 (14-9)

The limit for the possible fatigue life is then given by

 (14-10)

which implies infinite fatigue life for cases where this sum is less than 1.

For a random load, some type of cycle counting over a representative time interval 
must be used. This can be done from true measurements, or from a synthesized load 
history if the statistical properties of the load are known. The most commonly used 
method is called rainflow counting (Ref. 1), a procedure indicated in Figure 14-7. In 
the Structural Mechanics Module it is possible to perform a rainflow count on an 
arbitrary signal and split it into any number of amplitude/mean value pairs.

Figure 14-6: An example of a random load.

di
1

Ni
------=

di
ni

Ni
------=

ni

Ni
------

i
∑ 1=
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Figure 14-7: Rainflow counting of the cycles for the random load in the previous figure.

In real-life components the stress state is often multiaxial, in the sense that more than 
one principal stress is nonzero. Triaxial states of stress are unusual in this context, 
however, because fatigue cracks tend to appear on free surfaces, which by definition 
have a state of plane stress. The main exception is where contacting surfaces cause 
compression, so that fatigue cracks may instead develop below the surface.

If the directions of the principal stresses are fixed and the ratio between the principal 
stresses remain constant over the load history, the loading is said to be proportional. 
The problem is then just a matter of transforming uniaxial material data to biaxial 
material data.

In order for the opposite case, nonproportional loading, to occur, at least two 
independent loads must act on the structure. If the components of the stress tensor at 
the point of consideration do not only differ by a scale factor when the individual loads 
are applied, the loading is nonproportional. You find a simple case with 
nonproportional loading in the shaft_with_fillet model on page 346 in the 
Structural Mechanics Module Model Library.
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If, however, the principal axes rotate between the loadings, the situation is much more 
complex. There are many methods suggested in the literature, both for LCF and HCF. 
A family of methods known as critical plane methods are popular, and are used in the 
Structural Mechanics Module, more information and details are found on page 374. 
In a critical plane method, some failure criterion is evaluated in all possible directions 
at a certain material point, and the maximum value is used.

Design Strategies

There are several possible strategies when designing components subjected to 
alternating loads.

1 Design for infinite lifetime by keeping the stresses sufficiently low. “Infinite” should 
here be interpreted as much longer than the service life of the component, so the 
method can be used also for a material without fatigue limit. This is the most 
common approach, and is preferred as long as it is not unfeasible.

2 Design for a fixed life (with sufficiently large factor of safety), after which the 
component is replaced.

3 Damage tolerant design, where the structure is inspected for cracks at regular 
intervals. In this case it is the growth rate of macroscopic cracks that sets the limit 
of the inspection interval, and fracture mechanics methods must be used in the 
analysis.

Summary
As a summary, it is necessary to answer the following questions when performing a 
fatigue analysis:

• Low-cycle or high-cycle fatigue?

• If low-cycle fatigue; will an elastic analysis be sufficient or is an elasto-plastic analysis 
required? An LCF analysis with both methods is shown in the 
cylinder_with_hole model on page 372 in the Structural Mechanics Module 
Model Library.

• Will the load have constant or variable amplitude? In the later case cumulative 
damage summing is required.

• Will the principal axes of the strain tensor be approximately constant or will they 
change between loadings?

• Are reliable material data available? How large is the scatter, and what risk of failure 
is acceptable?
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Using the Structural Mechanics Module, it is possible to analyze both LCF and HCF 
problems. The procedure always starts with a stress analysis, and you then perform the 
evaluation against fatigue criteria as a separate postprocessing step. The fatigue analysis 
tools can handle the following types of loading:

• Proportional loading with constant amplitude

• Nonproportional loading with constant amplitude

• Proportional loading with nonconstant amplitude
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How t o  P e r f o rm Fa t i g u e  Ana l y s i s

This section provides a detailed description of how to perform fatigue analysis using 
the Structural Mechanics Module. The theoretical background to the different fatigue 
models is also explained.

High-Cycle Fatigue

High-cycle fatigue typically means that the number of load cycles exceeds 104. The 
loading can be divided in nonproportional and proportional loading. The functions in 
the Structural Mechanics Module performing high cycle fatigue analysis are:

• fatiguedamage (see page 174 for details)

• hcfmultiax (see page 177 for details)

S - N  C U R V E S  ( W Ö H L E R  C U R V E S )

Fatigue data for high cycle fatigue are often given as S-N curves—often referred to as 
Wöhler curves—where the stress amplitude S (σa) is given as a function of the number 
of cycles to fatigue, N. Figure 14-8 shows a typical S-N curve. An S-N curve is 
experimentally determined.

Figure 14-8: S-N curve for high-strength Iron Alloy UNS 4340.

The S-N curve depends on the mean stress, which can be characterized by the R value 
defined as
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 (14-11)

Here σmin is the minimum stress value and σmax is the maximum stress value. The 
stress amplitude, σa, is defined as

 (14-12)

The most common fatigue tests are done for alternating loads (R = −1) and pulsating 
loads (R = 0). The allowable stress amplitude decreases with increasing R value.

Figure 14-9: S-N curves for different R-values.

The function fatiguedamage requires the S-N data to be given as names of functions. 
The functions need to reside in a directory included in the COMSOL Script or 
MATLAB path. Input to the S-N curve is the number of cycles, output is the stress 
amplitude to fatigue for the given number of cycles. Examples of such a function is 
sn_mat1_r_min1 included in the Structural Mechanics Module:

function stressAmp = sn_mat1_r_min1(n)
%SN_MAT1_R_MIN1 Compute stress amplitude to fatigue from number of cycles for
%               4340 (UNS G43400)
%               UTS 200 Ksi - 293K
%               R=-1; unnotched
%
%   STRESSAMP = SN_MAT1_R_MIN1(N) calculates the stress amplitude STRESSAMP 
to fatigue
%   from the number of cycles N

%   Copyright (c) 1994-2007 by COMSOL AB

nExpr = 1;

R
σmin
σmax
-------------=

σa
1
2
--- σmax σmin–( )=
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exprs{1} = (6.134267E-02*log(n)^4 - 3.981468E+00*log(n)^3 + 
1.000292E+02*log(n)^2 - 1.158936E+03*log(n) + 5.683208E+03)*1.000000e+006;
intervals(1) = 8.000000e+003;
intervals(nExpr+1) = 2.000000e+007;

n = n ;
if (n <= 8.000000e+003 )
  n = 8000;
  stressAmp = (6.134267E-02*log(n)^4 - 3.981468E+00*log(n)^3 + 
1.000292E+02*log(n)^2 - 1.158936E+03*log(n) + 5.683208E+03)*1.000000e+006;
elseif (n >= 2.000000e+007);
  n = 20000000;
  stressAmp = (6.134267E-02*log(n)^4 - 3.981468E+00*log(n)^3 + 
1.000292E+02*log(n)^2 - 1.158936E+03*log(n) + 5.683208E+03)*1.000000e+006;
else
  if (n > 8.000000e+003 & n <= 2.000000e+007)
    stressAmp = (6.134267E-02*log(n)^4 - 3.981468E+00*log(n)^3 + 
1.000292E+02*log(n)^2 - 1.158936E+03*log(n) + 5.683208E+03)*1.000000e+006;
  end 
end 
r = -1.000000e+000;
stressAmp = stressAmp*(1-r)/2;

The fatigue data in the example above is extracted from the COMSOL Material 
Library, which is an add-on product to COMSOL Multiphysics. This is done using the 
matlibfatigue function. For details see matlibfatigue on page 184 in the 
Structural Mechanics Module Reference Guide.

Note: The S-N curves in the Material Library are given on the form σmax as function 
of number of cycles, but the fatigue functions in the Structural Mechanics Module 
requires σa as function of the number of cycles. The transformation is automatically 
handled by the matlibfatigue function.

Using Equation 14-11 and Equation 14-12, σa can be calculated from σmax as

 (14-13)

For R values between two specified S-N curves, the values are calculated by 
interpolating between the two S-N curves. You pass the R values for the specified S-N 
functions to the fatiguedamage function using the rvalue property.

For R values outside the available S-N curves a mean stress correction is calculated by 
interpolating the value for R = − 1 and then using the mean stress correction method 

σa σmax
1 R–( )

2
------------------=
 1 4 :  F A T I G U E  A N A L Y S I S



specified through the method property to the fatiguedamage function. The same 
applies if you only have the S-N curve for R = − 1. There are different mean stress 
correction theories to use if you only have fatigue data for R = − 1, that is, an 
alternating load. The Structural Mechanics Module supports two such methods: 
Gerber and Goodman. The methods are based on the ratio between mean stress and 
the ultimate stress σuts. Figure 14-10 compares the stress amplitude as function of the 
mean stress for the two methods.

Figure 14-10: Mean stress compensation for the Gerber and Goodman methods for a 
material with an ultimate stress of 1000 MPa and an endurance limit of 300 MPa for 
alternating loads.

You specify the ultimate stress to the fatiguedamage function using the params 
property.

N O N P R O P O R T I O N A L  L O A D I N G ,  C O N S T A N T  A M P L I T U D E

Use the function hcfmultiax for this type of analysis. The properties in the following 
section refer to the hcfmultiax function.

Theory Background
Nonproportional loading is defined as any state of time-varying stress in which the 
orientations of the principal stress axes change with respect to axes that are fixed with 
respect to the component. A simple example of nonproportional loading is a shaft 
exposed to both cyclic bending and torsion.

The critical plane is defined as the plane where the fatigue crack occurs. Different 
models use different criteria to determine the critical plane. A successful model must 
be able to predict both the fatigue life and the dominant failure plane. For 
nonproportional loading you need to examine the loading history for all possible 
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planes (directions) in order to find the critical plane. A critical plane model evaluates 
the stresses on different planes (directions) in the material and maximizes some type of 
damage criterion with respect to all possible directions. You control the resolution of 
the direction search with the property anglestep. anglestep is the step in angle 
subdividing the longitude of the unit sphere and controlling the subdivision in the 
latitude direction. This means that the number of searches are inversely proportional 
to the square of the step. The critical plane model in the Structural Mechanics Module 
is the Findley criterion. It can be stated as 

 (14-14)

where k and f are material parameters. You pass these material parameters to the 
hcfmultiax function through the property params. The Findley criterion states stress 
combinations giving the fatigue limit. In Equation 14-14, ∆τ is the maximum shear 
stress range of the cycle, and σn is the maximum normal stress during the cycle. The 
left-hand side of Equation 14-14 must for each material point (for example, a node in 
an FE analysis) be computed for a large number of directions until the maximum value 
is found. The fatigue usage factor fus is the ratio between the Findley criterion and the 
material parameter f. A value below 1 means that the component is loaded below the 
fatigue limit.

 (14-15)

On a given plane the normal stress is a scalar, but the shear stress is a two-dimensional 
vector. This requires an interpretation of ∆τ. The most strict interpretation is that ∆τ 
is the diameter of the smallest circle inscribing the path that the τ vector creates during 
a load cycle. This calculation is nontrivial, however, and takes significant computer 
resources. An alternative is to use the maximum distance between any two points on 
the path instead. This simplified procedure could in extreme cases underestimate ∆τ by 
13%, but in most cases the result is much better. The summation in Equation 14-14 
further reduces the error. The hcfmultiax function supports both these methods for 
calculating ∆τ through the property opt.

To find the two material parameters k and f you need two fatigue tests with different 
loading conditions. This can, for example, be pure tension and pure torsion, but there 
are other possibilities. For axial loading, the following relation is valid:

∆τ
2

------ k σn⋅+⎝ ⎠
⎛ ⎞

max
f=

fus

∆τ
2

------ k σn⋅+⎝ ⎠
⎛ ⎞

max
f

-------------------------------------------=
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 (14-16)

Here σmax, and σmin are the maximum and minimum stresses at the fatigue limit, that 
is, infinite life. In a pure (fully reversed) torsion test with an amplitude τa of the 
torsional shear stress, the corresponding relation is

 (14-17)

If only uniaxial test data with a single R value is available, it is possible to estimate k 
from the ratio between the fatigue limits under different conditions for a similar 
material.

Conducting a Fatigue Analysis
An analysis of high-cycle fatigue with nonproportional loading consists of the 
following steps:

1 Perform a finite element analysis (FEA) for the basic load cases.

2 Calculate all stress components from the FEA model for the different basic load 
cases at the locations where you are interested to find the fatigue damage. You do 
this by calling posteval from the command prompt.

3 Define the loading history by combining the basic load cases.

4 Find appropriate material data in the form of Findley parameters, k and f.

5 Calculate the fatigue usage factor using the hcfmultiax function. You find a 
detailed description in the entry for hcfmultiax on page 177 in the Structural 
Mechanics Module Reference Guide.

6 Plot the fatigue damage and look at the stress history. You can plot the fatigue 
damage using the postdataplot function.

You find an example of a high-cycle fatigue analysis with nonproportional loading in 
the model “Shaft with Fillet” on page 346.

P R O P O R T I O N A L  L O A D I N G ,  N O N C O N S T A N T  A M P L I T U D E

You use the function fatiguedamage for this type of analysis. The properties in the 
following section refer to the fatiguedamage function.

When the loading history is not deterministic, the question of how to characterize the 
load cycles from a fatigue point of view arises. An example of such a load (or stress) 
history is shown in Figure 14-11.

σmax σmin–

2
--------------------------------⎝ ⎠
⎛ ⎞

2
k σmax⋅( )2

+ k σmax⋅+ 2f=

τa
f

1 k2
+

--------------------=
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Figure 14-11: Example of a nondeterministic load history.

There are several methods for determining cycles having different ranges and possibly 
corresponding mean values. One commonly used method is “Rainflow counting” as 
described in Ref. 1.

If fatigue data, S-N curves are available it is possible to determine the allowable 
number Ni of cycles to fatigue for each such pair i consisting of a mean and amplitude 
stress. Using the linear cumulative damage rule attributed to Palmgren and Miner, 
each such pair would produce a relative damage

 (14-18)

In practice, all pairs with similar values of the mean stress and amplitude are grouped 
together in classes (“bins”), represented by its class midpoint. If the number of cycles 
stored in bin i is ni, the corresponding relative damage is

 (14-19)

The limit for the possible fatigue life is then given by

 (14-20)

di
1

Ni
------=

di
ni

Ni
------=

ni

Ni
------

i
∑ 1=
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In the Structural Mechanics Module there is a function named rainflow, which 
performs a rainflow count on an arbitrary signal and returns the number of occurrences 
in a matrix of (range, mean) bins.

This type of counting is useful only if the principal stresses are not rotating; in practice 
this often means that a single load controls the stress history, or that the critical point 
has a uniaxial stress state. It is theoretically possible to include effects of multiaxiality, 
but usually a single stress component (for example, the largest principal stress) is used.

The total fatigue damage factor damtot calculated by the Structural Mechanics 
Module function fatiguedamage is defined as

 (14-21)

Conducting a Fatigue Analysis
An analysis of high-cycle fatigue with nonconstant amplitude and proportional loading 
consists of the following steps:

1 Perform a finite element analysis for a unit loading factor.

2 Calculate all stress components from your FEA model at the locations where you 
are interested to find the total fatigue damage factor damtot. You do this by calling 
the posteval function.

3 Define the loading history as load factors either from measurements or from 
statistical methods.

4 Perform a Rainflow count of the loading history using the rainflow function. This 
results in a binning of your load. You can plot the result of the count using the stem 
plot function.

5 Find appropriate material data for different mean stresses in form of S-N curves and 
write functions (M-files) returning the stress amplitude giving the number of cycles 
or use a single S-N curve for R = −1 and specify a mean stress correction method 
through the method property.

6 Calculate the total fatigue damage factor damtot and the damage distribution using 
the fatiguedamage function. You find a detailed description of fatiguedamage on 
page 174 in the Structural Mechanics Module Reference Guide.

7 Plot the total fatigue damage factor damtot and the damage distribution.

You find an example of a high-cycle fatigue analysis with proportional loading in the 
model “Frame with Cutout” on page 357.

damtot
ni

Ni
------

i
∑=
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Low-Cycle Fatigue

When studying low-cycle fatigue, it has been found that it is more relevant to use strain 
as the important parameter in the fatigue laws. There is always significant cyclic plastic 
deformation involved in low-cycle fatigue situations. The functions in the Structural 
Mechanics Module performing low-cycle fatigue analysis are:

• lcfmultiaxlin (see page 179 in the Structural Mechanics Module Reference 
Guide for details)

• lcfmultiaxpla (see page 181 in the Structural Mechanics Module Reference 
Guide for details)

For a uniaxial case, it is often possible to use an expression of the type 

 (14-22)

Here ∆ε is the total strain range, and the two terms on the right-hand side represent 
the elastic and the plastic strain contributions. 2Nf  is the number of load reversals to 
fatigue (so that Nf  is the number of full cycles). In addition to the modulus of elasticity, 
E, there are four independent parameters: two coefficients, and two exponents.

There are many related models, considering, for example, mean stress effects, 
differences between shear and tension, or multiaxiality. One popular such model is the 
Smith-Watson-Topper (SWT) model. This is a type of critical plane model, where the 
plane normal to the maximum principal strain range is considered.

 (14-23)

The left-hand side is commonly called the SWT parameter and contains the maximum 
normal stress during the cycle on the used plane. The material parameters in 
Equation 14-22 and Equation 14-23 are the same. You specify these parameters to the 
functions lcfmultiaxlin and lcfmultiaxpla through the property params.

PARAMETER DESCRIPTION

Fatigue ductility coefficient

Fatigue ductility exponent
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Fatigue strength exponent
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In general, the stress and strain in Equation 14-22 and Equation 14-23 must be 
computed using plasticity theory. There are two possible approaches. The first is to 
compute a complete cycle, using a full elasto-plastic analysis. In this type of analysis, it 
is important to model the cyclic plastic behavior of the material appropriately. This 
means that kinematic hardening models are more suitable than isotropic models. It 
might also be necessary to analyze more than one load cycle in order to obtain a 
stabilized stress-strain cycle.

The second case occurs if the highly stressed region is localized. In this common case, 
it is possible to determine the stress and strain range using an elastic analysis and then 
externally compute an approximation to the plastic stresses and strains. Neuber’s rule 
states that for a notch, the product of elastically computed stress and strain is equal to 
the product of the actual, inelastic, stress and strain. Strictly speaking, it is defined in 
terms of a uniaxial stress state. In practice, the stress states are often multiaxial, so here 
Neuber’s rule is expressed in equivalent stresses and strains.

 (14-24)

In Equation 14-24 the left side has an “e” denoting the results of an elastic analysis, 
while the right side contains the actual values.

In strain-based fatigue analysis it is customary to assume an Ramberg-Osgood material 
law when modeling the cyclic plastic behavior

 (14-25)

The parameters in Equation 14-25 must be the cyclic values and not the monotonic 
values obtained from a standard tensile test.

Hoffman and Seeger has developed an algorithm for approximate computation of the 
stress and strain amplitude in a multiaxial case. You specify the material properties to 
the function lcfmutiaxlin through the property params. Initially, Equation 14-24 
and Equation 14-25 are solved together for obtaining the true equivalent (in von 
Mises sense) stresses and strains. It is then possible to approximate the major principal 
strain and corresponding stress as

 (14-26)

σe eq εe eq⋅ σeq εeq⋅=

ε σ
E
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+

----------------------------- εeq⋅=
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 (14-27)

These two relations contain the parameters a and ν. The latter is an effective Poisson’s 
ratio defined as

 (14-28)

A biaxiality factor, , is computed as the ratio between the two in-plane elastic 
principal strains:

 (14-29)

The parameter a is then defined as

 (14-30)

The stress σ1 and the strain ε1 can now be used for computing the fatigue life using, 
for example, the SWT equation above.

C O N D U C T I N G  A  F A T I G U E  A N A L Y S I S

Depending of whether the highly loaded area can be considered localized or not, two 
different methods can be used.

General Case
An analysis of low cycle fatigue with nonlocalized stresses consists of the following 
steps:

1 Perform a full elasto-plastic FEA analysis for as many cycles as needed to get a 
stabilized stress field.

2 Calculate all stress and strain components during a complete cycle at the locations 
where you are interested to find the fatigue damage. Do this by calling the 
posteval function.

3 Find appropriate material data for the Smith-Watson-Topper (SWT) fatigue model.

4 Calculate the fatigue damage using the lcfmultiaxpla function. You find a 
detailed description in the entry for lcfmultiaxpla on page 181 in the Structural 
Mechanics Module Reference Guide.
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5 Plot the fatigue damage by calling the postdataplot function.

You find an example of a low-cycle fatigue analysis using a full elasto-plastic analysis in 
the model “Cylinder with Hole” on page 372.

Simplified Analysis
An analysis of low cycle fatigue with localized stresses consists of the following steps:

1 Perform a linear elastic FEA analysis to get the stress field.

2 Calculate the principal stress components at the locations where you are interested 
to find the fatigue damage. Do this calculation by calling the posteval function.

3 Find appropriate material data for the Smith-Watson-Topper (SWT) fatigue model 
and your simplified linear elastic to elasto-plastic calculation.

4 Calculate the fatigue damage using the lcfmultiaxlin function. You find a 
detailed description in the entry for lcfmultiaxlin on page 179 in the Structural 
Mechanics Module Reference Guide.

5 Plot the fatigue damage by calling the postdataplot function.

You find an example of a low-cycle fatigue analysis using a linear elastic analysis in the 
model “Cylinder with Hole” on page 372.
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 15
G l o s s a r y  
This glossary contains finite element modeling terms in a structural mechanics 
context. For mathematical terms, and geometry and CAD terms specific to the 
COMSOL Multiphysics software and documentation see the glossary in the 
COMSOL Multiphysics User’s Guide. For references to more information about a 
term, see the index.
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G l o s s a r y  o f  T e rm s
anisotropy   Variation of material properties with direction. Both global and local user 
defined coordinate systems can be used to define anisotropic material properties.

augmented Lagrangian method   Segregated solution method, where the solver 
switches between solving for the contact pressure and the displacements, used when 
modeling contact.

axial symmetry   Symmetry in both load and geometry, solves for the radial (r) and 
axial (z) displacement.

bar    A line element that only has translational degrees of freedom, capable of 
sustaining axial forces, with no bending moments, torsional moments, or shear forces. 
Can be used on lines in 1D, 2D, and 3D.

beam    A line element having both translational and rotational degrees of freedom. 
Capable of sustaining axial forces, bending moments, torsional moments, and shear 
forces. Can be used on curves in 2D and 3D.

benchmark    Standard test designed to evaluate the accuracy or efficiency of a finite 
element system or model.

body forces   Forces distributed through the volume of a body.

buckling   The sudden collapse or reduction in stiffness of a structure under a critical 
combination of applied loads.

cable   A tension-only truss member used to model large deformation including sag.

Cauchy stress   The most fundamental stress measure defined as force/deformed area 
in fixed directions not following the body.

compliance matrix   The inverse of the elasticity matrix. See elasticity matrix.

constitutive equations   The equations formulating the stress-strain relationship of a 
material.

constraint   Constrains the displacement or rotations to zero or a specified value.
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contact model   The mathematical method to model bodies that come into contact 
with each other.

contact pair   A contact pair consists of some slave and master boundaries and is used 
for contact modeling.

continuum application modes   The application modes that solve for the displacement 
field without involving rotations. Solid, Stress-Strain; Plane Stress; Plane Strain; and 
Axial Symmetry, Stress-Strain are the continuum application modes.

coordinate system   Global Cartesian, local geometrical, application specific, and user 
defined coordinate systems. Loads, constraints, material properties, and 
postprocessing variables are defined in a specific coordinate system.

creep   Time-dependent material nonlinearity that usually occurs in metals at high 
temperatures in which the effect of the variation of stress and strain with time is of 
interest.

damping   Dissipation of energy in a vibrating structure. A common assumption is 
viscous damping where the damping is proportional to the velocity. See also Rayleigh 
damping.

eigenfrequency analysis   Solving for the undamped natural frequencies and vibration 
modes of a structure.

elasticity matrix   The matrix D relating strain to stresses:

elasto-plastic material   A material model where the material exhibits both elastic and 
plastic behavior. See also plasticity.

equilibrium equation   The equation expressing the equilibrium formulated in the stress 
components.

fatigue   A term describing the phenomena where a component fails after repeated 
loadings and unloadings.

first Piola-Kirchhoff stress   A rather mathematical stress measure used in the 
hyperelastic material model, its conjugate strain is the displacement gradient.

σ Dε=
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flexibility matrix   The inverse of the elasticity matrix. See elasticity matrix.

free vibration   The undamped vibration of a structure after it is displaced from the 
equilibrium position and released. See also eigenfrequency analysis.

frequency response analysis   A harmonic analysis solving for the steady-state response 
from a harmonic excitation. Typically a frequency sweep is performed, solving for 
many excitation frequencies at one time.

geometric nonlinearity   See large deformation.

Green-Lagrange strain   Nonlinear strain measure used in large-deformation analysis. 
In a small strain, large rotation analysis, the Green-Lagrange strain corresponds to the 
engineering strain, with the strain values interpreted in the original directions. The 
Green-Lagrange strain is a natural choice when formulating a problem in the 
undeformed state. The conjugate stress is the second Piola-Kirchhoff stress.

hyperelastic material   Material where the stresses are computed from a strain energy 
density function. Often used to model rubber.

initial strain   The strain in a stress-free structure before it is loaded.

initial stress   The stress in a non-deformed structure before it is loaded.

isotropic material   A material where the material properties are independent of 
direction.

isotropic hardening   A hardening model for an elasto-plastic material where the yield 
surface increases in size but maintains its original shape.

kinematic hardening   A hardening model for an elasto-plastic material where the 
yield surface is translated to a new position in the stress space as the plastic strain is 
increased, with no change in size or shape.

large deformation   The deformations are so large so the nonlinear effect of the change 
in geometry or stress stiffening need to be accounted for.

linear buckling analysis   Solves for the linear buckling load using the eigenvalue solver.

mass damping parameter   Rayleigh damping parameter, the coefficient in front of the 
mass matrix.
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master boundary   One side of a contact pair, the slave boundary is prohibited to 
penetrate the master boundary.

Mindlin plate   A thick plate including shear deformation. See also plate.

mixed formulation   A formulation where the pressure have been added as a dependent 
variable, used for nearly incompressible materials to avoid numerical problems.

Mooney-Rivlin material   A hyperelastic material model with three model parameters, 
the model is based on modified strain invariants.

Neo-Hookean material model   A hyperelastic material model with two model 
parameters, the model is based on modified strain invariants.

nonlinear geometry   See large deformations.

orthotropic material   An orthotropic material has at least two orthogonal planes of 
symmetry, where material properties are independent of direction within each plane. 
Such materials require nine independent variables (that is, elastic constants) in the 
constitutive equations. 

parametric analysis   An analysis which finds the solution dependence due to the 
variation of a specific parameter.

pinned   A constraint condition where the displacement degrees of freedom are fixed 
but the rotational degrees of freedom are free, typically used for frames modeled using 
beams and truss elements.

plane strain   An assumption on the strain field where all out-of-plane strain 
components are assumed to be zero.

plane stress   An assumption on the stress field, all out-of-plane stress components are 
assumed to be zero.

plasticity   A time-independent material nonlinearity. Three classes of plastic behavior 
are considered: perfectly plastic, isotropic hardening, kinematic hardening.

plate   Thin structure loaded in the normal direction.

primary creep   The initial creep stage where the strain rate is decreasing with time.
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principle of virtual work   States that the variation in internal strain energy is equal to 
the work done by external forces.

principal stresses/strains   Normal stresses/strains with no shear components that act 
on the principal planes. The magnitude of the principal stresses/strains are 
independent of the coordinate system used.

quasi-static transient analysis   The loads vary slowly so inertia terms can be neglected. 
A transient thermal analysis coupled with a structural analysis can often be treated as 
quasi-static.

Rayleigh damping   A viscous damping model where the damping is proportional to the 
mass and stiffness, through the mass and stiffness damping parameters.

rotational degrees of freedom   Degrees of freedom associated with a rotation around 
an axis. Beams, Mindlin plates, and shells have rotational degrees of freedom.

secondary creep   A creep regime where the strain rate is almost constant.

second Piola-Kirchhoff stress   Conjugate stress to Green-Lagrange strain used in 
large deformation analysis.

shell elements   A thin element where both bending and membrane effects are 
included.

slave boundary   One side of a contact pair, the slave boundary is prohibited to 
penetrate the master boundary.

static analysis   An analysis where the loads and constraints are constant in time.

strain   Relative change in length, a fundamental concept in structural mechanics.

stress   Internal forces in the material, normal stresses are defined as forces/area normal 
to a plane, and shear stresses are defined as forces/area in the plane. A fundamental 
concept in structural mechanics.

stiffness damping parameter   Rayleigh damping parameter, the coefficient in front of 
the stiffness matrix.

strain energy   The energy stored by a structure as it deforms under load.
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transient analysis   A time-dependent analysis, taking into account mass, mass moment 
of inertia, and damping.

tertiary creep   The creep stage where the strain rate increases very rapidly, followed by 
eventual failure.

Tresca stress   An effective stress measure that is equal to the maximum shear stress.

truss   See bar.

viscoelasticity   A time-dependent material nonlinearity. Viscoelastic materials have a 
time-dependent response, even if the loading is constant. Many polymers and 
biological tissues exhibit such a behavior. Linear viscoelasticity is a commonly used 
approximation where the stress depends linearly on the strain and its time derivatives.
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I N D E X

3D Euler Beam application mode 278

3D Truss application mode 300

A absolute tolerances 128

absorbing boundaries 212

acceleration loads 73

acceleration, prescribed 309

acoustics 2

Allman triangle 302

amplitude 41, 140, 248, 294, 313

analysis

dynamic 32

eigenfrequency 138

static 138

analysis capabilities 132, 137

analysis types 133, 190, 327

damped eigenfrequency 186

eigenfrequency 28, 138

for piezoelectric modeling 327

frequency response 41, 139, 184

harmonic 41, 139, 184

linear buckling 141

parametric 7, 48

quasi-static 53, 140

static 17, 133, 138, 183

static elasto-plastic material 190

thermal-structural 141

time-dependent 32, 139, 184

transient 32, 139, 184

angular excitation frequency 139

anisotropic material 169, 194

antisymmetric loading 80

antisymmetry plane 309

application mode guide 131

application mode properties

analysis type 190, 327

create frame 217

large deformation 191, 285

weak constraints 191, 327

Application Mode Properties dialog box 

138, 190, 326

application modes

3D Euler Beam 278

3D Truss 300

Axial Symmetry, Stress-Strain 163

continuum 164

for beams 277

In-Plane Euler Beam 277

In-Plane Truss 299

Mindlin Plate 227

overview of 132

Piezo Axial Symmetry 349

Piezo Plane Strain 349

Piezo Plane Stress 348

Piezo Solid 348

piezoelectric 326

Plane Strain 162

Plane Stress 161

selecting 135

Shell 301

Solid, Stress-Strain 160

application scalar variable 134

Application Scalar Variables dialog box 

139

area effects, in FSI models 359

area moment of inertia 263

Argyris TRIC triangle element 302

assembly 217

auglagiter variable 222

augmented Lagrangian method 118, 129, 

186

axial symmetry 80, 134

symmetry axis 163, 350
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Axial Symmetry, Stress-Strain application 

mode 163

B bars 279

Basquin equation 364

beams 253

application mode description for 259

constraints for 265

cross-section properties for 263

damping 275, 296

initial loads 257, 276

initial strains 257, 276

in-plane Euler beams 277

loads applied to 270

shape functions for 254

theory background 254

thermal couplings in 274

thermal strain in 256

biaxiality factor 384

boundary conditions

for electric currents 340

Boundary Settings dialog box 14, 22, 36, 

134

buckling 7, 141

bulk modulus 171

C cable elements 279, 288

cables 300

CAD import

DXF files 19

Cauchy stress 166

Cauchy-Green tensor 166, 176

centrifugal acceleration loads 73

charges 344

chemical reactions 2

Coffin-Manson equation 368

cohesion sliding resistance 187

complementarity conditions 173

complex modulus 122

complex notation 185

complex results 46

compliance matrix 167, 332, 333

component

damping of 33

eigenfrequency analysis of 28

frequency response analysis of 41

parametric analysis of 48

quasi-static analysis 53

static analysis of 17

time-dependent analysis of 32

computing the solution 14

COMSOL Script 6, 34

Constants dialog box 12

constitutive equations

for linear elastic materials 167

user-defined 109

constitutive form

piezoelectric material 329

strain-charge 330

stress-charge form 329

constitutive relations 178

constraint condition

fixed 308

no rotation 308

pinned 266, 308

constraints 79, 201

coordinate systems for 203, 290, 343

for beams 265

for Mindlin plates 244

for piezoelectricity 342

for shells 307

for trusses 289

general notation for 204

kinematic 81

standard notation for 204

symbols for 156

symmetry 80

contact map operator 186



Contact Modeling 217

contact modeling

friction 188

manual scaling 129

solver settings for 129

theory 186

contact pairs 118, 217

continuum 159

continuum application modes 164

Axial Symmetry, Stress-Strain 163

damping 210

Plane Strain 162

Plane Stress 161

Solid, Stress-Strain 160

Control System Toolbox 6

coordinate system

for shells 309

Coordinate System Settings dialog box 

148

coordinate systems 144

application-mode specific 146

constraints definition in 290

defining loads in 207

defining using work plane 150

for 3D Euler beams 267

for constraints 343

for loads 345

for material properties 197, 332, 336

for Mindlin plates 242

for shells 312

in constraints 203

local geometrical 145

user-defined 147

Coulomb friction 188

coupling operators 220

critical damping 33

critical plane 377

critical plane methods 372

cross section 263

cross-section area 288

cross-sectional properties 263, 288

cylindrical coordinates 163, 349

D damped eigenfrequency analysis 186

damping 121

beams 275, 296

continuum application modes 210

critical 33

equivalent viscous 123, 346

example 33

explicit 123

loss factor 122, 210, 250, 275, 297, 315, 

346, 347

mass 121

matrix 33, 139

Mindlin plate 250

model 33

no damping 210, 250, 275, 297, 315

page for specifying 210, 250, 275, 296, 

314, 346

piezoelectric 346

ratio 33

Rayleigh 33, 121, 184, 210, 250, 275, 297, 

315, 346

shells 314

stiffness 121, 211, 250, 275, 297, 306, 

315, 347

viscous 123

damping factor 121

Damping page 210, 250, 275, 296, 314, 

346, 347

damping ratio 121

decay factor 138, 186

deformation gradient 165

deformed frame 181

deformed shape 27

dependent variables 132
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dialog box

Application Mode Properties 138, 190, 

326

Application Scalar Variables 139

Boundary Settings 14, 22, 36, 134

Constants 12

Contact Pairs 219

Coordinate System Settings 148

Edge Settings 14, 134

Elasticity Matrix 195

Elasticity matrix 330

Elasto-Plastic Material Settings 196

Free Mesh Parameters 25

H Matrix 205

Import CAD Data From File 19

Materials/Coefficients Library 23

Plot Parameters 26

Relative permittivity 330

Shear elasticity matrix 242

Solver Parameters 14, 126

Subdomain Settings 14, 23, 24, 37, 134

direct piezoelectric effect 320

discrete mass 272, 295

discrete Reissner-Mindlin shape function 

229

discrete Reissner-Mindlin triangle 228

displacement gradient 177

distributed loads 206

Draw menu 13

Draw toolbar 13

drilling rotations 303

DXF files 19

dynamic friction coefficient 188

E Edge Settings dialog box 14, 134

edges, settings for 14

education 6

effective plastic strain 175

effective Poisson’s ratio 384

eigenfrequency 138

eigenfrequency analysis 28, 138

solver parameters for 30

eigenmodes

scaled 31

eigenvalue 138

elasticity matrix 167, 200

Elasticity Matrix dialog box 195

Elasticity matrix dialog box 330

elasto-plastic material 173, 190, 195

Elasto-Plastic Material Settings dialog 

box 196

elasto-plastic materials 103

elcontact element 186

Electric BC page 338

electric boundary conditions 338

electric currents

boundary conditions for 340

electric displacement 339

electric potential 339, 340

element

Lagrange 24

mixed 172

order 24

endurance limit 364

engineering assumption 132

engineering strain 166

entropy 179

equivalent viscous damping 123, 346

Euler beams 277

error message for coinciding points 

264

shape functions for 254

excitation angular frequency 139

excitation frequency 41, 45, 134, 184, 208, 

327

explicit damping 123

F fatigue analysis 125, 362



stress measures for 364

fatigue damage 378

fatigue ductility coefficient 368, 382

fatigue ductility exponent 368, 382

fatigue limit 364

fatigue strength coefficient 368, 382

fatigue strength exponent 368, 382

Findley criterion 378

first Piola-Kirchhoff stress 167, 176

flexibility matrix 167

fluid flow 2

fluid loads 359

fluid-structure interaction 115, 356

follower loads 73, 181, 206

deformation gradient for 166

fracture mechanics 362

frame 217

deformed 181

reference 181

frame structures 8

Free Mesh Parameters dialog box 25

free vibration 6

frequency 134

angular excitation 139

excitation 139

frequency response analysis 41, 139, 184, 

208

amplitude 248, 294, 313

phase 184

friction 188

FSI 115, 356

G gap distance 187

general 3D structure 8

general notation for constraints 204

geometric nonlinearity 165

geometry import

DXF files 19

Gerber method 365, 377

Goodman method 365, 377

gravity loads 73

Green strains 165, 166

Green-Lagrange strains 165

guess variables 213

H H Matrix dialog box 205

Haigh diagrams 365

hardening function 201

hardening model

isotropic 174

kinematic 174

hardening models 103

harmonic analysis 41

harmonic loads 139, 184

heat capacity 179

heat dissipation 123

heat transfer 314

high-cycle fatigue 364, 374

Hoffman and Seeger algorithm 383

Hooke’s law 287

hyperelastic material models

Mooney-Rivlin 176

Neo-Hookean 176

strain energy function 177

hyperelastic materials 102, 176

I ideal plastic material 174

ideal plasticity 175

IEEE standard, for piezo theory 321

Import CAD Data From File dialog box 

19

importing CAD files 19

incompressibility 176

initial

curvature 257

load 235

moment 257

normal force 257

shear forces 235
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strain 180, 235

stress 180

initial strains

for trusses 298

initial stresses 211

for trusses 298

initial values 38

in-plane elasticity matrix 242

In-Plane Euler Beam 277

In-Plane Truss

application mode 299

invariants 176

inverse piezoelectric effect 320

isotropic hardening 103, 174, 175

isotropic material 167, 193, 230

isotropic tangent modulus 200

K kinematic constraints 81

kinematic hardening 103, 174, 175

kinematic tangent modulus 201

L Lagrange element 24

Lagrange elements 159

large deformation 140, 191, 285

lattice trusses 299

library of materials 23

linear buckling analysis 141

linear elastic material 167

load cycles 362

load symbols 154

loading

nonproportional 377

proportional 379

loads 344

acceleration 73

applied to beams 270

coordinate systems for 207, 345

distributed 206

follower 73

for shells 312

gravity 73

on Mindlin plates 247

on trusses 293

page for specifying 205

thermal 208, 313

total 78

units for 207, 271, 293, 345, 346

local coordinate systems 145

loss factor 122, 211, 250, 251, 275, 297, 

315, 347

loss factor damping 122, 172, 210, 250, 

275, 297, 315, 346

loss modulus 122

low-cycle fatigue 364, 382

M manual scaling 129

map operator 220

mass damping parameter 121, 211, 250, 

276, 297, 315, 347

mass matrix 33, 139

mass moment of inertia 273

master boundary 187

master domains 118

material

anisotropic 169, 194

coordinate system 197

elasto-plastic 173, 195

ideal plastic 174

isotropic 167, 193, 230

linear elastic 167

mixed formulation 170

model 193

Mooney-Rivlin 176

Neo-Hookean 176

orthotropic 168, 193

material libraries 110

material models 101

Mooney-Rivlin 102

nearly incompressible material 109



Neo-Hookean 102

user-defined materials 109

material orientation

in piezoelectric application modes 330

Material page 193

material properties 22

coordinate system for 332

settings for 328

materials

elasto-plastic 103

hyperelastic 176

piezoelectric 320

Materials/Coefficients Library dialog box 

23

MATLAB 6

matrix

compliance 167, 332, 333

damping 33, 139

elasticity 167

flexibility 167

mass 33, 139

piezo coupling 333

stiffness 33, 139

maximum friction traction 187

mean stress correction theories 377

mean stress corrections 365

mechanical component 16

MEMS Material Properties library 111

menu

Draw 13

Mesh 14

Mesh menu 14

meshes, initializing 26

Mindlin plate

application mode for 227

constraints 244

coordinate systems 242

damping 250

initial load 235, 251

initial strain 235, 251

loads 247

postprocessing 134

postprocessing height 252

shape function 229

shear strain components 229

theory for 229

thermal coupling 249

mixed formulation 170, 177

mixed U-P formulation 108

Model M-file 6

Model Navigator 12

model of a mechanical component 16

Mooney-Rivlin material model 102, 176

Moving Mesh (ALE) application mode 

115

multiphysics

creating in Model Navigator 12

predefined 53

thermal-structural coupling 53

multiphysics contact 120

N nearly incompressible materials 109

Neo-Hookean 176

Neo-Hookean material model 102

Neuber’s rule 383

new features in version 3.4 9

no rotation 308

nonlinear geometry 140, 165

nonproportional loading 371, 377

normal stress 166, 230

O optical wave propagation 2

orthotropic material 168, 193

P page

Constraint 201, 342

Cross Section 134, 263, 288

Damping 210, 250, 275, 296, 314, 346
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Initial Stress and Strain 211

Load 205

Material 193

Postprocessing 316

Palmgren and Miner, damage rule 380

parametric analysis 7, 48

partial differential equations 6

penalized friction traction 187

penalty factors 119

penalty parameter 222

perfectly matched layers 212

perfectly plastic material 175

phase 47, 139, 140, 184

phase shifts 41, 139

Piezo Axial Symmetry application mode 

349

piezo coupling matrix 333

Piezo Plane Strain application mode 349

Piezo Plane Stress application mode 348

Piezo Solid application mode 348

piezoelectric

analysis types 327

application modes 319

piezoelectric application modes

application mode properties 326

piezoelectric effect 320

Piezoelectric Material Properties library 

110

piezoelectric materials 320

pinned 266, 308

plane strain 162

Plane Stress 161

boundary settings 22

mechanical component model using 16

plasticity 173

plates 227

plot

deformed shape 27

Plot Parameters dialog box 26

PMLs

see perfectly matched layers

point mass 272, 295

point mass moment of inertia 273

point settings 13

Point Settings dialog box 13

Poisson’s ratio 197, 199, 261

postprocessing

depth 134

height 252

Mindlin plate 134, 251

Shell 134

shells 316

variables 26

Postprocessing page 316

prescribed acceleration 309

prescribed velocity 309

pressure

as dependent variable 177

as Vanka variable 128

defined as negative mean stress 170

principle of virtual work 182

proportional loading 371, 379

Q quality factor 138, 186

quasi-static analysis 53, 140

R rainflow count 381

rainflow counting 370

Ramberg-Osgood material law 383

Rayleigh damping 33, 121, 184, 210, 250, 

275, 297, 315, 346

reaction forces 96

reference frame 181

reference temperature 178

Reissner-Mindlin triangle 228

Relative permittivity dialog box 330

rotating disk example 73

rotational degrees of freedom 277, 278



rotational joints 90

rotations 302

S sagging cables 299

sagging edges 288

scalar variables 191, 327

scaled eigenmodes 31

second Piola-Kirchhoff stress 123, 167, 

176, 178

segregated solver 186

shape functions

for beams 254

shear deformation 302

Shear elasticity matrix dialog box 242

shear factor 243

definition 233

shear factor orthotropic material 244

shear modulus 199, 243, 334

shear strain 164

shear strain components

Mindlin plate 229

shear stress 166, 230

Shell

constraint condition 308

loads 312

local coordinate system 317

postprocessing 134

Shell application mode 301

shell element 302

shells

constraints 307

coordinate systems 312

damping 314

units for 312

sheulb3d 254

Simulink 6

slave boundary 187

slave domains 118

Smith-Watson-Topper model 382

S-N curves 363, 374

solid mechanics 1

Solid, Stress-Strain application mode 160

solver method

augmented Lagrangian 129, 186

solver parameters 30, 126

absolute tolerance 128

linear system solver 127

manual scaling 129

symmetric matrices 126

Solver Parameters dialog box 14, 126

solver settings 126

for contact modeling 129

spars 279

St. Venant’s principle 65

standard notation for constraints 204

static analysis 17, 133, 138, 183

static coefficient of friction 188

stiffness damping 211, 250, 275, 297, 306, 

315, 347

stiffness damping parameter 121, 211, 

251, 276, 297, 315, 347

stiffness matrix 33, 139

storage modulus 122

straight edge option 288

straight edges option 281

strain 164, 166, 230, 234, 255

axial symmetry 164, 350

effective plastic 175

elastic 164, 230, 256

engineering 166

engineering form 164

Green 166

initial 180, 211

invariants 176

reference temperature 314

shear 164

temperature 314
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tensor form 164

thermal 164, 178, 230, 256

transverse shear 230

strain energy 181

strain energy function 177

strain reference temperature 209

strain temperature 209

strain tensor 164

strain-charge form 330

strain-displacement relation 164, 230, 255

large displacement 165

small displacement 164

stress 166, 230, 234

Cachy 166

first Piola-Kirchhoff 167, 176

initial 180, 211

normal 166, 230

second Piola-Kirchhoff 123, 167, 176, 

178

shear 166, 230

tensor 166, 230

stress amplitude 363

stress vector 179

stress-charge form 329

stresses, in fatigue analysis 364

stress-strain curves 104

stress-strain relation 166

structural damping 346

Structural Mechanics Module 3.4

new features in 9

structure

frame 8

general 3D 8

shell 8

thin-walled 3D 8

Subdomain Settings dialog box 14, 23, 24, 

37, 134

superposition principle 81

surface charge 339

symbols

for constraints 156

for loads 154

symmetric matrices 126

symmetry axis 163, 350

symmetry constraints 80

symmetry plane 309

symmetry planes 80

T temperature, reference 178

theory

for beams 254

for contact modeling 186

for Mindlin plates 229

for structural analysis 164

thermal coupling

for Mindlin plates 249

in beams 274

in trusses 295

thermal expansion coefficient 141, 200, 

287

anisotropic 198

isotropic 197

orthotropic 198

thermal expansion vector 178, 200

thermal loads 208, 313

thermal strain 141, 164, 178, 230, 256, 295

in beams 256

thermal-structural analysis 141

thermal-structure interaction 53

thin-walled 3D structure 8

time-dependent analysis 139, 184

initial values for 38

torsional constant 258

torsional moment 67, 258

total fatigue damage factor 381

total loads 78

transient analysis 32, 36, 139, 184



initial values for 38

transition life 369

truss application modes 284

trusses 279

application mode description 284

constraints for 289

cross-section properties for 288

initial strains 298

initial stresses 298

In-Plane Truss application mode 299

loads on 293

straight edge option for 281

thermal coupling in 295

typographical conventions 3

U units

for loads 271, 293

for shells 312

user-defined coordinate systems 147

user-defined materials 109

V variables

phase 47

postprocessing 26

velocity, prescribed 309

viscous damping 123

visualization

of loads and constraints 79

volume ratio 165

volumetric heat capacity 179

von Mises effective stress 18, 26

W weak constraints 191, 327

Wöhler curves 363, 374

Y yield function 200

yield functions 103

yield stress level 200

Young’s modulus 168, 197, 198, 199, 242, 

261, 287
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